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1 Introduction

ColorFlow software
ColorFlow software delivers color relationship management that unifies
all of the color control elements, such as ICC device profiles, device link
profiles, and plate and print curves. ColorFlow software manages the
relationship between the color control elements and device print
conditions.

ColorFlow software enables you to define the color relationships
between your devices. ColorFlow software is where the color
characterization data is stored and where you generate and edit curves;
import ICC device profiles; and import, generate, or edit ICC device link
profiles for use in the refine and output processes of Kodak Prinergy
workflow.

After you set up a device in ColorFlow software, you can easily create
variations of that setup. For example, envision that you invest a
considerable amount of time measuring color responses and creating
conversion and simulation links within a particular color setup. You
establish your press condition as a color reference point. Now, if you
want to simulate a different color response, all you need to do is
duplicate the color setup and choose the new simulation target in
ColorFlow software. Using traditional methods, you would need to
manually create several, individual conversion device link profiles to
align with the new target.

ColorFlow software, Workflow edition, is integrated with Kodak
Prinergy software, and is shipped with Prinergy version 6.1 and later.

For information about using ColorFlow software, see the Help or User
Guide.

Editions of ColorFlow software
ColorFlow software is available in three editions.

ColorFlow software, Workflow edition

This edition is included with Prinergy Connect, Prinergy Powerpack, and
Prinergy Evo 6.0 and later software. With this edition, you can:



● generate and edit curves

● import ICC device profiles

● import ICC DeviceLink profiles

ColorFlow software, Pro Workflow edition

This edition includes all of the functionality of the Workflow edition,
and it also enables you to generate and edit:

● ICC device profiles

● ICC DeviceLink profiles

The ColorFlow Pro Workflow edition also includes the ColorMatching
on Output licensed Prinergy feature.

ColorFlow software for Kodak Proofing Software

ColorFlow software, version 2.1, will be released in a future release of
Kodak Proofing Software.

The following table summarizes the features of the editions of
ColorFlow software. An "x" indicates that the feature is included in the
edition.

Feature ColorFlow
software,
Workflow
edition

ColorFlow
software, Pro
Workflow
edition

ColorFlow
software for
Proofing
Software

ICC device profile
and DeviceLink
creation

x x

ICC device profile
and DeviceLink
editing

x x

Color element
import–ICC
device profiles,
DeviceLinks,
measurement
data

x x x

Color element
import-device
links,
measurement
data

x x x

Report generation x x x
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Feature ColorFlow
software,
Workflow
edition

ColorFlow
software, Pro
Workflow
edition

ColorFlow
software for
Proofing
Software

Chart generation
and chart reading

x x x

Support for many
industry
standards and
specifications

x x x

Prinergy 6.0
software
integration

x x

Client for Mac OS
and Microsoft 
Windows

x x Windows only

Multiple clients
(single concurrent
connection)

x x

Curve creation x x

Curve editing x x

Kodak Harmony
software curve
support

x x

Support for
multiple print
technologies
(offset-sheetfed,
web, digital print,
flexographic,
inkjet)

x x Kodak Approval
and Kodak
Matchprint Inkjet

Additional options

Ink Optimizing Solution option
The Ink Optimizing Solution is a licensed feature that enables you to
improve print stability and to reduce ink consumption on offset
presses.

When this option is licensed and enabled, you can minimize ink
consumption in print jobs while maintaining the same overall color by
using an ICC device link profile to apply gray component replacement
(GCR) while limiting total ink coverage.
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The Ink Optimizing Solution is available for the ColorFlow Pro
Workflow edition.

See also:
About the Ink Optimizing Solution on page 205

Components of the ColorFlow window
The ColorFlow window consists of two major panes: Color Setups list
and color setup viewer.

When you select a color setup in the Color Setups list, that color setup
appears in the color setup viewer. A color setup may consist of a
primary color output (PCO), a number of secondary color outputs
(SCO), and a number of color inputs (CI). The color setup in the
following example includes a PCO, three SCOs, and no CI.

1. Color Setups list: Displays all of the color setups that have been
created

2. Color setup viewer: Displays the color setup that is currently
selected in the Color Setups list

3. Primary color output (PCO): The color reference point to which all
devices in the color setup will be aligned

4. Secondary color output (SCO): A device that aligns to the PCO

5. Conversion icon: Click to define or adjust a conversion.
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6. Sticky note: An optional, virtual note that you can attach to any
color setup

7. Simulation icon: Click to define or adjust a simulation.

8. PCO profile icon: Click to select or import a profile for the PCO.

9. Properties icon: Click to define device condition properties.

10. Device condition profile icon: Click to select or import a profile for
the device condition.

11. Measurements icon: Click to work with charts and measurements.

12. Device Curves icon: Click to define or import device curves.

13. Default Device Curves icon: Click to define default device curves for
all devices below.

14. Device condition: A device and its operating properties.

15. Devices dialog box: The Add device drop-down is always open to
make it easier for you to add a new device. In addition, you can
right-click to delete a device.

System requirements

ColorFlow 2.1, client software for Windows OS-based
computers

● Microsoft Windows 7, 8, or 8.1, or Microsoft Windows Server 2008

● Microsoft Internet Explorer 6.0 or later (recommended) or other
browser software, to display the Help for ColorFlow software

● Adobe Reader software (to display reports)

● Sun Oracle Java Standard Edition runtime environment 1.6

● Microsoft .NET Framework 2.0 or later, included in the ColorFlow
installer

● 1 GB RAM (minimum); 2 GB RAM (recommended)

● Intel Core 2 Duo processor (2.0 GHz minimum)

● Microsoft Visual C++ 2005 Service Pack 1 Redistributable Package
ATL Security Update

ColorFlow 2.1, client software for Macintosh computers

● Apple Macintosh computer with an Intel processor running Mac OS
10.7, 10.8, or 10.9. To install ColorFlow software, you must have a
user account with administrator privileges.
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Note: ColorFlow client startup is approximately one to two minutes slower on
computers running Mac OS 10.9 than on computers running other supported
versions of the operating system. This happens because Mac OS 10.9 uses the
64-bit version of Java 1.7, while ColorFlow software continues to use the 32-bit
version of Java 1.6, which is the version required to support the 32-bit-only
drivers for the X-Rite iSis spectrophotometers used for measurement
purposes. All other ColorFlow client functions continue to work normally. A
future ColorFlow software release will support Java 1.7.

● Apple Safari 5.1.10 (recommended), Mozilla Firefox 2.0.0.14 or later
(recommended), or other browser software, to display the Help for
ColorFlow software

● Adobe Reader software (to display reports)

● Intel Core 2 Duo processor (2.0 GHz minimum)

● 1 GB RAM (minimum); 2 GB RAM (recommended)

● Sun Java Standard Edition runtime environment 1.6

Note: Client software for Windows OS-based and Macintosh computers is not
supported on virtual operating systems.

Overview of color setups
A color setup is the virtual structure that you build to define the color
relationship of all of the devices in your printing task.

Concept of a color setup
A color setup consists of one primary color output (PCO), and any
number of secondary color outputs (SCO) and color inputs (CI).

The PCO is at the center of the color setup—it is a color reference
point to which all devices in the color setup will be aligned. The color
setup describes how color is converted between devices so that all
devices produce the same color output as the PCO. Rather than the
actual color response of the PCO device, the PCO can be a simulation
target—for example, it can be the color that the device in the PCO
prints as it simulates an industry specification such as GRACoL C1.

After you define the relationship of all devices in the printing
environment and provide ColorFlow with information about how each
device in the color setup currently prints color, ColorFlow calculates
color control elements such as ICC device profiles, DeviceLink profiles,
and curves, and ensures that they are used at the appropriate place in
the Prinergy workflow.

You can create a color setup for each type of printing that you do and
name the color setup after its commercial purpose—for example,
"Glossy brochures." The length of time that it takes to complete a color
setup depends on whether you characterize devices in the color setup
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by printing and measuring a ColorFlow-generated chart, and on the
type of chart that you create.

After you complete a color setup, you should rarely change it. To
create a similar, new color setup—for example, a color setup that has a
different simulation target or a different SCO—you can duplicate the
original color setup and make changes to it.

Device conditions

In order to measure how a device prints color, we need to know its
device condition. A device condition consists of a device type and the
operating properties of the device—for example, its inks, paper, and
resolution. Every device condition has a measurable color response.

The color response of a device condition is determined by printing a
ColorFlow-generated chart and measuring the chart using a
spectrophotometer, or by importing a CGATS measurement file.
ColorFlow uses the color response of a device condition to calculate
color control elements that align the PCO to the simulation target that
you specify, and that align any SCOs to the PCO.

If you change a device condition in the color setup, ColorFlow
automatically adjusts the affected color control elements to reflect
your changes. If a physical change in the device—such as new blankets
on a press—causes the device condition's color response to change
from what it was when it was first measured, you can update the
device's color response to reflect its new color response.

See also:
Device conditions on page 45
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Appearance of a color setup
When you select a color setup in the Color Setups list, the color setup
appears in the color setup viewer.

The color setup shows the relationships between devices in a printing
task, including the conversions that occur between color outputs. A
color setup describes relationships, not a workflow—that is, it
describes what conversions occur, but not when a conversion occurs in
the workflow process.

A complete color setup must include the following:

● One PCO

● A defined simulation target for the PCO, unless the PCO uses a
CMYK Reference device condition

● A color response for each device condition

● ICC device profiles (may be required by the Prinergy workflow)

A color setup may also include the following:
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● One or more SCOs

● One or more CIs

● Other color control elements, such as curves and DeviceLink
profiles

The ColorFlow interface uses the colors green and orange to guide you
through the creation of a color setup. When you start a new color
setup, the borders and Properties icons of all device conditions in the
color setup viewer are orange. After you define the properties of a
device condition, other icons in the device condition become orange to
indicate that they need to be defined next. When all elements of the
color setup have been defined and all color control elements have been
calculated, all icons and borders in the color setup are green.

ColorFlow Icons
The color and animation of an icon indicates the processing state of the
element that is associated with it.

Icons

Icon Function

Properties Opens a dialog box in which you can specify condition
properties to define a device condition

Profile Opens a dialog box in which you can manage the profile of a
device condition or PCO

Curves Opens a dialog box in which you can define or adjust device
curves for curve-controlled devices

Measurements Opens a dialog box in which you can create a chart,
measure a printed chart, import measurement data, and
generate a report

Simulation Opens a dialog box in which you can define or adjust how
the PCO simulates a target

Conversion Opens a dialog box in which you can define or adjust how
the SCO is calibrated to align to the PCO color space or
define how CI data is modified for the PCO color space

Icon color and animation

Because ColorFlow processes are interdependent, many tasks must be
done in a specific order. The ColorFlow interface guides you through
the completion of tasks using a graphic indication of what needs to be
defined next, what is currently being calculated, and what has
completed calculation.

The color and animation of each icon indicate the processing state of
the element that is associated with the icon.

ColorFlow Icons 9



Color or
animation

Icon examples Processing state

Orange   Not complete. Define this element before
all other elements.

Black, white,
or gray

  Not complete. This element cannot be
defined until the calculation for another
element is completed.

Spinning   (Optional) Queued, waiting to calculate.

Note: Do not redefine a queued element.

Slow sweep

  

(Optional) Calculating. The green portion
of the icon indicates the amount of
calculation that is complete.

Solid green

  

Complete

Border color

When all elements in a device condition or PCO have been created, the
border around the device condition or PCO changes from orange to
green.

The following example shows a completed device condition in an
incomplete PCO.

General steps for creating a color setup
To create a color setup, you must add devices that represent the
physical devices in your shop, choose a device to go in the PCO
position, specify the device condition of that device, establish its color
response, and select its simulation target.
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Add your shop devices
Before you create a color setup, you must add the devices that are
required in the color setup.

In the Devices dialog box, you can model your print environment by
creating devices that represent specific output devices in your shop.
Examples of devices include an offset printing press, a flexographic
printing press, an inkjet printer, a digital press, and a halftone proofer.

See also:
Devices on page 41

Choose a PCO device
To create a color setup, you must drag a device from the Devices
dialog box into the PCO position in the color setup viewer.

Add your shop devices 11



The device that you drag into the PCO position is the device with the
color response to which you want all other devices in the color setup to
align. This device may be the most important or most stable device in
your shop. For example, if you use a particular proofer to create
contract proofs, you may want to choose this proofer as the PCO
device, to ensure that all devices in the color setup print the same
colors as the contract proofer. The PCO device can also be a reference
device that uses the color response of an industry specification.

To add devices to the SCO position or CI position, drag devices from
the Devices dialog box to the appropriate locations in the color setup
viewer.

After you drag a device into the color setup viewer, you must define its
device condition.

Select device condition properties
After dragging a device into a color setup, you must specify its
operating properties in the Device Condition Properties dialog box.

When you specify the operating properties of a device in the Device
Condition Properties dialog box, if you select a unique combination of
properties, ColorFlow creates a new device condition. If you select a
combination of properties that is already used by the device in a color
setup, ColorFlow uses the existing device condition.

If the device is a curve-controlled device, and you select a combination
of properties that is already used by a device of the same type,
ColorFlow adds both devices into the same device condition. For
example, two offset presses that use the same ink, paper, and
screening, can be added to the same device condition, creating pooled
devices.

You can establish the color response of each device in PCO, SCO, and
CI positions of the color setup after you define their device conditions.

See also:
Device conditions on page 45
Pooled devices in a device condition on page 61

12 Chapter 1—Introduction



Establish the color response of a device in a device condition
You must determine the color response of each device condition in the
color setup in order for ColorFlow to create color control elements
such as ICC device profiles, curves, and DeviceLinks.

You can establish the color response of a device condition by creating
and measuring a ColorFlow-generated chart, measuring a standard
chart supported by ColorFlow, or by importing existing measurement
information. It is best practice to print and measure a ColorFlow-
generated chart in order to obtain a color response for a device
condition.

In the Charts dialog box, you can create a color characterization chart,
a tonal characterization chart, or a tint ramp. After you print the chart
using your device condition, you can measure the output color using a
spectrophotometer, and enter the measurement information into
ColorFlow. On the Measurements tab of the Measurements dialog
box, you can import a .cgt or .txt measurement file that you
previously created.

Tip: If you want to practice building a color setup using the sample data provided
with ColorFlow software, you can import a sample .cgt file from C:\Program
Files\Kodak\ColorFlow\SampleData\Measurements.

For curve-controlled devices, you must define device curves in the
Default Device Curves - Definition dialog box before you can access
the Measurements dialog box. If two curve-controlled devices are
pooled in the same device condition, you must establish the color
response of each individual device. ColorFlow requires the color
response of each device in the device pool in order to create device
curves that align their color outputs.

After you establish the color response of all devices in the color setup,
you must choose a simulation target for the PCO.

See also:
Measurement charts on page 65
Color response on page 81
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Choose a simulation target for the PCO
After you establish the color response of the device in the PCO
position, you must specify the color response that you want the PCO to
simulate.

In the Simulation Definition dialog box, you select the color response
that you want the PCO to simulate. The PCO can simulate any of the
following color responses:

● An industry specification—for example, GRACoL 2006 Coated 1

● The color response of a different device condition—for example, a
reference device condition or device condition that you previously
characterized

● The PCO device condition's actual color response—no simulation
occurs in this case. (The simulation target is set to None and no
simulation curves or DeviceLinks are generated.)

It is a best practice to use a default simulation method based on the
simulation target that you select. The simulation method is the type of
curves and/or DeviceLinks that ColorFlow will generate in order to
achieve the simulation target. You can select a different simulation
method than the default recommendation, and further adjust the
generated curves and/or DeviceLinks in order to fine-tune the
simulation.

The simulation curves and DeviceLinks that ColorFlow generates are
available in the Prinergy workflow. Prinergy refines jobs to the color
response that the PCO simulates.

See also:
The color setup and the primary color output on page 89
How Prinergy uses ColorFlow elements on page 183
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Define an ICC device profile
You can define an ICC device profile for each device condition in the
color setup, as well as for the PCO.

After you establish the color response of a device condition, the best
practice is to define a profile for the device condition in the Device
Condition Profile dialog box.

After you define the PCO simulation, it is best practice to define a
profile for the PCO in the Primary Color Output Profile dialog box.

All profiles that are used in ColorFlow conform to the standards of the 
International Color Consortium (ICC). You can generate a profile by
using ColorFlow or by importing a profile that was generated using
other software. Profiles may be required in the Prinergy workflow.

See also:
Device profiles on page 121
How Prinergy uses ColorFlow elements on page 183

Define the conversion method for SCOs and CIs
If your color setup contains any SCOs and/or CIs, you must define the
conversion method between the PCO and SCO and/or between the CI
and PCO.

You can add an SCO or CI to your color setup at any time, by
performing the same actions that you performed to add the PCO. You
do not need to select a simulation target for SCOs and CIs.

Define an ICC device profile 15



PCO to SCO conversion

After you create a device condition for an SCO and define the
simulation target for the PCO, you must define the conversion between
the PCO and SCO. In the Conversion - Definition dialog box, you define
how ColorFlow is to convert data between the PCO and SCO, so that
the SCO produces the same color as the PCO.

When you open the Conversion - Definition dialog box, ColorFlow
provides a default conversion method based on the devices that are
used in the PCO and SCO. The conversion method is the type of curves
and/or DeviceLinks that ColorFlow will generate in order to align the
SCO color output to that of the PCO. You can select a different
conversion method than the default recommendation, and later adjust
the generated curves and/or DeviceLinks in order to fine-tune the
conversion.

The conversion curves and DeviceLinks that ColorFlow generates are
made available in your Prinergy process templates in the Prinergy
workflow.
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CI to PCO conversion

A CI describes how input files were prepared for a job, and how those
files should be converted for the PCO. The device condition that you
add to the CI position is usually a reference device condition that
describes an industry specification such as GRACoL.

After you create a device condition for a CI and define the simulation
target for the PCO, you must define the conversion between the CI and
PCO. In the Conversion - Definition dialog box, you define how
ColorFlow will use DeviceLinks or Profile Pairs to convert data between
the CI and the PCO, so that input files are converted to the color space
of the PCO. You can specify a different conversion method for image
content (raster objects) and graphic content (vector objects, such as
text and linework).

The color input device conditions that you define in the color setup are
made available in your Prinergy process templates in the Prinergy
workflow. ColorFlow delivers the conversion DeviceLinks or Profile
Pairs to Prinergy for content conversion.

See also:
Secondary color outputs on page 95
Color inputs on page 101
How Prinergy uses ColorFlow elements on page 183
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How ColorFlow works with Prinergy

Client-server model
ColorFlow server software is installed on the Prinergy server, and
ColorFlow client software can be installed on one or more Mac or
Windows workstations.

The connection between the ColorFlow client software and the
ColorFlow database (all of the color control elements, such as curves,
profiles, and so on) depends on how ColorFlow is licensed.

● Standalone edition: ColorFlow software and its database exist on
the same Mac or Windows workstation.

● Workflow edition and Pro Workflow edition: The ColorFlow
database is on the Prinergy server. ColorFlow software exists as a
client on one or more Mac or Windows workstations.

The ColorFlow database is called the colorstore. The colorstore
includes information about all color control elements that ColorFlow
creates. The colorstore and ColorFlow server reside on the Prinergy
server. ColorFlow client software connects to a Prinergy server and
uses the license of the Prinergy server.

Although many users can connect from the client software to the
ColorFlow server, only one user has access to the server at any
moment. A user must wait for another user to quit his or her client
software in order to start a client and gain control of the ColorFlow
server.

See also:
Prinergy workflows on page 181

ColorFlow-Prinergy terminology
Some of the objects used in ColorFlow are named differently in
Prinergy.

ColorFlow term Prinergy term

Primary color output (PCO) profile Final output process profile (refine
process template)

Color input Source or DeviceLink profile (refine
process template)

Device condition profile Proof process (Destination) profile
(output process template)

Plate setup curve Plate curve

Calibration curve Print curve (Calibration)
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2 Getting started

ColorFlow server software installation
ColorFlow server software is included in the Prinergy installer. These
instructions are for the Workflow edition and Pro Workflow edition.

Workflow editions include a ColorFlow component on the Prinergy
server, in addition to ColorFlow software on each workstation.

New Prinergy 6.0 systems are provided with ColorFlow server software
installed. If you are upgrading to Prinergy 6.0, the Prinergy installer
automatically performs the following:

● For Kodak Prinergy Connect and Kodak Prinergy Powerpack, installs
ColorFlowServer.exe in C:\program files\Kodak
\ColorFlowServer.

● For Kodak Prinergy Evo, installs ColorFlowServer.exe in C:
\program files\Kodak\Evo\<current version>
\ColorFlowServer.

● Installs the ColorFlow User Guide into the Prinergy Eclipse plug-ins
directory, so that you can access the ColorFlow User Guide from
Prinergy.

● Creates a shared network folder called ColorFlowInstaller.

When you upgrade to a newer version of ColorFlow software,
ColorFlow software automatically migrates your colorstore from the
previous version.

Installing ColorFlow client software
Install ColorFlow client software on each workstation that you will use
to create color setups.

Requirements: For Windows, Microsoft .NET framework 3.5 is required
for installing the ColorFlow client software. The user account must have
administrator privileges.



1. Locate the shared ColorFlowInstaller folder on the Prinergy
system.

2. Run the appropriate ColorFlow software installer for your
computer's operating system. Perform one of the following actions:

○ For Mac OS X, open the MacOSX folder and run
ColorFlow.dmg.

○ For Windows, open the PC folder and run
ColorFlowSetup.exe.

3. Follow the installation prompts.

ColorFlow provides device drivers for the supported measurement
devices. If you connect a measurement device to a Windows-based
workstation running the ColorFlow client software, the Windows New
Hardware Wizard should appear. If the wizard cannot automatically
find the drivers, they can be found at c:\Program Files\Kodak
\colorflow\drivers.

When you install a new version, ColorFlow automatically migrates your
data from the previous version.

Starting the ColorFlow client software
Start the ColorFlow client software to build color setups.

Perform one of the following actions:

○ For Windows, select Start > Programs > Kodak > ColorFlow >
ColorFlow.

○ For Mac OS X, select Go > Applications and, in the Applications
folder, select Kodak > ColorFlow > ColorFlow.

Licenses
The editions of ColorFlow software require different types of licenses.
The ColorFlow software, Workflow edition, and ColorFlow software,
Pro Workflow edition, obtain their licenses from the Prinergy server to
which they are connected.

The Licensing dialog box appears when you start ColorFlow software
for the first time or when a license has expired. In the Licensing dialog
box of the Colorflow Workflow and Pro Workflow editions, you can
specify the primary Prinergy server to which you want to connect.

ColorFlow software, Workflow edition, is included in the license for
Prinergy version 5.1 and later. The ColorFlow software, Pro Workflow
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edition, requires an additional Prinergy license key. For more
information about license options, see the Prinergy System
Administration Guide.

Note: There is an optional license for the Kodak Ink Optimizing Solution with only
the Pro Workflow edition.

ColorFlow software for Kodak Proofing Software runs under a single-
user license. In the Licensing dialog box of ColorFlow software, you can
connect with the Kodak licensing server. After you supply a valid
license, ColorFlow software (or ColorFlow option) will run until the
license expires.

Activating a Workflow edition license
Connect ColorFlow to a Prinergy server to use the server's license.

Note: At any time, only one ColorFlow client can access the licensing server on the
Prinergy system.

1. In the Licensing dialog box of ColorFlow, select Workflow Edition.
ColorFlow automatically finds the available Prinergy servers in the
local network.

2. If you want to view additional servers that are not on the local
network, click the add button  and, in the Server Name box, type
the name or IP address of the server to which you want to connect,
then click OK.

3. In the Prinergy Primary Server list, select a server to view its
licensed ColorFlow edition and licensed options.

4. When you have selected the required server, click OK.
ColorFlow connects to the Prinergy server, and the features that are
licensed by the server become available.

Changing the language of the user interface
You can change the language of the user interface to any of the
following: English, French, Italian, German, Spanish, Russian, Japanese,
or Chinese (simplified).

Note: If you create color setups in one language and then change the user
interface to another language, any custom property values that you defined in the
original language will stay in the original language.
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1. Perform one of the following actions:

○ For Mac OS X, select ColorFlow > Preferences

○ For Windows, select File > Preferences

2. On the User Interface tab in the Select Language list, select your
preferred language, then click OK.

Sticky notes
You can attach sticky notes to a color setup in the color setup viewer.

Creating a sticky note
You can attach a sticky note to a color setup.

1. Do one of the following:

○ For Mac OS X, press Ctrl-click anywhere in the color setup
viewer.

○ For Windows, right-click anywhere in the color setup viewer.

2. Select New Sticky Note.

3. Type the sticky note.

The sticky note remains with this color setup until you hide or delete
the sticky note. To edit a sticky note at any time, click anywhere in the
note, and type your changes.
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Moving or resizing a sticky note
Change the size or location of a sticky note in the color setup viewer.

Do one of the following:

○ To change the location of a sticky note, drag its title bar.

○ To resize a sticky note, drag any edge or corner of the note.

○ To minimize or maximize a sticky note, click the minimize
button  or the maximize button  in the title bar.

Hiding sticky notes
You can hide all sticky notes in all color setups.

1. Do one of the following:

○ For Mac OS X, press Ctrl-click in the color setup viewer.

○ For Windows, right-click in the color setup viewer.

2. Select Hide Sticky Notes.
When you hide sticky notes, the notes are hidden in all color
setups.

Showing sticky notes
You can show all sticky notes in all color setups.

When sticky notes are hidden, you can display them by selecting Show
Sticky Notes.

1. Do one of the following:

○ For Mac OS X, press Ctrl-click in the color setup viewer.

○ For Windows, right-click in the color setup viewer.

2. Select Show Sticky Notes.
When you show sticky notes, the notes are displayed in all color
setups.

Deleting a sticky note
You can delete a sticky note from a color setup.

Click the close button  in the title bar.
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Quitting ColorFlow software
Quit ColorFlow software when you finish building color setups, or when
you want to finish building a color setup at a future time.

Requirements:

Ensure that all calculations are complete before you quit ColorFlow.

Important: When you quit ColorFlow, it scans its colorstore to remove objects that
are no longer needed. This may take several seconds or minutes to complete. If
you force ColorFlow to quit during this process, the colorstore may be corrupted.

Do one of the following:

● For Windows, select File > Exit.

● For Mac OS X, select ColorFlow > Quit.
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3 Working with ColorFlow
software

Aligning an offset press to another press
There are two methods of aligning an offset press to a house standard
or another press in your shop. You can align to the press in the PCO or
you can simulate the other press.

Aligning to the press in the PCO
The typical method for aligning a press to another press is to add the
press whose color you want to simulate as the PCO.

Requirements: Your offset presses should be in good condition, and
have good process control to ensure that they produce a consistent
result from the time of characterization and beyond.

1. Add the press that you want to simulate as the PCO, then
characterize its device condition.

2. Specify no simulation for the PCO.
Select None as the PCO's simulation target.

All devices added as SCOs in this color setup will align to the actual
color response of this PCO press (your house standard).

3. Add the second press as an SCO, then characterize its device
condition.

4. Define the PCO to SCO conversion.

Example color setup

Press B is aligning to the color response of Press A.



Note: The example above shows the alignment of
sheetfed offset press conditions. The technique
applies to all device types in ColorFlow software.

Simulating the other press's color response
Another method for aligning one press to another press is to select the
press whose color you want to simulate as the simulation target of the
PCO.

If you previously created the device condition of the press whose color
response you want to simulate, you can select this device condition as
your simulation target.

1. Add the press that you want to align to another press as the PCO,
then characterize its device condition.

2. Select the device condition of the other press as the PCO's
simulation target.
For example, if the device condition of the device you want to
simulate is called "PressA, 175lpi, Cover 100lb, Offset Press -
Sheetfed, CMYK," select PressA, 175lpi, Cover 100lb, Offset Press
- Sheetfed, CMYK in the simulation target list.

Example color setup

Press B is simulating the color response of Press A's
device condition.

Note: The example above shows the alignment of
sheetfed offset press conditions. The technique
applies to all device types in ColorFlow software.

Aligning an offset press to an industry specification
You can align an offset press to an industry specification, such as
FOGRA or GRACoL.
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Simulating the industry specification
One method for aligning to an industry specification is to select the
industry specification as the simulation target of your PCO device
condition.

1. Add the press as the PCO, then characterize its device condition.

2. Select an industry specification as its simulation target.
For example, if you want to simulate GRACoL C1 2006, in the
Target list, select GRACoL C1 2006.

Example color setup

Aligning to a reference device condition in the PCO
Another method for simulating an industry specification is to add the
color response of the industry specification as the PCO.

This configuration limits the scope of your color relationship
management because you cannot adjust the simulation of a reference
device. Also, if you add multiple SCOs to this color setup, while all
SCOs will all align to the industry specification, they may not align with
each other because the PCO to SCO conversion for each SCO device
condition may be different.

1. Add a reference device condition as the PCO and select an industry
specification as its color response.
For example, if you want to simulate GRACoL C1 2006, in the
Name list, select GRACoL C1 2006.

2. Add the press as the SCO, then characterize its device condition.
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Example color setup

Aligning the color response of presses within one
device condition

To align the color response of multiple curve-controlled devices that
have the same device condition properties, you can create a device
condition that contains pooled devices.

1. Create a device condition with pooled devices.

2. Select one press as the promoted device.
ColorFlow generates device curves to align the color response of all
other devices in the device condition with the color response of the
promoted device.

Example color setup

The PCO device condition in this color setup contains two
pooled devices. Press C is the promoted device, and Press
D aligns to the color response of Press C.
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Aligning a proofer to an offset press
You can simulate on proofs, the color that you print from an offset
press.

Requirements:

Your offset press should be in good condition and have good process
control to ensure that it produces a consistent result from the time of
characterization onwards.

1. Add the press to the PCO position, then characterize its device
condition.

2. Decide what you want the press to simulate:

○ If your press was characterized to a proprietary house standard
and you want it to operate as-is with no simulation, select None
as your simulation target.

○ If you want to simulate an industry specification or the color
response of a user-defined device condition, select the
appropriate simulation target. For example, if you want to
simulate GRACoL C1 2006, in the Target list, select GRACoL C1
2006.

3. Choose a simulation method.
It is a best practice to use a curves method only—for example, Gray
Balance.

After the simulation is calculated, a set of curves is available for
export (ColorFlow Standalone) or integrated use with Prinergy.
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4. If the color result of the simulation is not meeting your expectations
on press, examine the process control of your press and/or use the
curve editing tools in ColorFlow to adjust the simulation curves.

5. After your press achieves your desired color result, add proofers to
align to your press as it simulates the target.
For example, after you verify that the color result on press with the
ColorFlow curves is meeting the GRACoL specification, add
proofers to align to your press as it simulates GRACoL.

a. Add an inkjet proofer or halftone proofer to the SCO position,
then characterize its device condition.

6. Define the PCO to SCO conversion.
ColorFlow provides a default recommended conversion method
based on the device types used in the PCO and SCO:

● If the conversion is from a press to inkjet proofer, the default
DeviceLink Method is set to Full Reseparation.

● If the conversion is from a press to halftone proofer, the default
Curves Method is set to Gray Balance with DeviceLink Method
None. However, you can use curves and a DeviceLink in the
conversion if you find a DeviceLink is needed to achieve a better
color alignment between the SCO and PCO.

Note: The proofer's gamut may limit its ability to fully simulate the colors
produced by the four-color inkset of the press.

7. Add as many inkjet proofers and halftone proofers as SCOs as you
require.

Example color setup
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Next: Create a ColorFlow report to compare the color responses of
your device conditions. The report may reveal large differences in
gamut that can lead to disparity in color fidelity.

See also:
Reporting on page 193

Aligning an offset press to an inkjet proofer
Simulate on press the color that you print from an inkjet proofer.

Because an inkjet proofer is likely to be a very stable device, you may
want to configure a proofer as the PCO in a color setup and simulate an
industry specification or a user-defined device condition.

1. Add the proofer to the PCO position, then characterize its device
condition.

2. Select a simulation target for the proofer.
You can simulate any of the following items:

● An industry specification—for example, GRACoL 2006 Coated
1.

● The color response of a different device condition—for example,
a reference device condition or device condition that you
previously characterized.

● The PCO device condition's actual color response—no
simulation occurs in this case. (The simulation target is set to
None and no simulation DeviceLink is generated.)

3. Add the press to the SCO position, then characterize its device
condition.

a. Set up the press with device curves that ensure a good starting
point for characterization.
For example, if you are printing with a high gain Kodak Staccato
screening process, select a cutback device curve. In most cases,
using the default linear device curve should provide a good
starting point for characterizing most AM print conditions.
When the press is characterized, the device curve that was used
to produce the characterization is captured. If you try to redefine
the device curve after characterization, your initial
characterization is deactivated.

b. Print and measure a color characterization chart to characterize
the press.

4. Define the PCO to SCO conversion.
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Example color setup

Aligning an offset press to a halftone proofer
On press, you can simulate the color that you print from a halftone
proofer.

Using a halftone proofer as a PCO to simulate an industry specification
or a user-defined device condition has the following advantages:

● The halftone proofer is likely a very stable device.

● Halftone donor material has pigmentation properties similar to
offset ink pigmentation. While this is not the only factor in achieving
a good colorimetric alignment, it is essential for achieving a proper
metameric alignment to your press sample.

● You may be familiar with the gamut range of your halftone proofer.
This allows you to edit color control elements, see the effects of
your edits immediately on proof output, and propagate these edits
to the offset press.

1. Add the proofer to the PCO position, then characterize its device
condition.

2. Select a simulation target for the proofer.
You can simulate any of the following:

○ An industry specification—for example, GRACoL 2006, Coated
1.

○ The color response of a different device condition—for example,
a reference device condition or a device condition that you
previously characterized.

○ The PCO device condition's actual color response—no
simulation occurs in this situation. (The simulation target is set
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to None, and no simulation curves or DeviceLinks are
generated.)

3. Add the press to the SCO position and characterize its device
condition.

a. Set up the press with a device curve that ensures a good starting
point for characterization.
For example, if you are printing with a high gain Kodak Staccato
screening process, select a cutback device curve. In most cases,
using the default linear device curve should provide a good
starting point for characterizing most AM print conditions.
When the press is characterized, the device curve that was used
to produce the characterization is captured. If you attempt to
redefine the device curve after characterization, your initial
characterization is deactivated.

b. Print and measure a color characterization chart to characterize
the press.

4. Define the PCO to SCO conversion.

Example color setup

Propagating PCO simulation adjustments to an SCO
When you adjust the PCO simulation, ColorFlow automatically adjusts
the SCO conversion link to reflect the change.

The color relationship management of ColorFlow can track color
adjustments from device condition to device condition.

1. Create a complete color setup that has a PCO and an SCO.
For example, create a color setup with a proofer as the PCO and a
press as an SCO, and define all simulations and conversions.
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2. Make a change to the PCO simulation.
Your change is propagated to the SCO.
The specific changes that are tracked from PCO to SCO are:

● If the simulation uses curves only—edits to simulation curves

● If the simulation uses curves and a DeviceLink, or only a
DeviceLink—edits to simulation DeviceLink Input Tonality only

Example

Using the following color setup, you can proof a change to
the simulation, and the change is automatically applied to
the press color response. Note that the PCO profile is
being recalculated because you changed the simulation.

Note: When you make a change to the simulation,
ColorFlow maps the color conversion to preserve
the color alignment between PCO and SCO.
However, while your modification on proof may be
within the proofer's gamut, the press may not be
able to fully represent the modification.
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Using an SCO device condition as the PCO device
condition in another color setup

You can use the SCO device condition in one color setup as the PCO
device condition in another color setup.

1. Create a new color setup.

2. From the Devices dialog box, drag a device into the PCO position.
This should be the same device that you used in the SCO position in
another color setup.

3. When you define the device condition properties for the device,
select the same properties that you selected for the device in the
other color setup.

The same device condition is used in both color setups. You do not
need to print and measure a chart again for this device condition.

Note: If you use the same device condition in more than one color setup and you
make changes to the device condition in one color setup, the device condition is
affected in all color setups where it is used. For example, if the same device
condition is used in color setup A and color setup B, and you make a change to the
device curves in color setup A, the device curves for the device condition are
automatically changed in color setup B. If you change the Selection Properties of a
device condition in a color setup, you are choosing a different device condition for
use only in the color setup shown in the viewer. The original device condition will
continue to be used (unaffected) in other color setups that use it.

Example

The device condition for Press A is used as an SCO in the
following color setup.

The same device condition, for Press A, is used as the
PCO in the following color setup.
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See also:
How device conditions are created on page 47

Linearizing platesetter output
You can use plate setups to create ColorFlow plate lines that linearize
plates for your offset device.

1. When you create the device condition for an offset press, assign a
plate setup to the device condition.

2. Add the required plate lines to the plate setup.
Each plate setup can contain multiple plate lines. Plate lines are
used to compensate for variable differences between output
devices and plate processing units.
For example, you may have two plate processors, Processor A and
Processor B, that produce slightly different outputs. In this case,
you can create two different plate lines, LotemFibrehead-
Wednesday_Chemistry-ProcessorA-Prebake, and
LotemFibrehead-Wednesday_Chemistry-ProcessorB-Prebake.

3. For each plate line, determine the measured reading of the Image
Control Strip and type the reading values into the Measured Tint
(uncalibrated) boxes in the Plate Setups dialog box.
A plate line in ColorFlow creates a plate curve in Prinergy. In
Prinergy, you can select the appropriate plate line to use for a job
based on the output device that will be used.

See also:
Plate setups on page 157
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Printing as you did with Harmony, without
characterizing device conditions

If you previously used Kodak Harmony software to create a transfer
calibration curve that produces a desired color response on a device,
you can use this transfer calibration curve as a device curve in
ColorFlow so you can continue printing the same color using ColorFlow
as you did when you used Harmony.

In order to characterize a device condition in ColorFlow, it is best
practice to print and measure a chart. If you do not want to print and
measure a chart for your device immediately, you can import an
existing transfer calibration curve from Harmony. The transfer
calibration curve that you import is used as a device curve in
ColorFlow. You can use this device curve to continue printing in
ColorFlow without characterizing the device condition.

Note: When you import a Harmony transfer calibration curve without
characterizing the device condition, you cannot use ColorFlow computations to
manage the color response of the device condition. You cannot generate any color
control elements in ColorFlow until you characterize the device condition using
measurement data. When you use an uncharacterized device condition as a PCO
or SCO, the simulation or conversion curves are linear, and the response will be
the same as when you used Harmony.

1. To the PCO position, add the device for which you previously
created Harmony transfer calibration curves.

2. Define the device condition for this device.

3. In the device condition, click the Default Device Curves icon .

4. In the Default Device Curves Definition dialog box, in the Curve
Origin area, select Imported, and click Import.

5. Locate the .hmy file you want to import, and click Open.

6. In the Import Harmony Transfer Curve dialog box, select the
transfer calibration curve for this device, and click OK.
In the Default Device Curves Definition dialog box, the curve name
that you selected appears.

7. Click OK.

8. In the PCO, click the Simulation icon .

9. In the Target list, select None, and click OK.
You can now use this color setup to print the same color that you
printed when you used Harmony. The color setup contains only a
device curve; it does not contain measurement data or simulation.

Note: You can adjust the simulation curves to alter
the color response of the device or pool of devices.
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You can also adjust the device curves imported
from Harmony to alter the color response of one of
the devices. When you import a Harmony curve in
the Default Device Curves Definition, the imported
curves will be used by default for devices added to
a device pool. You can import unique Harmony
curves for each device by clicking the Device
Curves icon for a device, and redefining the device
curves.

Example

Note that various elements in this color setup are orange,
indicating that the color setup is not complete.

Next:

At a later time, characterize the device condition by printing and
measuring a chart so you can use the full capabilities of ColorFlow.

Note: If you do not update the simulation curves, the device(s) will print the same
color as it did before the response measurement. You can also reuse the device
condition in another color setup, where you can align its response to a desired
target.

Importing elements from other products
You can import ICC device profiles and ICC DeviceLink profiles that
you generated from Kodak Profile Wizard or other software.

1. To import an ICC device profile for a device condition, click its
Profile icon , and import the profile in the Device Condition Profile
dialog box.

Note: If none of the devices in the device condition have a measured response,
the imported profile will define the color response of the device condition. If
the device condition already has a color response that was derived from
measurement data, importing a profile will not replace this color response.
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2. To import a DeviceLink profile for a PCO, click the Simulation icon
, and select DeviceLink method: Imported in the Simulation -

Definition dialog box to import the profile. For an SCO or color
input, click the Conversion icon  between the PCO and SCO or
color input, and import the DeviceLink profile in the Conversion -
Definition dialog box.

Importing elements from other products 39



40 Chapter 3—Working with ColorFlow software



4 Devices

About ColorFlow devices
A ColorFlow device is a representation of a particular physical device in
your printing environment.

The Devices dialog box shows all of the devices that have been defined
for your shop. When you create a device in ColorFlow, you select a
device type from a list and assign a meaningful name to it in order to
identify it as a particular device in your shop. The device type you select
determines what types of properties can be associated with the device.
To add a device to a color setup, you drag it from the Devices dialog
box to the PCO, SCO, or CI position in the color setup viewer.

A device in ColorFlow does not contain any information about its
operating conditions, such as the paper, inks, and other parameters that
it uses to print. When you specify these operating properties for a
device, you create a device condition. One device can be associated
with many device conditions. If you rename a device, the device name
changes in all color setups where all of its device conditions are used.
You can delete any device that you create if it is not currently used in
any device conditions. You cannot delete a reference device.

Curve-controlled devices

A curve-controlled device is a print device for which a curve can be
applied during output in order to modify color response. Curve-
controlled devices that have the same device type and device condition
properties are automatically pooled into one device condition.

The following ColorFlow devices are curve-controlled devices:

● Offset Press – Sheetfed

● Offset Press – Heatset Web

● Offset Press – Coldset Web

● Flexographic Press

● Digital Halftone Proofer – Approval

● Digital Halftone Proofer – Spectrum

● Digital Halftone Proofer – Other

● Digital Press - Versamark

● Digital Press - Prosper



Non-curve-controlled devices

A non-curve-controlled device is a print device that normally does not
use curves to control color. Non-curve-controlled devices cannot be
pooled in the same device condition, even if they are of the same
device type.

The following ColorFlow devices are non-curve-controlled devices:

● Digital Press – Kodak NexPress

● Digital Press – Other

● Inkjet Proofer – Matchprint Inkjet

● Inkjet Proofer – Veris

● Inkjet Proofer – Other

Reference devices

Reference Device Conditions are available for both RGB and CMYK.
ColorFlow has built-in devices named CMYK Reference and RGB
Reference. You can use the CMYK Reference device to specify a print
device condition that has a color response for which there is no
physical device—for example, for an industry specification such as
FOGRA 39. Similarly, you can create a custom CMYK Reference that
represents a proofing system from which you receive proofs, by
measuring a test proof in ColorFlow.

Use the RGB Reference to define the RGB capture or display devices.
You can select from one of the built-in RGB device conditions, or create
a custom RGB Reference device condition with an imported RGB device
profile, such as a camera or scanner profile.

See also:
ColorFlow device conditions on page 45
Reference device conditions on page 51
Ink Optimizing Input device on page 206

Creating a ColorFlow device
You can add a device to represent a physical device in your shop.

1. The Devices palette automatically appears in the ColorFlow
workspace, with the Add device drop-down already open to make it
easier for you to add a new device. If the Devices palette is not
open in your ColorFlow workspace, select View > Devices.

Tip: You can double-click anywhere in the background of the color setup
viewer to open the Devices palette.
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2. In the Device Name box, type a name for the device you want to
add.

3. In the Device Type list, select the device type.

4. Click Create.
The new device appears in the Devices section.

Before you can determine the color response of this device, you must
define its device condition.

See also:
ColorFlow device conditions on page 45

Renaming a ColorFlow device
You can change the name of an existing device.

You cannot change the name of a reference device.

1. The Devices palette automatically appears in the ColorFlow
workspace, with the Add device drop-down already open to make it
easier for you to add a new device. If the Devices palette is not
open in your ColorFlow workspace, select View > Devices.

Tip: You can double-click anywhere in the background of the color setup
viewer to open the Devices palette.

2. In the Devices section, double-click the device.

3. Type a new Device Name.

The device name is changed in all color setups where the device is
used. To refresh its name in the color setup viewer, select a different
color setup.

Deleting a ColorFlow device
You can delete a device that you no longer need.

Note: You cannot delete a reference device or a device that is used in a device
condition.

1. The Devices palette automatically appears in the ColorFlow
workspace, with the Add device drop-down already open to make it
easier for you to add a new device. If the Devices palette is not
open in your ColorFlow workspace, select View > Devices.

Tip: You can double-click anywhere in the background of the color setup
viewer to open the Devices palette.
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2. In the Devices section, select the device and perform one of the
following actions:

○ For Windows, press Delete.

○ For Mac OS X, press Fn (Function key)+Delete.

Tip: You can right-click the device in the Devices section, and select Delete.
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5 Device conditions

ColorFlow device conditions
Device conditions are the basic building-blocks of a color setup. You
assign a device condition to a device after you drag the device into the
color setup viewer.

To create a device condition, you need to specify a device's operating
properties—for example, the ink type, paper type, and screening that
the device uses. The following two sets of properties are examples of
two different device conditions:

● Offset press A, using Staccato 10 screening, Cover 100lb paper

● Offset press A, using Staccato 20 screening, Cover 100lb paper

A device condition is uniquely defined by its properties. That is, there can
be only one device condition that has a particular set of properties. For
example, if you add a device to the PCO position of one color setup and
assign to it a particular combination of operating properties, and you
add the same device to the SCO position of another color setup and
assign to it the same combination of operating properties, the same
device condition is used in both color setups. If you make a change to
this device condition in one color setup, the device condition is changed
in both color setups.

After you create a device condition, it appears in the Device Conditions
dialog box, which is available from the View > Device Conditions menu
item. In the Device Conditions dialog box, you can view the device
conditions that have been created for each device type or delete a
device condition from the system. Device conditions that you create
also appear in the list of simulation targets and in the Name list in the
Device Conditions Properties dialog box for reference device
conditions.

Device condition properties

Depending on the device type that is used in a device condition, you are
required to specify different device condition properties in the Device
Condition Properties dialog box. For example, for a digital halftone
proofer, you are required to specify values for Screening and Substrate.
For an inkjet proofer, you are required to specify values for Resolution
and Substrate. You cannot add, change, or delete a device condition
property. You can only customize the list of values that are available for
each device condition property.



The list of values for a device condition is shared among some, but not
all, device types that use the property. For example, the device
condition property Screening is used for offset presses, digital presses,
and digital halftone proofers. If, while creating a device condition for an
offset press, you add 133lpi as a value for Screening, this value also
becomes available for most digital presses and digital halftone
proofers. But this value is not available for Versamark digital press
device conditions, because this device type uses special screens.

Similarly, Substrate values are shared among offset presses and digital
halftone proofers, because these devices can often use the same
substrates. But Matchprint Inkjet device conditions have a unique set
of substrate values to reflect media that is qualified for these devices.

If you want to use the same Screening or Substrate value with two
device types that do not share property values, add the value when
defining the device conditions for each device type.

The Other property allows you to associate custom values with a
device condition. You can use this property to create a difference
between two similar device conditions. For example, if two offset
presses use the same inks, screening, and paper, but you want to
create a unique device condition for each press, you can use an Other
value to differentiate the two device conditions. Similarly, you can
declare Other values Standard Inks and Fine Art Inks to distinguish
device conditions that use these two ink sets with the same Screening
and Substrate values.

The properties identified above appear in the Selection Properties
section of the dialog to indicate that they are used to differentiate
device conditions. The Spot Inks property allows you to declare spot
ink channels for the device condition, and designate the curve channel
that the workflow uses for a separation with the spot ink name. The
curve channel may be another ink's curve or a custom curve. You can
add as many spot inks as you require. When you add a spot ink to an
existing device condition, it does not create a new device condition.
The existing device condition is modified to include the spot ink
wherever it is used.

See also:
Ink Optimizing Device Condition on page 206

Components of a device condition
In the color setup viewer, a device condition is displayed inside a green
or orange border.

All elements inside the border, including device curves, measurements,
and profiles, are part of the device condition.
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1. Device type: a visual representation of the device

2. Device name: the name that you assigned to this device

3. Device condition name: the name that is automatically generated
for this device condition

4. Properties icon: use to specify device condition properties

5. Default Device Curves icon: use to define initial device curves for all
devices

6. Device Condition Profile icon: use to manage the device profile

7. Device Curves icon: use to define and adjust device curves

8. Measurements icon: use to establish the color response of the
device condition

How device conditions are created
If you select a unique combination of Selection Properties when you
specify the device condition Selection Properties for a device,
ColorFlow creates a new device condition. If you select the same
combination of Selection Properties that are found in an existing
device condition for the device, ColorFlow uses the existing device
condition.

ColorFlow does not let you create two device conditions that have the
same device type and Selection Properties—for example, the same
device type, screening, substrate, etc. This has several advantages:

● It eliminates needless duplication of device conditions.

● It forces the reuse of device conditions across color setups. After
you characterize a device condition once, you do not need to print
and measure charts again every time you need to use the device
condition in a new color setup.

● Except for reference device conditions, you do not need to name a
device condition. A device condition name is automatically
generated based on its properties. Every device condition name is
unique and describes the device condition fully. Reference device
conditions, however, can have user-defined names.
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In some cases, you may require two distinct device conditions even
though both device conditions have the same device type, screening,
substrate, and so on. You can use the Other device condition property
to create custom values that can be used to differentiate two device
conditions, making them separate device conditions.

If you add a new device and try to create a device condition that uses
the same properties as an existing device, the following actions occur:

● If the device is a curved-controlled device, ColorFlow pools the
device into the existing device condition.

● If the device is a non-curve controlled device, it cannot be pooled
into an existing device condition. You can use the existing device
condition as a generic device condition for both devices, or you can
create a second device condition for this device by making its
properties unique. You can use the Other device condition property
to include custom values that differentiate this device condition
from the existing device condition.

Note: If you use the same device condition in more than one color setup and you
make changes to the device condition in one color setup, the device condition is
affected in all color setups where it is used. For example, if the same device
condition is used in color setup A and color setup B, and you make a change to the
device curves in color setup A, the device curves for the device condition are
automatically changed in color setup B. If you change the Selection Properties of a
device condition in a color setup, you are choosing a different device condition for
use only in the color setup shown in the viewer. The original device condition will
continue to be used (unaffected) in other color setups that use it.

See also:
Pooled devices in a device condition on page 61

Defining a device condition
You can select device condition properties to create a new device
condition or to use an existing device condition.

1. In the color setup viewer, click the Properties icon  in a device
condition.

2. In the Device Condition Properties dialog box, select the
appropriate Selection Property values for your device type:
Different Selection Properties are available depending on your
device type.

Plate Setup

Enable the Plate setup check box to select a plate setup
from the list. The list is filtered to display plate setups for
the chosen device type. Click the edit icon  to display the
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Plate Setups dialog box, where you can add or edit a plate
setup.

Screening

Select the type of screening used in this device condition.
You can select the type of screening only if you did not
select a plate setup. If you need to add more values, click the
edit button.

Resolution

Select the resolution used in this device condition (inkjet
only). If you need to add more values, click the edit button.

Substrate

Select the type of paper or substrate used in this device
condition. The list is filtered based on the device type. If you
need to add more values, click the edit button.

3. Define spot inks for the device condition; click the add button  to
add any number of inks. (The Spot Inks section appears for curve-
controlled device conditions only. It lets you select which curve
channel will be used for declared spot inks. The ink named
"Default" determines the curve channel that will be used for
undeclared spot inks.)

a. Double-click under Color to choose a suitable color (for visual
recognition only).

b. Click under Name to enter the name of the spot ink.

c. Click under Curves to assign a curve channel to be used for the
spot ink. Selectable curve channels include Custom, all process
ink names, and all other spot ink names that use Custom curves.
Selecting Custom creates a custom curve channel for the spot
ink. Initially, the custom curve is identical to the curve channel
previously selected for the spot ink, but can be adjusted without
affecting other curve channels.

4. Click OK.

If you selected a unique combination of Selection Property values,
ColorFlow software creates a new device condition. If you selected a
combination of properties that can be found in an existing device
condition for this device, ColorFlow software uses that device
condition. If the device is a curve-controlled device, and you selected a
combination of properties that is already used by a device of the same
type, ColorFlow software pools both devices into the same device
condition.
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Next:

If you created a new device condition, you must establish the color
response of the device condition. If the device condition contains a
curve-controlled device, you must select a device curve to use when
printing a chart to establish the color response of the device condition.

See also:
Device curves on page 54
Ways to establish the color response of a device condition
on page 84

Deleting a device condition from the system
You can delete a device condition that you no longer need.

Note: Removing a device condition from a color setup does not delete the device
condition from the system. When you remove a device condition from a color
setup, the device condition can still be viewed from the Device Conditions dialog
box.

You cannot delete a device condition that is used in a color setup.

1. Select View > Device Conditions.

2. In the Device Types list, select the device condition's device type.

3. In the Device Conditions list, select the device condition and click
the delete button.

4. Close the Device Conditions dialog box.

Add, delete, or rename values of a device condition
property

You can modify the list of values that are available for a device
condition property.

Your changes will affect the property values in all the device types that
share the same property values.
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1. In the Device Condition Properties dialog box, click the edit button
 beside a property whose values you want to modify.

2. In the dialog box that appears, perform one of the following actions:

○ To add a value, click the add button  and type a name for the
value.

○ To delete a value, select the value and click the delete button
.

○ To rename a value, double-click the value and type a new name
for the value.

3. Close the Device Conditions dialog box.

Reference device conditions
Reference device conditions are used in ColorFlow software to
represent the color response of inputs or outputs for which there is no
physical device. They most commonly represent published
characterization data or printing aim points of industry specifications,
such as GRACoL C1 and Fogra 39. These are called CMYK Reference
device conditions in ColorFlow software. ColorFlow software also
supports RGB Reference device conditions.

Reference device conditions are defined using the built-in CMYK
Reference or RGB Reference device, instead of a physical device that
you declare.

You can use the built-in measurement data of an industry specification
as the color response of a reference device condition. You can also use
an arbitrary color response that you have measured from a printed
sample, such as a supplied proof or purchased reference sheet.

CMYK reference device conditions
CMYK reference device conditions are often used in a color input to
define the color space of CMYK input files. They may also serve as a
PCO or SCO, when you want to output CMYK files instead of printed
output. Finally, they are often used as the simulation target of a PCO.

Because they are not associated with physical output devices,
reference device conditions do not have device condition properties
relating to inks, substrate, screening, or resolution. The Separate Same
As property of the CMYK Reference device defines the default black
generation parameters of the device condition. Because black
generation parameters are different for different device types, you can
choose the device type whose black generation strategy should be
provided by default for the reference device condition that you create.
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Using a built-in reference device condition
ColorFlow software includes built-in CMYK Reference device
conditions that encapsulate the color response of industry
specifications or printing aim points.

1. From the Devices dialog box, drag the CMYK Reference into the
color setup viewer.

○ To create output that aligns to an industry specification, drag
the device into the PCO position.

○ To specify that input files should be reseparated from the color
space of an industry specification to the PCO color space, drag
the device into the CI position.

2. In the color setup viewer, click the Properties icon  in the CMYK
Reference device condition.

3. In the Name list, select an industry specification such as GRACoL
C1 or FOGRA 39.

Note: There are tonal responses added to the GRACoL C1, SWOP C3, and SWOP
C5 built-in device conditions that are estimated from their colorimetric response,
according to ISO recommendations. This facilitates their use as a simulation target
with the Tonal Match curves method.

Next:

Generate a device profile for the reference device condition.
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Using a custom CMYK reference device condition
You can create a reference device condition that uses a color response
that you supply.

1. Drag the CMYK Reference from the Devices dialog box to the color
setup viewer.

○ To create output that aligns to this color response, drag the
device to the PCO position.

○ To specify that input files should be reseparated from the color
space of this color response to the PCO color space, drag the
device to the CI position.

2. In the color setup viewer, click the Properties icon  in the CMYK
Reference device condition.

3. In the Name list, type a name for the reference device condition.

4. In the Separate Same As list, select a device type that best
represents the printing technology of the reference device
condition. This will determine the black generation strategy for
separating content for this device condition.
For example, if your reference device condition color response will
be measured from a supplied sheetfed press sample, select Offset
Press - Sheetfed.

5. Characterize the reference device condition.
You can measure a chart or import existing measurements.

The reference device condition that you created is now defined for use
as a color input or output, and is also available in the list of simulation
targets.

RGB reference device conditions
RGB reference device conditions are used exclusively for color inputs
to define the color space of RGB input files. An RGB reference cannot
be used as a PCO.

You can select from one of the following built-in RGB reference device
conditions:

● Adobe RGB (1998)

● eciRGB v2

● ProPhoto RGB

● sRGB IEC61966-2.1

You can also create a custom RGB Reference device condition to
represent the color response of an RGB scanner or camera.

Using a custom CMYK reference device condition 53



Using a built-in RGB reference device condition
You can select a built-in RGB reference for a color input.

1. From the Devices dialog box, drag the RGB Reference into the color
input position of the color setup viewer.

2. In the color setup viewer, click the Properties icon  in the RGB
Reference device condition.

3. In the Name list, type a name for the reference device condition.

Note: These built-in device conditions are based on published RGB profiles. You
cannot adjust or replace these profiles. Click the Profile icon  to view profile
properties.

Using a custom RGB reference device condition
You can select a custom RGB reference for a color input.

1. From the Devices dialog box, drag the RGB Reference into the color
input position of the color setup viewer.

2. In the color setup viewer, click the Properties icon  in the RGB
Reference device condition.

3. In the Name list, type a name for the reference device condition and
close Properties.

4. In the color setup viewer, click the Profile icon  in the RGB
Reference device condition.

5. Click Import, and browse to an RGB ICC device profile.

Device curves
You can select the device curve that is applied to a curve-controlled
device during plate making to control color. You can also define bump
or cutoff curves for flexographic printing.

Before you can characterize the device condition of a curve-controlled
device, you must select a device curve to use with the device condition.
Because a device curve is used during the initial characterization of the
device, it remains as part of any calibration curve that is subsequently
calculated and used on the device.

The device curve that you select can be a linear curve, cutback curve,
or Harmony transfer calibration curve that you import into ColorFlow
software. A linear curve does not change the color output of a device—
no calibration is applied during output. You can use a cutback curve to
compensate for the high dot gain of some screening methods. If you
used a Harmony transfer calibration curve to print a chart, or if you
previously created a Harmony transfer calibration curve for the device,
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you can import the curve to calibrate the device to a desired color
response.

Device curves provide a separate curve channel for each process ink in
the device condition. Spot inks may have custom curve channels, or
they may use another ink's curve.

After you characterize a device, you should only adjust device curves in
order to correct the device's color response—for example, in case of a
color shift.

If a device condition contains pooled devices, ColorFlow software can
generate device curves that align the color response of non-promoted
devices in the device condition to that of the promoted device. This
occurs automatically when you characterize any non-promoted device.

If the color response of either the promoted or non-promoted device
contains tonal response information only, ColorFlow software
calculates the non-promoted device curves for process inks according
to the Tonal Match method. If the color response of both devices
contains colorimetric response information, ColorFlow software uses
the Gray Balance method to calculate the process ink curves.

ColorFlow software always uses the Tonal Match method to calculate
spot ink device curves.

See also:
Pooled devices in a device condition on page 61
Correcting a color shift on a curve-controlled device on page 86

Selecting default device curves
Select the device curves that curve-controlled devices should use by
default, during plate making.

1. In a device condition in the color setup viewer, above the devices,
click the Default Device Curves icon .

2. In the Default Device Curves - Definition dialog box, in the Curve
Origin area, select Preset.

3. Select one of the following options:

○ To characterize the device condition in an uncalibrated state, in
the list, select Linear.

○ If you know that the uncalibrated device's dot gain (or TVI) is in
excess of 30%, select 15% Cutback in the list.

○ If the device condition is for the Flexographic press device type,
you can select from a family of preset curves designed for
printing with Kodak Flexcel NX plates.

For example, if you are characterizing a coldset web press that is
printing on newsprint with Staccato 35, select 15% Cutback.
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Note: If you have characterized a device response with the 20% Cutback
curve, you can continue to use it. For new characterization of high-gain device
conditions, the 15% Cutback curve is recommended.

4. To view the default device curves you have selected, click View
Curves.

5. If the device condition is for the Flexographic Press device type,
define Mindot Bump / Cutoff curve values.

6. Click OK.
The default device curves that you selected will be used as device
curves for all devices in the device condition. The device curves will
be used to print the measurement chart, and are part of the
calibration curves for each device.

Importing default device curves
You can import a Harmony transfer calibration curve set as ColorFlow
default device curves.

Note: You can only import a Harmony transfer calibration curve into ColorFlow.
You cannot import a Harmony derived calibration curve.

1. In a device condition in the color setup viewer, above the devices,
click the Curves icon .

2. In the Device Curves - Definition dialog box, in the Curve Origin
area, select Imported, and click Import.

3. Locate the .hmy file that you want to import, and click Open.

4. In the Import Harmony Transfer Curve dialog box, select a CMYK
curve set to use for CMYK device curve channels.
In the Device Curves Definition dialog box, the curve name that you
selected appears.

5. To use the Black Harmony curve for custom spot ink curve, select
Import Black curve for all Custom spot ink curves.

6. Click OK.

7. Import Harmony spot ink curves for use as Custom spot ink curve
channels.

a. Locate the .hmy file and click Open.

b. Select a Spot curve and click OK.

If the device condition has a spot ink with the same name that uses
a Custom curve, the Harmony Spot curve will be imported.

8. To view the default device curves you have selected, click View
Curves.

9. If the device condition is for the Flexographic Press device type,
define Mindot Bump / Cutoff curve values.
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10. Click OK.
The curves that you imported are used as device curves for all
devices in the device condition. The device curves will be used to
print the measurement chart, and are part of the calibration curves
for each device.

See also:
Defining bump and cutoff curves on page 57
About importing curves on page 109
Viewing curves using the Curves View-Edit tool on page 117

Defining bump and cutoff curves
You can define bump or cutoff curves separately for process and spot
ink curve channels of a device condition for the Flexographic Press
device type. The ColorFlow controls described in this section do not
appear for device types other than Flexographic Press.

1. In a flexographic press device condition in the color setup viewer,
above the devices, click the Default Device Curves icon .

2. In the Default Device Curves - Definition dialog box, use controls in
the Mindot Bump / Cutoff area to define curve settings below.

3. In the Process Inks (CMYK) - Tint In box, enter the CMYK input
file tint percentage that you want to produce the minimum
printable dot on plate.
All input tints less than this value will produce no dot on the plate.

4. Select the setting you want for Snap Tint In to 8-bit values:

○ If Snap Tint In to 8-bit values is selected, the Tint In value you
enter is snapped to a tint percentage value that corresponds to
an 8-bit value between 0 and 255, commonly called a system
value. For example, if you enter 0.5%, the value snaps to 0.39%,
which corresponds to system value 1.

○ To preserve a Tint In value as entered, such as 1.00%, clear
Snap Tint In to 8-bit values and re-enter the value.

When you enter a Tint In value, ColorFlow sets the Minimum Tint
Out to the output value of the Preset or Imported curves that you
have defined in the Curve Origin area, evaluated at the Tint In
value. A file input value equal to Tint In produces an output tint
equal to Minimum Tint Out in the halftone output image delivered
to plate imaging. For some plating and screening technologies, the
dot produced by this output tint is printable. If this is the case for
your plate and imaging system, leave the Minimum Tint Out value.
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5. If this evaluated output value does not produce a printable dot,
enter the minimum printable dot in the Process Inks (CMYK) -
Minimum Tint Out box. You cannot enter a value less than the
evaluated curve output value.
The Process Inks (CMYK) - Minimum Tint Out values define the
process inks Mindot.

6. Define the desired Mindot behavior with Allow Tint Out increase
to improve color match. Selecting Allow Tint Out increase to
improve color match is recommended.
For more information, see the Defining Mindot Behavior section.

7. To view the curves that you have defined, click View Curves.
The process inks Mindot appears as a solid dot on the C, M, Y, and
K curves.

If you have entered a Minimum Tint Out value, the Mindot you
defined will lie above the curve defined in Curve Origin. ColorFlow
creates a smooth curve from the Mindot to the curve you have
defined.

8. To adjust the transition from the Mindot to the defined curve,
adjust the Highlight Contrast slider. You can also enter a value in
the box. For most cases, the default value of 70% is acceptable.

○ Reducing Highlight Contrast produces a curve that is flatter
near the Mindot, meeting the defined curve at a lower point but
reducing contrast in this region.

○ Increasing Highlight Contrast produces a curve that preserves
highlight contrast, but meets the defined curve at a higher point.

9. Enter Spot Inks - Tint In and Minimum Tint Out values to define
the spot inks Mindot.

10. Click OK.
The bump or cutoff default device curves you have defined are used
as device curves for all devices in the device condition. The device
curves will be used to print the measurement chart, and are part of
the calibration curves for each device.

See also:
Selecting default device curves on page 55
Importing default device curves on page 56
Defining Mindot behavior on page 58
Viewing curves using the Curves View-Edit tool on page 117
Bump and cutoff curves on page 164

Defining Mindot behavior

You can configure ColorFlow-generated device curves to ensure that a
file input value equal to the Mindot Tint In value always produces an
output tint equal to the Mindot Minimum Tint Out in the halftone
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output image delivered to the plate imaging system. Or, you can
configure ColorFlow to increase the output value produced by Mindot
Tint In to improve color match in the Mindot and highlight region.

1. In the Default Device Curves - Definition dialog box, perform one of
these actions:

○ Clear the Allow Tint Out increase to improve color match check
box to ensure that a file input value equal to the Mindot Tint In
value always produces an output tint equal to the Mindot
Minimum Tint Out in the halftone output image delivered to the
plate imaging system.

○ Select the Allow Tint Out increase to improve color match
check box to increase the output value produced by Mindot Tint
In to improve color match in the Mindot and highlight region.

2. Click OK.
The Allow Tint Out increase to improve color match setting takes
effect when ColorFlow generates device curves for a demoted
device in a device pool of Flexographic Press devices. The setting in
the Default Device Curves - Definition dialog box provides a default
value for each device that you add to the pool. You can change the
setting for individual devices. The setting also provides a default
value for simulation and conversion curves of PCOs and SCOs that
use the device condition you are defining. You can change the
setting for individual PCOs and SCOs.

See also:
Allow Tint Out increase to improve color match control on page 170

Specifying device curve selection for Prinergy
The device curves you define are part of the calibration curves
delivered to Prinergy. The device curves are normally fetched from the
snapshot selected in Prinergy for output.

For Prinergy output from the Approved snapshot, you can configure
ColorFlow to deliver device curves from the ColorFlow current state,
instead of device curves from the Approved snapshot. This lets you
adjust and use device curves to reflect a change in press behavior,
without needing to capture and approve a snapshot for production
output.
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1. In a device condition in the color setup viewer, above the devices,
click the Default Device Curves icon .

2. In the Device Curve Selection for Prinergy area, specify what
should happen when Prinergy requests curves from the Approved
snapshot:

○ To deliver device curves from the current state, select the Use
Current State for Approved Snapshot check box.

○ To deliver device curves from the Approved snapshot, clear the
Use Current State for Approved Snapshot check box.

The selection applies to device curves for all devices in the device
condition.

See also:
Prinergy and snapshots on page 181

Defining device-specific device curves
You can define the device curves that a specific curve-controlled
device in a device condition will use during plate making, replacing the
default device curves for the specific device. You can also define
device-specific bump or cutoff curves for flexographic printing.

1. In a device condition in the color setup viewer, next to the device
for which you want to define specific device curves, click the
Curves icon .

2. In the Device Curve Adjustments dialog box, click Redefine.

3. In the Device Curves - Definition dialog box, in the Curves Origin
area, select preset curves or import Harmony curves as described
for default device curves. View the curves if desired.

4. If the device condition is for the Flexographic Press device type,
define Mindot Bump / Cutoff curve values.

5. Click OK.
The specific device curves will be used to print the measurement
chart, and are part of the calibration curves for the device.

See also:
Selecting default device curves on page 55
Importing default device curves on page 56
Defining bump and cutoff curves on page 57
Pooled devices in a device condition on page 61
Viewing curves using the Curves View-Edit tool on page 117
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Reverting to default device curves
If you have defined specific device curves for a device, or adjusted its
device curves, you can revert the device curves to the default device
curves.

1. In a device condition in the color setup viewer, next to the device
for which you want to revert the device curves to default curves,
click the Curves icon .

2. In the Device Curve Adjustments dialog box, click Redefine.

3. In the Device Curves - Definition dialog box, click Default.

4. To view the curves that you have preset or imported, click View
Curves.

5. Click OK.
The default device curves will be used to print the measurement
chart, and are part of the calibration curves for the device, until you
make changes to the device curves.

Pooled devices in a device condition
With curve-controlled devices, you can include more than one device
in a device condition.

In order to add more than one device in the same device condition, the
devices must have the same device type and device condition
properties. For example, if you have two offset presses that use exactly
the same ink, paper, and screening, you can pool the presses into one
device condition. After you add pooled devices to a device condition,
the devices are pooled in all color setups where the device condition is
used. If you remove a pooled device from a device condition, the device
is removed from the device condition in all color setups where the
device condtition is used.

There are several advantages to pooling devices:

● Fewer ICC device profiles

● Fewer DeviceLink profiles

● Simpler color setups

One device in the device condition is the promoted device. The name of
the promoted device appears in bold. The color response of the
promoted device is used as the color response of the device condition.
Pooled devices in a device condition do not need to have identical
uncalibrated color responses. ColorFlow automatically calculates
device curves that align to the color responses of all other devices in a
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device condition to the color response of the promoted device. A
device can only be promoted after it is characterized.

When ColorFlow calculates device curves to align a device to the
promoted device response, it automatically changes the device curves
Curve Origin to ColorFlow Generated. It does this for each non-
promoted device when it is characterized. The device curves of the
promoted device retain their original Preset or Imported origin.

See also:
Color response of a pooled device condition on page 83

Adding a curve-controlled device to an existing device
condition

You can create a device condition with pooled devices.

Requirements: You can only add a pooled device to a device condition
if both devices are curve-controlled devices, and if they have the same
device type and device condition properties.

1. The Devices palette automatically appears in the ColorFlow
workspace, with the Add device drop-down already open to make it
easier for you to add a new device. If the Devices palette is not
open in your ColorFlow workspace, select View > Devices.

Tip: You can double-click anywhere in the background of the color setup
viewer to open the Devices palette.

2. Drag a device from the Devices dialog box into an existing device
condition in the color setup viewer.

3. Characterize the devices in the device condition.
By default, the first device that you characterize becomes the
promoted device.

ColorFlow calculates device curves that align the color response of
all other devices in the device condition with the color response of
the promoted device.

After you characterize another device in the device condition, you can
manually select it as the promoted device.
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Promoting a pooled device in a device condition
You can select a different device in a pooled device condition to be the
promoted device.

1. In the color setup viewer, in a device condition with pooled devices,
click the Measurements icon  for the device that you want to
promote.

2. Click the Measurements tab.

3. Click Promote Device.

The color response of the device you promoted is now the color
response of the device condition. Any affected color control elements
are automatically recalculated.
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6 Measurement charts

About the measurement chart
ColorFlow can generate charts that are suited to your device inkset, the
size of your printing device, and your measuring instrument.

You can generate the following chart types:

Color Characterization

Measure this chart with a spectrophotometer to establish a
colorimetric response and a tonal response.

Tonal Characterization

Measure this chart with a spectrophotometer to establish only a
tonal response.

Tint Ramp

Measure this chart manually, and enter values into ColorFlow to
establish a tonal response.

In order to characterize a printing device, it is best practice to create
and print a ColorFlow characterization chart. You can also import a
measurement file that you previously created. The measurement data
that you import must be in a .cgt file, CGATS.5 format, or .txt file.

You can measure a ColorFlow-generated chart with any of the following
measurement devices:

● X-Rite Eye-One Pro Spectrophotometer,* with or without UV filter

● X-Rite i1 iO Table with X-Rite Eye-One Pro Spectrophotometer,*
with or without UV filter

● X-Rite iSis Spectrophotometer*

● X-Rite iSis XL Spectrophotometer*

● Techkon RS-800 (supported on a PC only)

*Spectrophotometer available from Kodak.

Note: [X-Rite Isis Revision, version model E, Spectrophotometer should work but
has not been fully tested.]



Forms

The entire measurement chart, including footer, is often printed on a
single form which is ready for imposition. However, if you are using a
very small press, your chart may be distributed across multiple forms.

A form contains several measurement pages that are suited to your
color measuring device. After printing the chart, you may need to
physically cut out each page from the press sheet(s) in order to
measure the color patches.

Each measurement page contains color patches that are a few
millimeters in width. The total number of patches that are printed in a
chart depends on the number of process inks that are used. The
standard four-color CMYK inkset requires about 1600 patches.

The chart in the following example consists of four measurement
pages which are contained in a single form.

1. Form

2. Measurement page

3. Patch

Fold lines and cut lines

When you create a color characterization chart or tonal
characterization chart, you can specify the fold lines and/or cut lines
that will be used by the in-line folder of your web press. Because
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folding or other mechanical action on paper affects color,
measurement pages are not printed on fold lines and/or cut lines.

To specify fold lines and/or cut lines, in the Force Page Breaks area,
select the number of partitioned areas you want to have across and
down the form. The default value is 1 across, 1 down—that is, one
contiguous area with no fold and/or cut lines.

In the following example, a chart was created with no fold lines and/or
cut lines.

In this chart, the printable area is divided into six measurement pages
to accommodate the measurement device.

When the value for Across is changed to 2, the measurement pages
are resized in order to avoid a vertical fold and cut line in the center of
a chart, as indicated by the orange line in the chart illustration in
ColorFlow. (This orange line does not appear in the exported PDF file.)

In this chart, each half of the printable area is subdivided into four
measurement pages to accommodate the measurement device.

Chart naming

When a new chart is added to the workflow and processed for output,
it is automatically assigned a default name CMYK_0, CMYK_1, etc.
You can rename these charts and give them a name that is more
meaningful.

Dimensions

You can specify chart measurements in inches, points, or millimeters.
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Creating a color characterization chart to fill the
printable area

You can create a full-color chart that completely fills the printable area
you have specified.

If all the required color patches do not fit on a single form, a second
form will be created. Each form is the same size, but reduced in width
(as much as possible).

1. Select View > Charts.

2. Click the add button .

3. In the Chart Type list, select Color Characterization.

4. In the Page list, select the spectrophotometer that you will use to
measure the pages of this chart.
The measuring device type that you select determines the
maximum size of measurement pages in the chart.

5. In the Color Bar list, select the device that you will use to scan the
color bar at the bottom of each form.
The color bar may be used to perform sheet selection from a press
run.

Note: If your chart size is too narrow, the color bar will not appear and you will
not be able to use it to perform sheet selection.

6. In the Height box, type the height of the form(s) that you want to
create. In the Width box, enter the maximum allowable width of the
form(s).
Usually, this is the safe printable width on your printing device,
excluding marks and color bars.

7. In the Form Layout area, select Fill Printable Area.

8. If the substrate is not completely opaque and you need to print the
same color patches on both sides of the sheet, select Front and
Back Forms.

9. In the Across and Down lists in the Force Page Breaks area, specify
the areas where measurement pages should not be placed.
Typically, these are the fold and/or cut lines that the in-line folder
of a web press will use.

For example, for a typical 8-up layout, select 4 for Across and
select 2 for Down.
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10. Perform one of the following actions:

○ If you want to apply a uniform background tint in all areas
outside the measurement pages to assist with ink takeoff on all
ink channels, select the Background Tint check box.

○ If you do not want to use a tinted background, clear the
Background Tint check box.

11. Roll your mouse over the chart.
If the chart extends over multiple forms, an indicator appears and
displays the form number of the form that you are current viewing.
Click the arrows on the indicator to view a different form.

12. Rename the chart (as required) by selecting the name in the Charts
pane.

13. Click Save.

14. Export the chart.

a. Click Export.

b. Browse to the location where you want to export the chart for
later imposition and printing, then click Save.

The color characterization chart is created as an imposition-ready PDF
(.pdf) file. If the chart has multiple forms to accommodate a small
printable area, each form is a separate page in the exported PDF file.

You can use the same chart to characterize different devices in the
same device condition, or different device conditions, if the devices can
accommodate the chart size.

Creating the smallest possible color characterization
chart

By default, the specified printable area of the chart is filled with as
many patches as possible to maximize the quality of the measured
characterization data. You can create a full-color chart that contains
only the minimum number of color patches needed to characterize the
printing device. The height of the chart will be set equal to the height
specified for the printable area; the width of the chart will be reduced
without eliminating necessary patches.

If all the required color patches do not fit on a single form, a second
form will be created. Each form is the same size, but reduced in width
(as much as possible).
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1. Select View > Charts.

2. Click the add button .

3. In the Chart Type list, select Color Characterization.

4. In the Page list, select the spectrophotometer that you will use to
measure the pages of this chart.
The measuring device type that you select determines the
maximum size of measurement pages in the chart.

5. In the Color Bar list, select the device that you will use to scan the
color bar at the bottom of each form.
The color bar may be used to perform sheet selection from a press
run.

Note: If your chart size is too narrow, the color bar will not appear and you will
not be able to use it to perform sheet selection.

6. In the Height box, type the height of the form(s) that you want to
create. In the Width box, enter the maximum allowable width of the
form(s).
Usually, this is the safe printable width on your printing device,
excluding marks and color bars.

7. In the Form Layout area, select Minimize Form Size.

8. Change the chart Height dimension if necessary to adjust the
aspect ratio of the form(s).

9. If the substrate is not completely opaque and you need to print the
same color patches on both sides of the sheet, select Front and
Back Forms.

10. In the Across and Down lists in the Force Page Breaks area, specify
the areas where measurement pages should not be placed.
Typically, these are the fold and/or cut lines that the in-line folder
of a web press will use.

For example, for a typical 8-up layout, select 4 for Across and
select 2 for Down.

11. Perform one of the following actions:

○ If you want to apply a uniform background tint in all areas
outside the measurement pages to assist with ink takeoff on all
ink channels, select the Background Tint check box.

○ If you do not want to use a tinted background, clear the
Background Tint check box.

12. Roll your mouse over the chart.
If the chart extends over multiple forms, an indicator appears and
displays the form number of the form that you are current viewing.
Click the arrows on the indicator to view a different form.
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13. Rename the chart (as required) by selecting the name in the Charts
pane.

14. Click Save.

15. Export the chart.

a. Click Export.

b. Browse to the location where you want to export the chart for
later imposition and printing, then click Save.

The color characterization chart is created as an imposition-ready PDF
(.pdf) file.

You can use the same chart to characterize different devices in the
same device condition, or different device conditions, if the devices can
accommodate the chart size.

Creating a tonal characterization chart
You can create a chart that will produce only tonal information.

A tonal characterization chart has fewer patches than a color
characterization chart.

1. Select View > Charts.

2. Click the add button .

3. In the Chart Type list, select Tonal Characterization.

4. In the Page list, select the spectrophotometer that you will use to
measure the pages of this chart.
The measuring device type that you select determines the
maximum size of measurement pages in the chart.

5. In the Height box, type the height of the form(s) that you want to
create. In the Width box, enter the maximum allowable width of the
form(s).
Usually, this is the safe printable width on your printing device,
excluding marks and color bars.

6. If the substrate is not completely opaque and you need to print the
same color patches on both sides of the sheet, select Front and
Back Forms.

7. In the Across and Down lists in the Force Page Breaks area, specify
the areas where measurement pages should not be placed.
Typically, these are the fold and/or cut lines that the in-line folder
of a web press will use.

For example, for a typical 8-up layout, select 4 for Across and
select 2 for Down.
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8. Perform one of the following actions:

○ If you want to apply a uniform background tint in all areas
outside the measurement pages to assist with ink takeoff on all
ink channels, select the Background Tint check box.

○ If you do not want to use a tinted background, clear the
Background Tint check box.

9. Rename the chart (as required) by selecting the name in the Charts
pane.

10. Click Save.

11. Export the chart.

a. Click Export.

b. Browse to the location where you want to export the chart for
later imposition and printing, then click Save.

The tonal characterization chart is created as an imposition-ready PDF
(.pdf) file.

You can use the same chart to characterize different devices in the
same device condition, or different device conditions, if the devices can
accommodate the chart size.

Creating a tint ramp chart
You can create a tint ramp chart to manually measure tint values.

The size of the tint ramp chart is fixed. You can only measure it using a
hand-held measuring device.

1. Select View > Charts.

2. Click the add button .

3. In the Chart Type list, select Tint Ramp.

4. Click Save.

5. Export the chart.

a. Click Export.

b. Browse to the location where you want to export the chart for
later imposition and printing, then click Save.

The tint ramp chart is created as an imposition-ready PDF (.pdf) file.
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Exporting a chart
You can export a chart that you previously created, in order to print it.

You can export a chart any time after you create and save it.

1. Select View > Charts.

2. In the Charts list, select the chart that you want to export.

3. Click Export.

4. Browse to the location where you want to export the chart, and
click Save.
All charts are saved as imposition-ready PDF files.

Printing the chart and selecting sample sheets
You can print the chart from your press and select sample sheets for
measurement. The following instructions apply mostly to offset
presses, but you can modify them to suit other types of output devices.

Requirements:

● Print the chart using the same substrate, screening, and ink that you
specified in the ColorFlow device condition.

● Print the chart on a warm press only. Do not print the chart on a
press that has been idle for an extended length of time.

● Ideally, the press should be in the middle of a maintenance cycle
when printing the ColorFlow chart.

● Check form roller stripes 8 hours before printing the chart.

○ If necessary, reset roller stripes to the manufacturer's
specifications.

○ Replace any damaged rollers as part of regular maintenance. Do
not change rollers specifically for printing the ColorFlow chart.

● Check blanket height.

○ If necessary, repack blankets.

○ Replace any damaged or worn blankets as part of regular
maintenance. Do not change blankets specifically for printing the
ColorFlow chart.

● Ensure that the dampening solution's conductivity, pH, and
temperature are within tolerance levels. Do not change the
dampening solution specifically for printing the ColorFlow chart.

Exporting a chart 73



1. Locate the ColorFlow chart that you exported.

2. Impose it as an entire sheet and, if appropriate, apply a color bar for
press and plate marks.

3. In ColorFlow, create a snapshot in order to make the new device
condition available in Prinergy.

Note: You do not have to approve the snapshot.

4. Create a test job in Prinergy to print the chart.

5. In the Prinergy process template editor, select the appropriate
device and device condition to output the chart.
Prinergy applies the device curves that you selected for this device.

6. Operate the press in the same way that you operate during regular
production.

a. Print the ColorFlow chart with uniform solid ink densities across
the entire form, at densities within ±0.05 density of house or
standard target values.
If solid ink densities vary by more than 0.10 density units across
the target press sheet, you should not use the press sheet to
characterize your press.

Note: If you applied a background tint on the form, the background tint
color should be consistent across the form, but it does not need to be a
neutral color.

b. Inspect the lithographic performance to ensure correct ink and
water balance, and correct wet trap.
Ensure that no tinting or toning is present in the live area of the
sheet and check slur targets for doubling or sheet movement
issues.

c. Print to the target values of your house standard densities or an
industry standard.
Avoid making density adjustments based on visual assessment
of color.

7. Maintaining correct solid ink densities, print at least 500 sheets.

8. Select 5 to 10 sample sheets from a point in the press run where
you confirmed densities to be accurate and stable.

Note: If you replaced any blankets for this press run, check the blanket packing
again before you select any press sheets.

The sample sheets should be at least 25 sheets from the end of the
run to avoid shutdown color drift. If the chart includes a color bar,
ColorFlow can perform sheet selection to choose one or more
printed sheets that are deemed to best represent the color
response of the device condition.

9. Visually inspect the sample sheets for printing defects in the color
patches area.
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Next:

Ensure that the printed sheets are sufficiently dried before you
measure them.

Measuring the chart
You can measure the color on your printed chart using a supported
measurement device.

Requirements: If necessary, allow sheets to dry for several hours before
measuring. For inkjet printing technologies, wait at least 30 minutes
before measuring a printed chart.

1. Examine the chart that you printed to determine the chart name.

2. In a device condition in the color setup viewer, click the
Measurements icon  next to a device.

3. Click the Charts tab.

4. In the Charts list, select the chart that you want to measure.

5. Click Measure.

○ If you are measuring a color characterization chart or tonal
characterization chart, follow the instructions in the Chart
Measurement wizard.

○ If you are measuring a tint ramp chart, use a hand-held
measuring device to determine the EDA value for the tint of
each ink, and enter the value in the Tint Ramp Chart
Measurement dialog box.

When you have measured all the required sheets for a color
characterization chart or tonal characterization chart, ColorFlow
activates the characterization data and creates a color response for
this device condition.

Suspending measurement
Measuring multiple sheets to accurately characterize a print device is a
time-consuming process. It may be convenient to suspend
measurement, in order to perform other ColorFlow tasks or other
responsibilities.

ColorFlow lets you suspend measurement at many points in the
measurement process. For automated devices, you can suspend
measurement before any page measurement. For the X-Rite i1 Pro, you
can suspend measurement prior to scanning any row of patches.
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To suspend measurement, click Suspend in any measurement control
dialog.

Suspend will save all acquired measurements and close the
measurement control dialog. The suspended measurement data set
will not appear in the Measurements tab, because it is incomplete. If
you close the Measurements dialog and quit ColorFlow, your
suspended measurement will be retained.

After suspending measurement, you can start a measurement session
for any other device or device condition. You can also resume any
suspend measurement.

To resume a suspended measurement:

1. In a device condition in the color setup viewer, click the
Measurements icon  next to the device whose measurement you
suspended.

2. Click the Charts tab.

3. In the Charts list, select the chart whose measurement you
suspended.

4. Click Measure.

For hand-held devices, ColorFlow will indicate the sheet,
page, and row you were measuring when you suspended
measurement. You can resume the measurement, or
discard the saved measurements and restart the
measurement process. If you resume measurement, the
process will continue as though you had not suspended
the session. You can suspend the session at any time.

While you are measuring, ColorFlow automatically saves
all measurement data and information. If a system or
power failure causes ColorFlow to quit unexpectedly, your
measurements are retained as though you suspended the
measurement session. To recover, resume the
measurement as described above.

Remeasuring pages
When you are measuring charts, it is possible for ColorFlow to acquire
bad data samples from the measurement device. Bad measurements
are often caused by an incorrect scanning path of the measurement
head, whether it is scanned automatically or manually.

As measurements are acquired from the measurement device,
ColorFlow performs a cursory data check that may result in another
scan of the page row. It is difficult to detect errors at this stage without
the risk of rejecting good measurements. Consequently, this check has
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a very wide tolerance, making it possible for measurement errors to
remain in the data set after measurement is complete.

When ColorFlow activates a complete measurement set, it can
perform a more thorough and stringent data check. This test allows for
the detection of measurement errors that were previously overlooked.

If a patch measurement error is detected, ColorFlow tries to correct the
error using other patch measurements with the same tint value. If a
correction is not possible, ColorFlow launches the Remeasure Pages
control dialog.

In the Remeasure Pages control dialog, ColorFlow identifies the form,
sheet, and patches that contain errors. If you choose to Continue the
process, ColorFlow will prompt you to load each page containing errors
for remeasurement. If you are measuring with the X-Rite i1 Pro, you will
be prompted to remeasure only those page rows that contain errors.

After remeasuring the necessary patches, ColorFlow will repeat the
data check with the new measurement values. If errors remain, the
Remeasure Pages dialog is launched again, perhaps identifying another
sheet that contains errors.

There may be situations where the form contains a large number of
printing defects, making remeasurement unsuccessful. In this case,
reprinting the form is necessary. To affect this action in the Remeasure
Pages dialog, click Reprint, instead of Continue. This provides three
options in the measurement process:

● Suspend measurement while the form is being reprinted.

● Remeasure newly printed sheets, discard all the measurements for
the form, but keep measurements of other forms (if the chart
contains more than one form).

● Return to the Remeasure Pages dialog.
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Activating a measurement set
You can establish a new color response for a device condition based on
measurement data that you previously collected for the device
condition.

1. In a device condition in the color setup viewer, click the
Measurements  icon next to a device.

2. In the Measurements dialog box, click the Measurements tab.

3. Expand the Inactive Measurements section, and select a
measurement set.

4. Click Activate.
A color response is calculated from the measurement set that you
selected, and replaces the previous color response of this device
condition.

Exporting measurement data
You can export a measurement data set from ColorFlow.

1. In a device condition in the color setup viewer, click the
Measurements  icon next to a device.

2. In the Measurements dialog box, click the Measurements tab.

3. In the Active Measurement area, select a measurement set.

4. Click Export.

5. Browse to the location where you want to save the measurement
set, and click Save.
The measurement data is saved as a .cgt file, in CGATS.5 format.

Importing measurement data
Instead of printing and measuring a chart, you can import
measurements that you previously saved for a device condition.

Requirements: Before you can import measurement data for the device
condition, you must define the device condition.
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1. In a device condition in the color setup viewer, click the
Measurements icon  next to a device.

2. In the Measurements dialog box, click the Measurements tab.

3. In the list, select Measurement Data, then click Import.

4. Locate the measurement file that contains the measured data for
your device condition, and click Open.

5. If a previous measurement already exists for this device condition,
click Yes to deactivate the previous measurement.
Information about the measurement file that you imported appears
in the Active Measurement area.
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7 Color response

About color response
Color response describes the relationship between input values of a
digital file and the output color, such as the color on a press sheet.

If an output device, using one device condition, is maintained in a stable
operating state, its color response remains the same from day to day. If
you change the device condition of the output device—for example, if
you change its paper type—the color response of the device changes.

The color response of the same device, under different device
conditions, is different for each device condition. ColorFlow uses the
color response of each device condition to generate color control
elements that produce the color you want on output.

The color you want on output is defined by the color response of the
primary color output (PCO). You define the color response of the PCO
by defining the PCO simulation target. Rather than the actual color
response of the simulation target, the color response of the PCO is the
predicted color response of your PCO device condition when it simulates
the target. For example, if you select GRACoL C1 as the simulation
target for your press, the color response of the PCO is the press's color
response when it simulates GRACoL C1. Depending on inherent
limitations of your press, the PCO color response may or may not
achieve GRACoL C1.

Colorimetric response and tonal response

Color response can be categorized into two types:

Colorimetric response

The relationship between input data (in the color space of the
device) and output colors (in a device-independent color space
such as CIELAB), is known.

Tonal response

The relationship between input data and the resulting effective
dot area (EDA) on the printed sheet is known. A tonal response
contains no color data.

The type of color response that you obtain from a chart depends on the
type of chart that you measure and how you measure it. When you
print a ColorFlow color characterization chart and measure it with a



spectrophotometer, you can determine the colorimetric response and
tonal response of a device condition.

ColorFlow requires colorimetric data to generate profiles or
DeviceLinks. After you have established the color response of a device
condition, the device condition's color response type is displayed in the
Type column on the Measurements tab of the Measurements dialog
box.

● Color Only indicates a CIELAB colorimetric response

● Tonal Only indicates a tonal response

● Tonal and Color indicates a CIELAB colorimetric and tonal
response, obtained from spectral or CIELAB and density
measurements

When you define the PCO simulation, the PCO device condition's color
response type affects the simulation targets and simulation methods
that you can use.

Type of color
response

Available for
device types

Obtained from Use with
simulation
targets

Allows simulation
methods

Colorimetric
(spectral)

any One of the following:

● Measure ColorFlow color
characterization chart

● Import suitable ColorFlow
measurements

Fogra, GRACoL,
SWOP, ISO TVI
curves

Gray Balance
curves, DeviceLink,
Tonal Match curves

Colorimetric
(CIELAB)

any One of the following:

● Measure ColorFlow color
characterization chart

● Import suitable CIELAB
measurements

● Import ICC profile

Fogra, GRACoL,
SWOP

Gray Balance
curves, DeviceLink

Tonal (density,
EDA)

curve-
controlled
devices

One of the following:

● Measure ColorFlow color
characterization chart

● Measure ColorFlow tonal
characterization chart

● Measure tint ramp

● Import density measurements

ISO TVI curves Tonal Match curves
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Color response of a device condition
Before ColorFlow can generate color control elements to calibrate a
device condition, you must establish the color response of the device
condition.

After you establish the color response of a device condition, you should
not change it. If you use a device condition in several color setups,
changing the device condition's color response will cause elements in
all color setups to be recalculated.

Occasionally, the color produced by a curve-controlled device may
change from the color that it produced when you first characterized its
response in a device condition. For example, the dot gain of an offset
press may vary with temperature or a change in the blanket type,
causing a color shift. You can correct this shift in color by adjusting
device curves to return the device to its original printing behavior.

You can view the color response of a device condition in the following
ways:

● If the device is a curve-controlled device, and the device condition
has a tonal response, click Device Tonality in the Device Curves -
Adjustment dialog box to view the tonal response of the device
condition. This response does not include a device curve—it shows
the uncalibrated device tonality and does not show any device curve
that may have been applied when you printed the measurement
charts.

● Print a press sheet or proof to see evidence of the color response.

● Use other software to look at a device condition profile and obtain
information about the device condition's color response.

See also:
Correcting a color shift on a curve-controlled device on page 86
Uncalibrated Device Tonality dialog box on page 235

Color response of a pooled device condition
When multiple devices are pooled in the same device condition, the
color response of the promoted device is the color response of the
entire device condition.

If you select a different device to be the promoted device, you change
the color response of the device condition to be the color response of
the newly promoted device. ColorFlow automatically calculates new
device curves to align the color response of all other devices in the
device condition to the color response of the newly promoted device. It
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also recalculates appropriate color control elements that reflect the
device condition's new color response.

Ways to establish the color response of a device
condition

There are several ways to establish the color response of a device
condition.

You can do any of the following:

● Measure a ColorFlow chart

● Activate an existing measurement set

● Import existing measurements

● Import a ICC device profile. This only produces a colorimetric
response. If the device condition already has a color response that
was derived from measurement data, importing a profile does not
replace the existing color response.

See also:
Measuring the chart on page 75
Activating a measurement set on page 78
Importing measurement data on page 78
Importing a device profile on page 124

Color response of the PCO
ColorFlow uses the color response that you establish for the PCO
device condition to calculate color control elements that allow the PCO
device condition to simulate a target color response.

The PCO device condition, simulating the target that you select, is the
color response of the PCO. For example, after you establish the color
response of the PCO device condition, you can use it to simulate an
industry specification such as GRACoL. In this case, the PCO device
condition as it simulates GRACoL is the color response of the PCO.

The color response of the PCO is a predicted color response. The PCO
device condition may or may not achieve the simulation target exactly,
depending on its inherent limitations.

While the color response of a device condition should not be adjusted
after it is established, you can adjust the color response of the PCO at
any time by adjusting simulation curves and DeviceLinks. When you
adjust the PCO color response, ColorFlow automatically propagates
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necessary changes to any secondary color outputs (SCOs) and/or
color inputs (CIs) in the color setup.

Ways to establish the color response of the PCO
You can establish the color response of the PCO by selecting a
simulation target or by importing an ICC device profile for the PCO.

The PCO may have a colorimetric response or tonal response,
depending on the way the simulation target is defined, and depending
on the PCO device condition's color response type.

If the device condition in the PCO has a colorimetric color response,
you can generate ICC profiles and DeviceLinks, and use the tonal-
match or gray-balance method to generate curves. If the device
condition in the PCO has a tonal color response, or if the simulation
target only contains tonal data—for example, if the simulation target is
an ISO TVI curve—you can only use the tonal-match method to
generate simulation curves.

The principal way to establish a PCO color response is to define the
simulation. You define the simulation by clicking the Simulation icon

, and selecting a simulation target and simulation method.

Another way to establish a PCO color response is to import an ICC
device profile as the PCO profile. You import a profile by clicking the
Profile icon  in the PCO, and selecting Imported.

Note: If measurement data is available for the PCO device condition, ColorFlow
uses the measurement data for calculations by default. A PCO profile that is
generated by ColorFlow is not used as the color response of the PCO, and is not
used in any calculations.

PCO color response adjustment
You can adjust the color response of the PCO by adjusting simulation
curves and DeviceLinks.

Adjusting the PCO color response is an overall adjustment. When you
adjust the color response of the PCO, your adjustments may propagate
changes to CIs and SCOs in the color setup.

When you adjust the color response of the PCO, your adjustments do
not affect the device condition(s) in the PCO, and they do not affect
any other color setups.

You can force ColorFlow to recalculate any calibration curves or
DeviceLinks for the PCO, as well as any calibration curves or
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DeviceLinks for any SCOs. When you recalculate a calibration curve,
any adjustments that you previously made to the curves are lost.

See also:
Propagating PCO simulation adjustments to an SCO on page 33

Correcting a color shift on a curve-controlled device
Occasionally, the color produced by a curve-controlled device may
change from the color that it produced when you first characterized its
response in a device condition. For example, the dot gain of an offset
press may vary with temperature or a change in the blanket type,
causing a color shift. You can correct this shift in color by adjusting
device curves to return the device to its original printing behavior.

If you notice that the color produced by a device has shifted from when
you first established its color response, you can recharacterize the
device condition by printing and measuring a chart, or you can adjust
the device's device curves. Device curve adjustments let you
compensate for a change in the response of the device without
recharacterization. When you adjust device curves, ColorFlow updates
the uncalibrated color response of the device to reflect its current
printing behavior. For example, if you notice that a device is printing
less magenta in the midtones than it printed when it was first
characterized, you can adjust its device curves using the Curve
Adjustments tool to indicate that more magenta is required in the
midtones.

1. In a device condition in the color setup viewer, next to the device
for which you want to adjust a device curve, click the Curves icon

.
The Device Curves - Adjustment dialog box appears and displays
the Curve Adjustments tool.

2. Make your adjustments.
For example, move the 50% slider for the magenta channel
upwards to indicate a required increase in tonality.
When you move the slider upwards, the following changes can be
observed:

● In the Device Curves dialog box, the magenta curve rises to
darken the magenta tonality on output.

● In the Uncalibrated Device Tonality dialog box, the magenta
tonality decreases.

● In the Image Preview window, the current section of the preview
image changes to contain less magenta.

These changes indicate that the color response of the device in the
device condition, without its magenta device curve, contains less
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magenta tonality, or gain, than the previously established color
response for the device condition. That is to say, this device
condition currently prints less magenta than it printed when you
first characterized it. When you print with the updated magenta
device curve, the output device will print with the desired magenta
tonality, despite the decrease in its uncalibrated magenta tonality.
The effect of the adjustment to correct the tonality back to the
measured response is indicated by the corrected section of the
preview image remaining constant.

Correcting the color response of a curve-controlled device by adjusting
device curves has no effect on the color response of the device
condition. Instead, the uncalibrated response of the device is deemed
to have changed; therefore, its device curves are updated to align the
device color response, including device curves, to the desired color
response of the device condition.

When you update the uncalibrated color response of a device in a
device condition by adjusting its device curves, the update takes effect
not only for that device, but in all color setups that use the device
condition. However, any simulations and/or conversions that use the
device condition are not recalculated, because simulation and
conversion curves exist independently of device curves. When you
output a file, the updated device curve is combined with a conversion
curve or simulation curve to form the print calibration curve that
produces your desired color output.

See also:
About previewing images on page 149
Device Curves dialog box on page 234
Uncalibrated Device Tonality dialog box on page 235
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8 The color setup and the
primary color output

About the color setup and the primary color output
Every color setup has a primary color output (PCO), and every PCO has
a simulation target.

The PCO is at the center of the color setup—it is a color reference point
to which all devices in the color setup will be aligned. The PCO includes
a device condition and a simulation target.

After you define the device condition of the device in the PCO position,
you can define the PCO's simulation target. The PCO's simulation
target is the color response that the PCO device condition simulates,
using curves and/or DeviceLinks that ColorFlow generates.

When you click the Simulation icon  in the PCO, the Simulation
Definition dialog box appears. In the Simulation Definition dialog box,
you can choose a simulation target for the PCO device condition. The
simulation target can be any of the following:

● An industry specification—for example, GRACoL 2006 Coated 1

● The color response of a different device condition—for example, a
reference device condition or device condition that you previously
characterized

● The PCO device condition's actual color response—no simulation
occurs in this case. (The simulation target is set to None and no
simulation curves or DeviceLinks are generated.)

Based on the PCO device type and simulation target that you select,
ColorFlow displays a recommended simulation method. ColorFlow can
use curves and/or DeviceLinks to transform the color response of the
device condition in the PCO to the simulation target that you specify.
When you add a secondary color output (SCO) to the color setup,
devices in SCOs will align to the PCO's simulation target.

For example, if you select GRACoL 2006 Coated 1 as your simulation
target, the default simulation method for curves is Gray Balance.

See also:
Simulation targets and methods on page 268



Creating a color setup
You can add a new, empty color setup to the Color Setups list to start a
new color setup.

1. In the Color Setups list, click the add button .

Note: If you are starting ColorFlow for the first time, an empty color setup
automatically appears in the Color Setups list.

The Devices dialog box appears, and a new empty color setup
named Untitled_<n> appears in the Color Setups list.

2. Double-click Untitled_<n >, and type a new name for the color
setup.

3. Create the PCO device condition.

See also:
Creating the PCO device condition on page 91

Duplicating a color setup
You can duplicate an existing color setup to create a similar color setup
with a different simulation target.

1. In the Color Setups list, select the color setup that you want to
duplicate.

2. Select Edit > Duplicate Color Setup.
The color setup you duplicated appears in the Color Setups list as
<color setup> copy.

3. To change the name of the new color setup, double-click its name
in the Color Setups list, and type a new name.

Deleting a color setup
You can delete a color setup that you no longer need.

1. In the Color Setups list, select the color setup that you want to
delete.

2. Click the delete button .

3. In the dialog box that appears, click Yes to confirm the deletion.
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Creating the PCO device condition
You can add the PCO of a color setup.

1. Drag a device from the Devices dialog box into the PCO position in
the Color Setup Viewer.

2. Define the device condition for the PCO device.

Next: Define the PCO's simulation target.

See also:
Defining a device condition on page 48

Simulating a target
You can simulate an industry specification, the color response of a
different device condition, or use the PCO device condition's actual
color response.

Simulating an industry specification
You can simulate an industry specification such as GRACoL or a
FOGRA specification.

1. In the color setup viewer, in the PCO, click the Simulation  icon.

2. In the Simulation Definition dialog box, in Target list, select the
industry specification that you want the PCO to simulate.
It is a best practice to use a default simulation method based on the
simulation target that you select. The simulation method is the type
of curves and/or DeviceLinks that ColorFlow will generate in order
to achieve the simulation target. You can select a different
simulation method than the default recommendation, and further
adjust the generated curves and/or DeviceLinks in order to fine-
tune the simulation.

3. To select a different curve or DeviceLink than the default
recommendation, use the Curves Method or DeviceLinks Method
selector to select the method.
If the PCO device is not a curve-controlled device, the Curves
Method selector is not available.

4. Click OK.
ColorFlow calculates the required color control elements. The
Simulation icon shows the progress of the calculation.

See also:
Simulation Definition (PCO to target) dialog box on page 236
Simulation targets and methods on page 268
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Simulating another device condition
Simulate a reference device condition, or the color response of a device
condition that you previously defined and characterized.

1. In the color setup viewer, in the PCO, click the Simulation  icon.

2. In the Simulation Definition dialog box, in Target list, select the
device condition that you want the PCO to simulate.
It is a best practice to use a default simulation method based on the
simulation target that you select. The simulation method is the type
of curves and/or DeviceLinks that ColorFlow will generate in order
to achieve the simulation target. You can select a different
simulation method than the default recommendation, and further
adjust the generated curves and/or DeviceLinks in order to fine-
tune the simulation.

3. To select a different curve or DeviceLink than the default
recommendation, use the Curves Method or DeviceLinks Method
selector to select the method.
If the PCO device is not a curve-controlled device, the Curves
Method selector is not available.

4. Click OK.
ColorFlow calculates the required color control elements. The
Simulation icon shows the progress of the calculation.

See also:
Simulation targets and methods on page 268

Using the PCO device condition's actual color response
You can use the PCO device condition's color response without
simulating another target.

1. In the color setup viewer, in the PCO, click the Simulation  icon.

2. In the Simulation Definition dialog box, in Target list, select None.

3. Click OK.
No DeviceLink is generated. If the PCO device condition is a curve-
controlled device, a linear simulation curve is generated.

Note: This simulation curve may be adjusted to modify the PCO color response
away from the device condition's actual color response. The device condition
remains unaffected.
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Adjusting simulation curves
After you examine the color output of the PCO, if you want to produce
a closer color alignment between the PCO and its simulation target,
adjust the simulation curves that ColorFlow has calculated.

Simulation curves are available only for curve-controlled devices.

1. In the color setup viewer, in the PCO, click the Simulation icon .

2. In the Simulation Adjustment dialog box, click the Curves tab (this
is selected if the DeviceLink method is None).
The Curve Adjustment tool appears.

3. Make the appropriate adjustments.

4. Click Apply to save your changes.

See also:
About adjusting curves on page 111
Adjusting curves using the Curve Adjustments tool on page 113

Adjusting a simulation DeviceLink
After you examine the color output of the PCO, if you want to produce
a closer color alignment between the PCO and its simulation target,
adjust the simulation DeviceLink that ColorFlow has calculated.

1. In the color setup viewer, in the PCO, click the Simulation icon .

2. In the Simulation Adjustment dialog box, click the Adjust
DeviceLink tab.

3. Make the appropriate adjustments.

4. Click Apply to save your changes.

See also:
Adjusting curves using the Curve Adjustments tool on page 113
About adjusting DeviceLinks on page 133
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Changing the simulation target or method
You can recalculate the curves and/or DeviceLinks that ColorFlow has
generated for a simulation.

1. In the color setup viewer, in the PCO, click the Simulation icon .

2. In the Simulation Adjustment dialog box, click Redefine.

3. Select a new simulation target and simulation method.

See also:
Simulating a target on page 91
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9 Secondary color outputs

About secondary color outputs
ColorFlow calculates color control elements that calibrate a secondary
color output (SCO) to align to the color space of the primary color
output (PCO) so that the color produced by the SCO device appears
very similar to the color produced by a PCO device.

After you define the simulation target for the PCO and you define the
device condition of an SCO, you can select the conversion method that
is used to transform data from the SCO to the color space of the PCO.
You can use both curves and DeviceLinks in a conversion, depending on
your device type.

When you click the Conversion icon  between an SCO and the PCO,
the Conversion - Definition dialog box appears and displays a
recommended conversion method based on the types of devices that
are used in the PCO and in the SCO. The conversion method may
include Tonal Match or Gray Balance curve transformations, and/or
full color management DeviceLinks. If required, you can select a
different conversion method than the default recommendation. For
example, you can select a DeviceLink in addition to a curve when the
default recommendation only includes a curve.

Note: Depending on the DeviceLink options you choose, the gamut of the SCO is
either mapped or clipped. Only when the SCO's gamut entirely encompasses the
PCO's gamut, can all colors from the PCO can be reproduced on the SCO.

After you examine the actual output from the SCO device, you can
adjust the PCO to SCO conversion curves and/or DeviceLink in order to
fine-tune the color alignment from the PCO to the SCO.

Creating an SCO
You can add an SCO to a color setup.

1. The Devices palette automatically appears in the ColorFlow
workspace, with the Add device drop-down already open to make it
easier for you to add a new device. If the Devices palette is not open
in your ColorFlow workspace, select View > Devices.

Tip: You can double-click anywhere in the background of the color setup
viewer to open the Devices palette.



2. Drag a device from the Devices dialog box to the SCO position in
the color setup viewer.

3. Define the device condition for the SCO device.

Next: You can add additional SCOs to a color setup at any time. After
you define a device condition for the SCO, establish the PCO-to-SCO
conversion method.

See also:
Defining a device condition on page 48

Defining a conversion method for the SCO
You can define how data should be transformed from the SCO to the
color space of the PCO.

Requirements: The SCO device condition must be defined and its color
response must be established.

1. In the color setup viewer, click the Conversion icon  between the
PCO and an SCO.
The Conversion-Definition dialog box appears and displays a
recommended conversion method based on the device type that is
used in the SCO.
For example, if the SCO is an inkjet proofer, the default conversion
DeviceLink Method is set to Full Reseparation.

2. To select a different curve or DeviceLink than the default
recommendation, use the Curves Method or DeviceLinks Method
selector to select the method.
If the SCO device is not a curve-controlled device, the Curves
Method selector is not available.

3. Click OK.
ColorFlow calculates the required color control elements. The
Conversion icon and conversion link show the progress of the
calculation.

See also:
Conversion Definition (PCO to SCO) dialog box on page 243

Adjusting SCO conversion curves
After you examine the color output of the SCO, if you want to produce
a closer color alignment between the SCO and the PCO, adjust the
conversion curves that ColorFlow has calculated.

Conversion curves are available only for curve-controlled devices.
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1. In the color setup viewer, click the Conversion icon  between the
PCO and the SCO.

2. In the Conversion Adjustment dialog box, click the Curves tab (this
is selected if the DeviceLink method is None).
The Curve Adjustment tool appears.

3. Use the Curve Adjustments tool to adjust the conversion curve.

○ If you are not satisfied with the way the SCO reproduces the
PCO color output in one channel only, select and adjust that
channel. For example, you notice that the SCO has an overall
magenta cast across all tones, adjust the M channel.

○ If you want the SCO color output to be lighter or darker in a
certain range but you want to maintain the overall color, or if
you want to correct a color cast in a certain range of gray, select
and adjust the CMY channels.

4. To edit a specific curve, click Conversion Curves and use the Curve
View-Edit tool.

5. Click Apply to save your changes.
Depending on the nature of your adjustments, ColorFlow may need
to recalculate certain color control elements.

See also:
About adjusting curves on page 111
Adjusting curves using the Curve Adjustments tool on page 113
Adjusting curves using the Curve View-Edit tool on page 117

Adjusting an SCO DeviceLink
After you examine the color output of the SCO, if you want to produce
a closer color alignment between the SCO and the PCO, you can adjust
the conversion DeviceLink that ColorFlow has calculated.

1. In the color setup viewer, click the Conversion icon  between the
PCO and the SCO.

2. In the Conversion - Adjustment dialog box, click the Adjust
DeviceLink tab.

3. Select the type of adjustment that you want to make.
If you select Input Tonality or Output Tonality, the Curve
Adjustments tool appears.
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4. Make the required adjustments, and click Apply to commit your
changes.
Depending on the nature of your adjustments, ColorFlow may need
to recalculate certain color control elements.

See also:
Adjusting curves using the Curve Adjustments tool on page 113
About adjusting DeviceLinks on page 133

Removing an SCO from a color setup
You can delete an SCO from the color setup in the color setup viewer.

Note: Removing a device condition from a color setup does not delete the device
condition from the system. When you remove a device condition from a color
setup, the device condition can still be viewed from the Device Conditions dialog
box.

1. Click the border of the of the SCO device condition.
The border becomes purple.

2. Perform one of the following actions:

○ For Windows, press Delete.

○ For Mac OS X, press Fn+Delete.

3. Click Yes to confirm the deletion.

The SCO and any PCO to SCO conversions that you have created are
removed from this color setup. The device condition that was used in
this SCO still exists, and can be viewed from the Device Conditions
dialog box.

See also:
Deleting a device condition from the system on page 50
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Defining a new method for SCO conversion
You can recalculate the curves and/or DeviceLinks that ColorFlow has
generated for an PCO to SCO conversion.

1. In the color setup viewer, click the Conversion icon between the
PCO and the SCO.

2. In the Conversion - Adjustment dialog box, click Redefine.

3. Select a new conversion method.

See also:
Defining a conversion method for the SCO on page 96
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10 Color inputs

About color inputs
Color inputs (CIs) describe the color space of input files so that
ColorFlow can generate color control elements that convert data in the
input color space to the color space of the primary color output (PCO).

The use of a CI in a color setup is optional. When you define a CI,
Prinergy uses that CI as the source space to reseparate input files to the
destination color space of the PCO. This conversion is defined in
ColorFlow by specifying a profile pair or DeviceLink conversion between
the CI and PCO. If you do not want to reseparate all input files using the
color space of the CI, you do not need to include a CI in your color
setup.

Having a color input in your color setup may be useful if, for example,
you receive a CMYK input file that exceeds the maximum ink coverage
of your press because it was incorrectly separated from RGB during the
design stage. In this case, by defining a CI, you can choose to reseparate
your received CMYK content in order to assign a more desirable Total
Area Coverage (TAC) value to your press-ready separations.

After you define the simulation target for the PCO and you define the
device condition of a CI, you can select the conversion method that is
used to transform input data from the CI to the color space of the PCO.
When you click the Conversion icon  between an CI and the PCO, the
Conversion - Definition dialog box appears and displays a
recommended conversion method. If required, you can select a
different conversion method than the default recommendation. You can
also specify a different conversion method for raster content (such as
images) and vector content (such as text).

Note: ColorFlow 1.2 supports RGB devices and RGB color inputs, as well as color
input conversion. RGB and CMYK color input conversions are enhanced to include
profile pair conversion to current DeviceLinks or RGB-to-CMYK DeviceLinks (for
RGB color input conversions).

See also:
Ink Optimizing Input device on page 206
Ink Optimizing Device Condition on page 206



Creating a CI
You can add a CI to a color setup.

1. The Devices palette automatically appears in the ColorFlow
workspace, with the Add device drop-down already open to make it
easier for you to add a new device. If the Devices palette is not
open in your ColorFlow workspace, select View > Devices.

Tip: You can double-click anywhere in the background of the color setup
viewer to open the Devices palette.

2. Drag a device from the Devices dialog box into the CI position in
the color setup viewer.
The CI is usually a reference device that you use to define the color
space of input files.

3. Define the device condition for the CI device.

Next:

After you define a device condition for the CI, establish the CI-to-PCO
conversion method.

See also:
Reference device conditions on page 51

Conversions for input types
When you define the conversion between the CI and the PCO, you can
choose between two conversion methods for image (raster) content
and another conversion method for graphic (vector) content.

In the Input Conversion - Definition dialog box, there are two
conversion methods you can apply to your images and graphics. For
each content type you can select either Profile Pair or DeviceLink. In
the Image tab, you can define the conversion method for raster
content. On the Graphic tab, you can define the conversion method for
vector content.

Note: The options in the dialog box vary depending on the RGB Reference or
CMYK Reference device you selected.

The way that ColorFlow handles raster vs. vector content reflects the
way that input data is processed as either image or graphic data in the
Prinergy workflow.

Input data type Prinergy treats as

Pictures Image

Text Graphic
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Input data type Prinergy treats as

Linework Graphic

Gradient (shading) Image or graphic, operator choice

See also:
Conversion Adjustment (Color Input to PCO) dialog box on page 253

Defining a conversion method for the CI
Define how input data should be transformed to the color space of the
PCO.

Requirements: The CI device condition must be defined and its color
response must be established.

1. In the color setup viewer, click the Conversion icon between the CI
and the PCO .
The Input Conversion - Definition dialog box appears.

2. Select the Conversion Method, either Profile Pair or DeviceLink.

3. Click the Image tab.
These settings vary depending on the selected conversion method.

4. Adjust the settings accordingly.

5. Click the Graphic tab.
These settings vary depending on the selected conversion method.

Note: To use the same settings for text or linework as you do for pictures,
select the Graphic Conversion Same as Image Conversion check box.

6. Click OK.
ColorFlow calculates the required DeviceLinks. The Conversion
icon and conversion link show the progress of the calculation.

See also:
Input Conversion Definition (Color Input to PCO) dialog box
on page 248

Adjusting a CI conversion
After you examine the separations that are produced by the CI, you can
adjust the CI to PCO conversion DeviceLink to fine-tune the
conversion.

For example, you can adjust the input tonality of a single ink channel to
modify how the ink channel is reseparated.
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Note: Making a single-channel curve adjustment has a high impact because it
changes the way separations are created for all output devices.

1. In the color setup viewer, click the Conversion icon  between the
CI and the PCO.

2. In the Input Conversion - Adjustment dialog box, select the
Conversion Method.

3. Make the required adjustments, and click Apply to commit your
changes.
Depending on the nature of your adjustments, ColorFlow may need
to recalculate certain color control elements.

See also:
Adjusting curves using the Curve Adjustments tool on page 113
About adjusting DeviceLinks on page 133

Removing a CI from a color setup
Delete a CI from the color setup in the color setup viewer.

Note: Removing a device condition from a color setup does not delete the device
condition from the system. When you remove a device condition from a color
setup, the device condition can still be viewed from the Device Conditions dialog
box.

1. Click the border of the CI device condition.
The border becomes purple.

2. Perform one of the following actions:

○ For Windows, press Delete.

○ For Mac OS X, press Fn+Delete.

3. Click Yes to confirm the deletion.

The CI and any CI-to-PCO conversion that you created are removed
from this color setup. The device condition that was in this CI still
exists; you can view it from the Device Conditions dialog box.

See also:
Deleting a device condition from the system on page 50
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Defining a new method for CI-to-PCO conversion
Recalculate the DeviceLinks that ColorFlow generated for a CI-to-PCO
conversion.

1. In the color setup viewer, click the Conversion icon  between the
CI and the PCO.

2. In the Conversion - Adjustment dialog box, click Redefine.

3. Select a new conversion method.

See also:
Defining a conversion method for the CI on page 103
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11 Curves

About curves
Applying calibration curves to a printing plate is a standard method of
controlling color on curve-controlled devices such as offset presses and
digital halftone proofers.

A calibration curve changes the natural color response of a device by
adjusting the tint percentage in the digital file when the device images
plates. Curves can either reduce a tint (cutback) or increase a tint
(bump) in a file when imaging a plate.

There are two methods of calibrating a press using calibration curves:

● Tonal Match refers to tonal value increase (TVI), also known as dot
gain, and uses the calculated Effective Dot Area (EDA) for
calibration. Calculations are based on the density measurements of
each ink or colorant. The same target response can be used for each
process color, or different target responses can be used for
optimizing color builds.

● Gray Balance uses the CIELAB values of the neutral or near-neutral
axis to calibrate the chromatic process colors (CMY), while black ink
is calibrated based on L* (lightness) or density. Unless the device
and device condition produce good gray balance when uncalibrated,
the process colors will have separate targeted responses.

You can choose either method when you calibrate the primary color
output (PCO) to the simulation target, or when you calibrate a device
condition such as a secondary color output (SCO) to align to the PCO.

Curves in ColorFlow
ColorFlow can use five types of curves to control the color that is
imaged on a plate.

Device curves

Are specific to a device and device condition. When you
characterize a device, you can choose a device curve to exercise
the working range of the device. You can also import a Harmony
transfer calibration curve as a ColorFlow device curve. When
multiple devices are pooled in a device condition, ColorFlow
calculates device curves in order to align the color response of



all devices in the device condition with the color response of the
promoted device.

Simulation curves

Calibrate the device condition in the PCO to the simulation
target.

Conversion curves

Calibrate SCO device conditions in a color setup to the same
gray balance or tonality as the PCO.

Calibration curves

Used by the workflow when imaging a plate. Calibration curves
are:

● For a device in a PCO, the combination of a simulation curve
and a device curve

● For a device in an SCO, the combination of a conversion
curve and a device curve

Plate setup curves

Linearize a plate for a particular plate type, device type,
screening, and plate line. Plate setup curves are identical for
each separation. They are typically used for process control in
the plate room.

ColorFlow manages a calibration curve as if it is made up of discrete
components—for example, a device curve plus a simulation curve.
Before providing a calibration curve to a workflow, ColorFlow combines
the calibration curve's components into a single curve. You can export
a calibration curve or a device curve from ColorFlow, but you cannot
export a simulation curve or a conversion curve.

A linear calibration curve makes no change to the digital file before
imaging on plate. You can start off with a linear calibration curve in
ColorFlow and later adjust the curve so that it changes the file in the
way that you want.

The curves that ColorFlow calculates are smooth and monotonic,
increasing continuously from 0% tint (paper) to 100% tint (solid).
Using smooth curves provides for smooth vignettes and reduces
"flashing" (or hue changes) in color builds when moving through the
tonal scale.

The curve types described above are explicitly defined and identified in
ColorFlow. Curves also exist inside device profiles and DeviceLinks.
These profile curves can be viewed and adjusted using tools similar to
those used for explicit ColorFlow curves.
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About importing curves
You can import Harmony transfer calibration curves into ColorFlow.

After you specify the properties of a device condition, you can click the
Curves icon  to import a Harmony transfer calibration curve to be
used as a ColorFlow device curve.

The following are situations in which you might import a device curve:

● You have a legacy Harmony transfer calibration curve that already
produces the desired color response on the PCO device condition. If
you import the curve and select no simulation for the PCO (set the
simulation target to None), ColorFlow will use the Harmony transfer
calibration curve as the calibration curve.

● You are about to measure a chart generated by ColorFlow, but the
device curve that was used to print the chart is not the device curve
that is currently configured in ColorFlow. You can import the device
curve that was used to print the chart in order to obtain correct
measurement information.

See also:
Printing as you did with Harmony, without characterizing device
conditions on page 37
Importing default device curves on page 56

Viewing a device curve
After you define a device curve for a device in a particular device
condition, you can view the curve using the Curve View-Edit tool.

1. In the color setup viewer, click the Curves icon  next to the
device name.
The Curve Adjustments tool appears in the Device Curve –
Adjustments dialog box.

2. Click Device Curves to view the actual device curves.

See also:
About the Curve View-Edit tool on page 116
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Viewing a simulation curve
After you define a curve method for a simulation, you can view the
calibration curve using the Curve View-Edit tool.

1. In the color setup viewer, click the Simulation icon .

2. In the Simulation Adjustment dialog box, click the Curves tab (this
is selected if the DeviceLink method is None).
The Curve Adjustments tool appears in the Simulation Adjustment
dialog box.

3. Click Calibration Curves to view the actual calibration curves.
Each calibration curve consists of a device curve and a simulation
curve. If the device condition contains pooled devices, select the
appropriate device in the Device list.

4. To see only the simulation curve, click Show Simulation Curves
only.

See also:
About the Curve View-Edit tool on page 116

Viewing a conversion curve
After you define a curve method for a conversion, you can view the
calibration curve using the Curve View-Edit tool.

1. In the color setup viewer, click the Conversion link .

2. In the Conversion Adjustment dialog box, click the Curves tab (this
is selected if the DeviceLink method is None).
The Curve Adjustments tool appears in the Conversion Adjustment
dialog box.

3. Click Calibration Curves to view the actual calibration curves.
Each calibration curve consists of a device curve and a conversion
curve. If the device condition contains pooled devices, select the
appropriate device in the Device list.

4. To see only the conversion curve, click Show Conversion Curves
only.

See also:
About the Curve View-Edit tool on page 116
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Viewing plate setup curve values
You can view the tint values for the plate line.

1. Select View > Plate Setups.

2. Select a device type in the Device Type list.

3. Select a Plate Setup and a Plate Line.
Tint values for the plate line appear in the Tint Values list.
ColorFlow does not display a graph of a plate curve.

About adjusting curves
You can adjust curves to fine-tune or update the color response of a
device in a device condition.

The following are three common types of curve adjustments:

Device Curve Adjustment

A local adjustment that affects only a single device. A device
curve adjustment may be required when a physical change in
the device—such as new blankets on a press—causes a color
shift. You can update the uncalibrated color response of the
device to reflect the change by adjusting the device curve.

Simulation Curve Adjustment

A global adjustment affecting all devices in the PCO device
condition and all the devices in the color setup, including those
in any SCOs. A simulation curve adjustment can be used to
fine-tune a simulation, and may propagate changes to SCOs
and color inputs of the color setup.

Conversion Curve Adjustment

A global adjustment affecting all devices in a particular SCO. A
conversion curve adjustment can be used to fine-tune the color
alignment between the PCO and an SCO.

You can adjust curves in ColorFlow using the Curve Adjustments tool
or the Curve View-Edit tool.

Curve Adjustments tool

Use this tool to make general tonal and color adjustments at
fixed curve points, with fixed ranges.

Curve View-Edit tool

Use this tool to view and edit curves directly. The Curve View-
Edit tool lets you change the curve in the exact range and at the
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exact center that you specify. This is an advanced tool which
provides more precise control than the Curve Adjustments tool.

Both tools offer the following adjustment modes:

● Single channel C, M, Y, or K: The curves can be adjusted separately
for each ink channel.

● Coordinated CMY: You can request a specific color cast and/or
lightness shift in a given range of the neutral axis, and ColorFlow
calculates and applies the appropriate coordinated changes to the
C, M, and Y curves simultaneously. In the CMY adjustment mode,
one curve may move in one direction while the other two curves
move in the opposite direction to achieve the overall result that you
specified.

● Spot: Enables you to make adjustments to a selected custom spot
ink curve defined in the device condition.

See also:
Correcting a color shift on a curve-controlled device on page 86
Adjusting simulation curves on page 93
Adjusting SCO conversion curves on page 96

Curve Adjustments tool
Use the Curve Adjustments tool to specify a general change in tonal
response. This tool lets you adjust all ColorFlow curve types and profile
input/output curves.

About the Curve Adjustments tool
The Tonal Adjust tool can be used for simple adjustments. When you
use the Curve Adjustments tool, you request a change to the tonality of
a device and ColorFlow adjusts curves appropriately in order to
produce that tonality.

The Curve Adjustments tool includes a graph and five sliders that
represent different points in the tonal range. The value in the box under
each slider is a change percentage. Because the graph shows only
curve changes, it appears flat until an adjustment is made. This helps
you make adjustments based on the desired overall effect, rather than
adjustments based on how the actual curves appear. You can directly
view or change actual curves with the Curve View-Edit tool. When you
make a change in either tool, you can see the change in both tools.

You can adjust individual ink channels separately, adjust the CMY
channels together, or adjust a spot color curve.
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Table 1: Use the following keyboard shortcuts to select a channel:

To select In Windows In Mac OS X

C Ctrl+1 Command+1

M Ctrl+2 Command+2

Y Ctrl+3 Command+3

K Ctrl+4 Command+4

Note: Spot color curves appear only in ColorFlow curves, not in device profile or
DeviceLink input/output curves.

Adjusting curves using the Curve Adjustments tool
You can use the Curve Adjustments tool to adjust individual curve
channels, or to adjust CMY gray balance lightness or cast.

Using the Curve Adjustments tool on individual color
channels

You can use the Curve Adjustments tool to change the curves of
individual ink channels.

1. Select the channel you want to adjust (C, M, Y, or K, or Spot).

2. If you selected the Spot channel, use the Spot Ink selector to
choose the specific spot ink channel.

3. Move the appropriate slider to adjust the corresponding tonal
range.

● Slider at 10% (Highlight): affects 0 to 25%

● Slider at 25% (Quartertone): affects 0 to 50%

● Slider at 50% (Midtone): affects entire tonal range

● Slider at 75% (3/4-tone): affects 50 to 100%

● Slider at 90% (Shadow): affects 75 to 100%

You can also enter a value in the box under the slider to indicate the
curve change percentage.

Limitations are applied for each slider, in each direction, to prevent
unwanted artifacts.

4. At any time, you can do the following:
To see the calculated tonal response (EDA) resulting from your
adjustment, click:

○ Device Tonality (device curve adjustment)

○ Expected Tonality (simulation or conversion curve adjustment)
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To see the effect of your adjustment on the underlying curve, click:

○ Device Curves (device curve adjustment)

○ Calibration Curves (simulration or conversion curve
adjustment)

○ Input Curves (device profile or DeviceLink input tonality
adjustment)

○ Output Curves (device profile or DeviceLink output tonality
adjustment)

To see the immediate color effect of the adjustments on an image,
click Preview.

To refine the curves or profile that you are adjusting, click Redefine.

5. Repeat these steps to adjust each channel.

See also:
About the Curve View-Edit tool on page 116
About previewing images on page 149

Using the Curve Adjustments tool on neutral balance

Use the Curve Adjustments tool to adjust a color cast, lightness error,
or both in near-neutral CMY colors. ColorFlow adjusts CMY curves
simultaneously to achieve the color change you request.

1. Click CMY.

2. Select the tonality range in which you want to adjust the neutral
balance.
Click Highlight, Quartertone, Midtone, or 3/4-tone.

3. Use the lightness (L*) slider together with the cast (a*b*) selector
to adjust the color in the chosen range.
You can also type values directly in L*, a*, and b* boxes in the Color
Change area.

Your movement in the color selector may be constrained to prevent
unwanted artifacts.

The displayed color patches demonstrate the effect of all the
adjustments specified in this dialog box. The color produced by the
curves or profile before your adjustment is shown on the left
(Before). The color produced by the curves or profile after your
adjustment is shown on the right (After).

Note: In the case of device curve adjustments, the color that is currently being
produced is shown on the left (Current), and can be adjusted to reflect any
changes in the device color output that require correction. The desired color
output is shown on the right (Corrected) and remains constant, as a reference
to the expected color output after correction.
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4. If the neutral gray that is displayed in the color patch does not
visually align to the neutral gray on your proof or press sheet, adjust
the displayed color of the patch on your viewing monitor.

a. Select the Adjust Displayed Colors check box.

b. Use the lightness (L*) slider and the cast (a*b*) selector to
change the displayed color to align to the color on your proof or
press sheet.
This color change does not affect any curves or color control
elements. You are only adjusting the displayed color of the
patches.

c. To move the sample point to the color at the center of your
adjustment range, click Reset.

d. When you achieve the correct color, clear the Adjust Displayed
Colors check box.

5. To display the color patches in a larger view for easier color
comparison, click a color patch.
The color patches open in a new window.

6. At any time, you can do the following:
To see the calculated tonal response (EDA) resulting from your
adjustment, click:

○ Device Tonality (device curve adjustment)

○ Expected Tonality (simulation or conversion curve adjustment)

To see the effect of your adjustment on the underlying curve, click:

○ Device Curves (device curve adjustment)

○ Calibration Curves (simulation or conversion curve adjustment)

○ Input Curves (device profile or DeviceLink input tonality
adjustment)

○ Output Curves (device profile or DeviceLink output tonality
adjustment)

To see the immediate color effect of the adjustments on an image,
click Preview.
To refine the curves or profile that you are adjusting, click Redefine.

See also:
About the Curve View-Edit tool on page 116
About previewing images on page 149

Curve View-Edit tool
Use the Curve View-Edit tool to view and edit curves directly. This is an
advanced tool that lets you change curves in the exact range and at the
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exact center that you specify. It applies to all ColorFlow curve types
and profile input/output curves.

About the Curve View-Edit tool
The Curve View-Edit tool can be used for viewing and advanced
adjustments of curves. When you use the Curve View-Edit tool, you
can precisely adjust the shape of a curve.

The Curve View-Edit tool shows the curve values and a graph of the
curve. If you are viewing or editing a calibration curve and the device
condition contains pooled devices, you must select the device with the
calibration curve you want to view.

You can view or adjust each ink channel (C, M, Y, K) separately or
adjust the CMY channels together. You can also view and edit spot ink
channels of ColorFlow curves.

Table 2: You can use the following keyboard shortcuts to select a channel:

To select In Windows In Mac OS X

C Ctrl+1 Command+1
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To select In Windows In Mac OS X

M Ctrl+2 Command+2

Y Ctrl+3 Command+3

K Ctrl+4 Command+4

You can view and edit curves in either of two modes: Tint Out and Tint
Change. Tint Out mode shows the actual curve output value
corresponding to each Tint In value. Tint Change mode shows the
amount by which each Tint In value is increased or decreased by the
curve.

To change the view/edit mode, click the icons above the top left corner
of the graph.

Viewing curves using the Curves View-Edit tool
You can use the Curves View-Edit tool to view channels of ColorFlow
curves or profile input/output curves.

Requirements: If you are viewing ColorFlow curves of a device
condition that contains pooled devices, ensure that the correct device
is selected in the Device list.

If you are adjusting curves of a simulation or conversion, the curves
that you see are the complete calibration curves for the device. They
contain the simulation curve or conversion curve, and the device curve.
To exclude the device curve from the graph and table, select Show
Simulation/Conversion Curves only radio button. To show complete
calibration curves, select Include Device Curves.

If you are adjusting device curves or profile input/output curves, the
Device selector and radio button controls do not appear.

Using the Curve View-Edit tool to view curves
1. In the Curve View-Edit tool, deselect Enable Editing.

2. Select the channel you want to view (C, M, Y, K, or Spot).

3. If you selected the Spot channel, use the Spot Ink selector to
choose the specific spot ink curve channel.
The selected channel is highlighted in the graph and Curve Values
are displayed.

4. Click a point on the curve whose input and output you want to view,
or type a value in the Tint In or Tint Out box.
A point appears on the curve, and Tint In or Tint Out values are
updated.

Adjusting curves using the Curve View-Edit tool
You can use the Curve View-Edit tool to edit individual curve channels
directly, or to adjust CMY gray balance lightness or cast. This tool
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shows the actual curves and gives you flexible control over the edit
point and range.

Using the Curve View-Edit tool on individual color
channels

You can use the Curve View-Edit tool to directly change the shape of a
curve. ColorFlow constrains curves to be monotonic and continuous.

Requirements:

If you are viewing ColorFlow curves of a device condition that contains
pooled devices, ensure that the correct device is selected in the Device
list.

If you are adjusting curves of a simulation or conversion, the curves
that you see are the complete calibration curves for the device. That is,
they contain the simulation or conversion curve, and the device curve.
To exclude the device curve from the graph and table, select Show
Simulation/Conversion Curves only radio button. To show complete
calibration curves, select Include Device Curves.

If you are adjusting device curves or profile input/output curves, the
Device selector and radio button controls do not appear.

1. In the Curve View-Edit tool, select Enable Editing.

2. Select the channel you want to adjust (C, M, Y, K, or Spot).

3. If you select the Spot channel, use the Spot Ink selector to choose
the specific spot ink curve channel.

4. Click the part of the curve that you want to adjust, or type the curve
value in the Tint in box.
An adjustment point appears on the curve.

5. Create two anchor points to constrain the range of your
adjustment.
The curve will not be affected at tint values outside of these anchor
points. There are implied anchor points at 0% and 100%.

a. Click two points on either side of the point on the curve that you
want to adjust.

6. Drag the adjustment point up to darken the output or drag it down
to lighten the output.
You can also type a value in the Tint Out box.

Your adjustment may be restricted in order to keep the curves
monotonic.

7. To remove an adjustment point, right-click the point and select
Delete selected point, or click to select the point, and type
<Delete>.
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Using the Curve View-Edit tool on neutral balance

You can use the Curve View-Edit tool to adjust a color cast, a lightness
error, or both in near-neutral CMY colors. ColorFlow adjusts CMY
curves simultaneously to achieve the change you request.

Requirements:

If you are viewing ColorFlow curves of a device condition that contains
pooled devices, ensure that the correct device is selected in the Device
list.

If you are adjusting curves of a simulation or conversion, the curves
that you see are the complete calibration curves for the device. That is,
they contain the simulation or conversion curve, and the device curve.
To exclude the device curve from the graph and table, select Show
Simulation/Conversion Curves only radio button. To show complete
calibration curves, select Include Device Curves.

If you are adjusting device curves or profile input/output curves, the
Device selector and radio button controls do not appear.

1. In the Curve View-Edit tool, select Enable Editing.

2. Click CMY.

3. Move the sliders below the graph to constrain the range of your
adjustment and to select the center of your adjustment.
The curve will not be affected at tint values outside of this range.
There are implied anchor points at 0% and 100%.

4. Use the lightness (L*) slider together with the cast (a*b*) selector
to adjust the color in the chosen range.
You can also type values directly in L*, a*, and b* boxes in the Color
Change area.

Your adjustment may be restricted in order to keep the curves
monotonic.

The displayed color patches demonstrate the effect of all the
adjustments that are specified in this dialog box. The color
produced by the curves or profile before your adjustment is shown
on the left (Before). The color produced by the curves or profile
after your adjustment is shown on the right (After).

Note: In the case of device curve adjustments, the color that is currently being
produced is shown on the left (Current), and can be adjusted to reflect any
changes in the device color output that require correction. The desired color
output is shown on the right (Corrected) and remains constant, as a reference
to the expected color output after correction.

5. To display the color patches in a larger view for easier color
comparison, click a color patch.
The color patches open in a new window.
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6. If the neutral gray that is displayed in the color patch does not
visually align to the neutral gray on your proof or press sheet, adjust
the displayed color of the patch on your viewing monitor.

a. Select the Adjust Displayed Colors check box.

b. Use the lightness (L*) slider and the cast (a*b*) selector to
change the displayed color to align to the color on your proof or
press sheet.
This color change does not affect any curves or color control
elements. You are only adjusting the displayed color of the
patches.

c. To move the sample point to the color at the center of your
adjustment range, click Reset.

d. When you achieve the correct color, clear the Adjust Displayed
Colors check box.

Exporting a curve
You can export a curve from ColorFlow to use it in a non-integrated
workflow or in external software.

In the Workflow and Pro Workflow editions of ColorFlow software, you
do not need to export any color control elements in order to use them
in your Prinergy Connect or Prinergy Evo workflow.

1. In a color setup in the color setup viewer, perform one of the
following actions:

○ To export a device curve, click the device in a device condition,
and select Export > Device Curves.

○ To export a calibration curve for the PCO, click the border of the
PCO, and select Export > Calibration Curves.

○ To export a calibration curve for an SCO, click anywhere in the
conversion connection area, and select Export > Calibration
Curves.

2. In the Save Curves dialog box, browse to the location where you
want to save the curve.

3. Use the default file name for the curve or type a new file name, and
click Save.
The curve is saved in Harmony format, as a .hmy file.
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12 Device profiles

About device profiles
ColorFlow software manages ICC device profiles that can be used in the
Prinergy workflow.

A device profile represents the relationship between colorant tint
values of a device condition and the resulting color. Device profiles
describe colorimetric color response and do not contain any tonal
information.

Every device profile has two sets of color lookup tables, called tags, for
transforming color. One set, called source tags, transform from device-
dependent color coordinates, like CMYK or RGB, to device-independent
color coordinates that model human vision. The other set, called
destination tags, transform from device-independent color coordinates
to device-dependent coordinates.

Each set has three rendering intents to describe the different methods of
mapping the device gamut to the full color gamut of human vision,
making a total of six tags. A seventh tag, the Media White Point tag,
describes the substrate color for CMYK devices, or the white point of
an RGB device.

Each of the six tags contains a set of curves at its inputs and outputs,
one curve for each input and output channel. The device-dependent
CMYK curves are visible in ColorFlow for print device profiles, identified
as Input Tonality and Output Tonality curves for source and
destination tags respectively. These curves are distinctly different from
ColorFlow device, simulation and conversion curves. They exist in
device profiles for both curve-controlled and non-curve-controlled
device conditions. You can view and adjust the Input Tonality and
Output Tonality curves of device profile tags in the Device Condition
Device Profile or PCO Device Profile dialog boxes.

Any color input, PCO or SCO, in a color setup that will be used in
Prinergy with color management, requires a device profile for each
device condition and the PCO. In a device condition or in a PCO in the
color setup, you can click the Profile icon  to open a dialog box in
which you can import or calculate a profile for the device condition or
PCO that you selected.

If you have an ICC device profile that you created with Kodak Profile
Wizard software, Kodak Spotless Color Toolkit, Kodak Spotless
Software, or other software that supports the ICC profiles, you can



import the profile into ColorFlow as the device profile of a device
condition or PCO.

If you import a device profile into a device condition that has not been
characterized with measurement data, the imported profile will define
the device condition's colorimetric response. The tonal response will
remain undefined.

Note: If the device condition already has a color response that was derived from
measurement data, importing a profile will not replace this color response.

You can import or calculate profiles in ColorFlow Pro Workflow edition.
In ColorFlow Workflow edition, you can use profiles only by importing
them.

From the ICC Profiles tab of the Preferences dialog box, you can
choose the ICC profile format that you want ColorFlow to use. When
you generate a device profile, you can specify the total ink limit and
black generation separation settings that will be used for the
separation tags of the profile.

Profiles that ColorFlow has generated can be exported. You can also
export the measurement set that was used to generate a profile. If you
export a device profile, ColorFlow assigns a default profile name based
on the device condition or PCO properties.

Depending on your ColorFlow edition, the following device profile
functionalities may be available:

● Generate device profiles with user specified parameters

● Import device profiles that were created outside of ColorFlow

● Adjust device profiles that are imported or generated in ColorFlow

● Export device profiles

Note: You can import, generate, and adjust device profiles in ColorFlow Pro
Workflow edition. In ColorFlow Workflow edition, you can only use device profiles
by importing them.
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Selecting an ICC profile format
You can select the default ICC profile format that you want ColorFlow
to use when it calculates device profiles.

1. Perform one of the following actions:

○ For Windows, select File > Preferences

○ For Mac OS X, select ColorFlow > Preferences

2. Click the ICC Profiles tab.

3. In the ICC Profile Format list, select the format that you want to
use.
When you generate a device profile, ColorFlow will use the ICC
profile format that you selected.

Generating a device profile
You can specify the total ink limit and black generation settings to use
when generating a device profile.

Requirements: You must establish the color response of a device
condition before calculating a device profile for the device condition.

1. In a color setup in the color setup viewer, perform one of the
following actions:

○ To generate a profile for a device condition, click the Profile icon
 in the device condition.

○ To generate a profile for the PCO, click the Profile icon  in the
PCO.

If you clicked the Profile icon in a device condition, the Device
Condition Profile dialog box appears. If you clicked the Profile icon
in a PCO, the Primary Color Output Profile dialog box appears.

2. In the Origin area, select ColorFlow Generated.

Note: For all of the separation settings identified below, ColorFlow provides
recommended default values. These values are tailored to the device type of
the device condition.

3. Specify the maximum sum of tint values of all the inks.

Total Ink Limit

240 to 400%

Selecting an ICC profile format 123



4. Specify the start point on the neutral axis for black ink.

Black Start

0 to 50%

For example, if you set the start point value to 20%, tones less than
20% down from the white point will print with CMY ink only.

5. Specify the maximum allowable percentage of black ink used in the
black separation.

Max Black

70 to 100%

6. Specify the relative quantity of black vs cyan, magenta, and yellow
used to generate the neutral gray component of colors.

Black Strength

Use the slider or the text box to select a value between 5
and 75%.

As you move the slider towards the maximum value, colors can
contain more black.

Note: With the optional Kodak Ink Optimizing Solution, you can generate a
PCO device profile with a Black Strength value up to 100%, for ink savings and
color stability.

7. Click OK.

The Profile icon shows the progress of the profile calculation.

See also:
How Prinergy uses ColorFlow elements on page 183

Importing a device profile
You can use a device profile that was generated outside of ColorFlow.

Note: If none of the devices in the device condition have a measured response, the
imported profile will define the color response of the device condition. If the device
condition already has a color response that was derived from measurement data,
importing a profile will not replace this color response.
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1. In a color setup in the color setup viewer, perform one of the
following actions:

○ To import a profile for a device condition, click the Profile icon 
in the device condition.

○ To import a profile for the PCO, click the Profile icon  in the
PCO.

If you clicked the Profile icon in a device condition, the Device
Condition Profile dialog box appears. If you clicked the Profile icon
in a PCO, the Primary Color Output Profile dialog box appears.

2. In the Origin area, select Imported.

3. Click Import.

4. Locate the profile that you want to import, and click Open.
Information about the profile that you selected is displayed.

5. Click OK.

Exporting a device profile
You can export a device profile from ColorFlow to use it in a non-
integrated workflow or in external software.

In the Workflow and Pro Workflow editions of ColorFlow software, you
do not need to export any color control elements in order to use them
in your Prinergy Connect or Prinergy Evo workflow.

1. In a color setup in the color setup viewer, perform one of the
following actions:

○ To export the device profile of a device condition, click the
border of the device condition.

○ To export the device profile of the PCO, click the border of the
PCO.

2. Select Export > Device Profile.

3. In the Save Device Profile dialog box, browse to the location where
you want to save the device profile.

4. Use the default file name for the device link or type a new file name
and click Save.
The device profile is saved as an .icc file.
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13 DeviceLinks

About DeviceLinks
ColorFlow creates and manages ICC DeviceLink profiles which can be
used in the Prinergy workflow.

ICC DeviceLink profiles are a powerful application of the mathematics
of device profiles. They effectively combine two device profiles to
create a one-way link with a single rendering intent, and can be used to
align color on different output devices. In ColorFlow, ICC DeviceLink
profiles are referred to as DeviceLinks.

A DeviceLink uses color lookup tables to transform every color point in
an image from the source (device-dependent) color space to the
destination color space. This method of transformation is called Full
Reseparation. When you define a DeviceLink, you can select the
method that it uses to transform color. For example, you may not
always want the full color transformation that occurs with the Full
Reseparation method. Sometimes, you may not want areas in a file that
are totally black (K channel only) to contain CMY after a DeviceLink is
applied. When you define the DeviceLink, you can constrain various
aspects of the transformation. For example, you can define the
DeviceLink so that black, and other primary colors, remain pure after
the DeviceLink is applied.

A DeviceLink contains one set of curves for each primary color at the
input of its lookup table, and another set of curves at the output. These
Input Tonality and Output Tonality curves are distinct from other types
of curves in ColorFlow, such as device, simulation, or conversion curves.
Input Tonality and Output Tonality curves exist in a DeviceLink
whether or not a simulation or conversion uses curves, and they exist
for both curve-controlled devices and non-curve-controlled devices.
You can view and adjust the Input Tonality and Output Tonality curves
of a DeviceLink in the Simulation Adjustment or Conversion
Adjustment dialog boxes.

You can use DeviceLinks in the following areas in a color setup:

● In the PCO, to simulate a target

● In the PCO to SCO conversion, to align the SCO color response to
the PCO

● In the CI to PCO conversion, to convert input data to the PCO color
space



Depending on your ColorFlow edition, the following DeviceLink
functionalities may be available:

● Generate CMYK to CMYK or RGB to CMYK DeviceLinks with user-
specified parameters.

● Generate DeviceLinks from imported profiles or profiles that are
generated in ColorFlow.

● Import DeviceLinks that were created outside of ColorFlow.

● Adjust DeviceLinks that are imported or generated in ColorFlow.

● Export DeviceLinks from ColorFlow.

Note: You can import, calculate, and adjust DeviceLinks in ColorFlow Pro
Workflow edition. In ColorFlow Workflow edition, you can only use DeviceLinks by
importing them.

See also:
About the Ink Optimizing Solution on page 205

Generating a DeviceLink
Create a DeviceLink and specify how the DeviceLink will preserve
some aspects of the image separation.

Requirements: You must establish the color response of device
conditions that use the DeviceLink before generating the DeviceLink.

1. In a color setup in the color setup viewer, perform one of the
following actions:

○ To generate a DeviceLink for a simulation, click the Simulation
icon  in the PCO.

○ To generate a DeviceLink for a conversion, click the Conversion
icon  between the CI and the PCO or between the PCO and the
SCO.

If you clicked the Simulation icon in a PCO, the Simulation
Definition dialog box appears. If you clicked a Conversion icon, the
Conversion Definition dialog box appears.

2. Use the DeviceLink Method selector to select a desired generation
method.
Depending on the device type, some positions may be unavailable.

Ink Optimizing Solution

This method is available if your license includes the Ink
Optimizing Solution feature. Select Ink Optimizing Solution
to apply a high level of gray component replacement (GCR)
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to optimize ink usage, by replacing the neutral component of
combined cyan, magenta, and yellow tints with black.

Full Reseparation

Completely reseparated. Solid colors in the original file may
not remain solid. The black generation parameters that you
specify are used, which may result in using less chromatic
ink and more black ink.

CMYK Integrity

All color builds can be adjusted. The relative amount of
black vs CMY will be preserved in content processed
through the DeviceLink.

Black Purity Only

Any colors other than black channel (solid K, K-grays) can
be adjusted.

Color and Black Purity

Same as Fully Constrained but solid colors can be reduced
to a tint.

Fully Constrained

A DeviceLink is used to change data in the digital file.
However, it is constrained, so that any color made with only
one or two inks will not have other inks added. Solid (100%
tints) primaries and secondaries are not affected and remain
solid.

Imported

Import an existing DeviceLink. Click Import to browse to a
DeviceLink.

None

A DeviceLink is not used to change data in the digital file.

3. In the Rendering Intent list, choose the gamut mapping that should
be used when mapping colors from one color gamut to another.

Perceptual

Fits all colors in the source space into the destination space
while preserving overall color relationships. This method is
suitable for images that contain significant out-of-gamut
colors; it is recommended, and the default selection for RGB
color inputs.
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Relative Colorimetric

Maps white in the source to white in the destination,
reproduces all in-gamut colors and clips out-of-gamut
colors to the closest reproducible hue. This method
preserves more of the original colors than the Perceptual
method; it is recommended, and the default selection for
CMYK color inputs and output simulation or conversion
DeviceLinks.

Saturation

Converts saturated colors in the source to saturated colors
in the destination. This method is suitable for pie charts or
business graphics, but may not be suitable for preserving
original colors in an image.

Absolute Colorimetric

Maintains color accuracy and does not change any colors
that fall inside the destination color gamut (including white).
This method is most suitable for proofing.

4. Select the black generation parameters.
The DeviceLink Method selector determines which options are
available.

Note: For all of the separation settings identified below, ColorFlow provides
recommended default values. These values are tailored to the device type and
device condition.

a. Specify the maximum sum of tint values of all the inks.

Total Ink Limit

200 to 400%

b. Specify the start point on the neutral axis of black ink.

Black Start

0 to 60%

For example, if you set the start point value to 20%, tones less
than 20% down from the white point will print with CMY ink
only.

c. Specify the maximum allowable percentage of black ink used in
the black separation.

Max Black

70 to 100%

d. Specify the relative quantity of black vs cyan, magenta, and
yellow used to generate the neutral gray component of colors.
As you move the slider towards the maximum value, colors can
contain more black.
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Black Strength

Use the slider or text box to select a value between 5 and
100%.

5. Select whether you want to transform colors visibly on curved
devices with the Ink Optimizing Solution. (Not applicable to color
inputs and non-curved outputs.)
Target Simulation or Color Space Conversion
The name of this option depends on whether you are in the PCO or
SCO.
For curve-controlled devices, select this option to achieve a closer
color match to your source color space while achieving ink savings.
When this option is selected, gamut mapping will occur between
two different color spaces.
When this option is not selected, the DeviceLink optimizes ink
usage but does not visibly convert colors.

6. Select Black Point Compensation, if desired, for relative
colorimetric DeviceLinks. Select this option to perform perceptual-
like gamut mapping of the lightness scale.

7. When you are finished defining the simulation or conversion, click
Apply.
ColorFlow calculates the DeviceLink.

Note: There may be a slight delay before the Simulation or Conversion icon
shows the progress of the DeviceLink calculation.

See also:
How Prinergy uses ColorFlow elements on page 183
About the Ink Optimizing Solution on page 205
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Importing a DeviceLink
You can use a DeviceLink profile that was generated outside of
ColorFlow.

1. In a color setup in the color setup viewer, perform one of the
following actions:

○ To import a DeviceLink for a simulation, click the Simulation
icon  in the PCO.

○ To import a DeviceLink for a conversion, click the Conversion
icon  between the CI and the PCO or between the PCO and the
SCO.

If you clicked the Simulation icon in a PCO, the Simulation
Adjustment dialog box appears. If you clicked a Conversion icon,
the Conversion - Definition dialog box appears.

2. Use the DeviceLink Method selector to choose Imported.

3. Click Import.

4. Locate the DeviceLink profile that you want to import, and click
Open.
Information about the DeviceLink that you selected is displayed.

5. Click OK.

Exporting a DeviceLink
You can export a DeviceLink from ColorFlow to use it in a non-
integrated workflow or in external software.

In the Workflow and Pro Workflow editions of ColorFlow software, you
do not need to export any color control elements in order to use them
in your Prinergy Connect or Prinergy Evo workflow.
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1. In a color setup in the color setup viewer, perform one of the
following actions:

○ To export a simulation DeviceLink, click the border of the PCO.

○ To export a conversion DeviceLink, click anywhere in the
conversion connection area.

2. Select Export > DeviceLink Profile.

3. In the Save DeviceLink Profile dialog box, browse to the location
where you want to save the DeviceLink.

4. Use the default file name for the DeviceLink or type a new file name
and click Save.
The device profile is saved as an .icc file.

About adjusting DeviceLinks
After ColorFlow calculates a DeviceLink, you can adjust the DeviceLink
in several ways.

You can adjust the white point and the input tonality or output tonality
of a DeviceLink. To adjust the input tonality or the output tonality of a
DeviceLink, you can use the Curve Adjustments tool or Curve View-
Edit tool.

Before you adjust simulation a DeviceLink, you should consider what
other elements may be dependent on the DeviceLink. When you adjust
the input tonality of a simulation DeviceLink, ColorFlow recalculates
dependent color control elements, and any adjustments you previously
made to those elements will be lost.

You can only adjust the white point of a DeviceLink if its rendering
intent is Absolute Colorimetric. White point adjustment is used to
adjust the paper tint simulation. The size of the surrounding area that is
affected by your adjustment depends on how much you adjusted the
white point. Because white point adjustments may affect the highlights
area, when you make a white point adjustment, you should check its
effects before you adjust output tonality.

Adjusting the output tonality of a DeviceLink is the recommended
method for global color adjustments. The effect of adjusting the output
tonality of a simulation or conversion DeviceLink is similar to adjusting
a simulation or conversion curve. However, if a simulation uses both
curves and a DeviceLinks, only DeviceLink adjustments are tracked to
SCOs.

Unless a DeviceLink uses the Full Reseparation method, the effect of
adjusting the input tonality of the DeviceLink is similar to adjusting the
output tonality of the DeviceLink. If the DeviceLink uses the Full
Reseparation method, CMYK input content is completely reseparated
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and, for example, a black-channel gradient may become a CMY
gradient. In this case, adjusting the input tonality for black is not the
same as adjusting the output tonality for black.

You can only adjust DeviceLinks in the Workflow Pro edition of
ColorFlow.

Adjusting DeviceLink white point
You can adjust how a DeviceLink transforms the meaning of white from
one device to the other to simulate paper tint.

Requirements: You can only adjust a DeviceLink white point when the
DeviceLink's rendering intent is Absolute Colormetric.

1. In a color setup in the color setup viewer, perform one of the
following actions:

○ To adjust a DeviceLink white point for a simulation, click the
Simulation icon  in the PCO.

○ To adjust a DeviceLink white point for a conversion, click the
Conversion icon  between the CI and the PCO or between the
PCO and the SCO.

If you clicked the Simulation icon in a PCO, the Simulation
Adjustment dialog box appears. If you clicked a Conversion icon,
the Conversion - Adjustment dialog box appears.

2. In the Conversion - Adjustment or the Simulation Adjustment
dialog box, on the Adjust DeviceLink tab, click White Point.

3. Change the output value for white input in any of the following
ways.
Your changes may be constrained by the gamut of the output
device.

○ Use the lightness (L*) slider together with the cast (a*b*)
selector.

○ Type values directly in the Out column.

○ Type L*a*b*values directly in the Change column.

4. To see the effect of your adjustments on an image, click Preview
and place a colorimeter on a white area of the image that you
preview.

5. When you are satisfied with your changes, click Apply.

See also:
About previewing images on page 149
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Adjusting the input or output tonality of a DeviceLink
You can adjust the Input Tonality and Output Tonality of a DeviceLink
to fine-tune a transformation.

1. In a color setup in the color setup viewer, perform one of the
following actions:

○ To adjust the input or output tonality of a DeviceLink for a
simulation, click the Simulation icon  in the PCO.

○ To adjust the input or output tonality of a DeviceLink for a
conversion, click the Conversion icon  between the CI and the
PCO or between the PCO and the SCO.

If you clicked the Simulation icon in a PCO, the Simulation
Adjustment dialog box appears. If you clicked a Conversion icon,
the Conversion - Adjustment dialog box appears.

2. In the Conversion - Adjustment or the Simulation Adjustment
dialog box, click the Adjust DeviceLink tab.

3. Perform one of the following actions:

○ To adjust color on the input device and output device, click Input
Tonality.

○ To adjust color on the output device but not on the input device,
click Output Tonality.

4. Adjust the curves at the input or output of the DeviceLink color
lookup table.

5. To see the effect of your adjustments on an image, click Preview.

6. When you are satisfied with your changes, click Apply.

See also:
About previewing images on page 149
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14 Profile Adjustments

Overview
You can adjust and edit devices profiles and DeviceLink profiles,
including source, destination, and white point tags. ColorFlow includes
the following modes for adjusting profiles:

● White Point

● Input Tonality

● Output Tonality

● Dark Point

● Gray Balance

● Selected Color

Note: In order to prevent anomalies when you are making adjustments to profiles,
do not edit the profile with multiple modes at the same time. Adjust the profile in
one mode and then test the output before making more changes.

Adjustment ranges for DeviceLink and source tag adjustment can be
localized in a device coordinate space to ensure, for example, that
adjusting the CMY-only gray balance does not affect the K-only ramp.
This localization can also be disabled.

Why do you need to adjust profiles
You can adjust profiles in order to correct for an error that was
introduced when the profile was created.

These are some of the main reasons for adjusting profiles:

● Human error, caused by misaligning the device when measuring the
profile.

● Measurement error, caused by a problem with the
spectrophotometer.

● Subjective reasons for making adjustments to the profile to improve
the reproduction of a specific color.

About Rendering Intents
All output devices, have a gamut or range of colors that they can
output. If a color needs to be output and is outside the gamut of the



output device, it must be mapped or approximated to some other color
that exists within the gamut. Rendering Intent describes the strategy
for compressing or mapping out of gamut colors from one color space
to another.

Rendering intents in profiles

A profile is composed of a number of tags that describes how a color
space is converted from one space to another.

Every device ICC profile has seven different tags (white point included)
that encodes different rendering intents for the source and destination.

● Perceptual—With this rendering intent, the full gamut of the source
space is compressed or expanded to fill the gamut of the
destination space. This preserves some relationship between out of
gamut colors, even if this results in inaccuracies for in gamut colors.
Used predominantly when converting from large to small volume
gamuts (RGB to CMYK). This rendering intent is usually used when
working with realistic images such as photographs, including scans
and images. All or most colors in the original images are changed,
but the relationship between the colors does not change.

● Saturation—The saturation of the source space is preserved, at the
expense of hue accuracy and lightness. Used predominantly with
content such as business graphics (charts, solid colors).

● Relative Colorimetric—This rendering intent, maintains a near exact
relationship between in gamut colors, even if this clips out of gamut
colors. Most often used in proof output where the destination
gamut is larger than source gamut. This is the default option for
CMYK.

● Absolute Colorimetric—Absolute colorimetric and relative
colorimetric uses the same table except for the way the white point
is adjusted for the different media types. Absolute colorimetric is
manipulated by the white point tag and is used in addition to the
relative colorimetric rending intent (wtpt) tag. It is similar to relative
colorimetric (clips out of gamut colors), but handles the color white
(purest and lightest white in the color space) differently. Most often
used for proof output where the media white color of the source
needs to be reproduced on the destination media.
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Adjusting a device profile
You can adjust the Input Tonality, Output Tonality, DarkPoint, Gray
Balance, or Selected Color of a device profile to fine-tune a
transformation.

1. In a color setup in the color setup viewer, click the Profile icon  in
the PCO.
The PCO window appears.

2. Select the Edit mode, either Source or Destination.

3. Select the suitable Rendering Intent (RI).

Note: In many cases, users will adjust the Absolute Colorimetric intent
because they want all of the in gamut colors to be reproduced exactly without
modification. In this case, they may or may not want the media white point
reproduced on the destination device. For the same RI, they may want the
media white point of the source gamut to reproduce on the destination
substrate. This is a predominant proofing use case.
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4. Select from one of the following adjustment modes:

○ Input Tonality or Output Tonality (depending on which Edit
mode you selected, Source or Destination).

○ Dark Point

○ Gray Balance

○ Selected Color

Note: See the sections following this for detailed steps on how to set the Dark
Point, White Point, Gray Balance, and Selected Color.

5. To see the effect of your adjustments on an image, click Preview.

6. When you are satisfied with your changes, click Apply.

7. When you are finished, click OK.

Note: You can undo or redo any changes from the History window. See the
chapter on History and undo later on in this guide.

Adjusting a device profile input or output tonality
You can adjust the Input Tonality or Output Tonality of a device
profile to fine-tune a transformation.

1. In a color setup in the color setup viewer, click the Profile icon  in
the PCO.
The Device Condition Profile Adjustment window appears.

2. Select the Edit mode, either Source or Destination.

3. Select the Rendering Intent (RI) that is suitable for this profile.
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4. Select Input Tonality or Output Tonality (depending on which Edit
mode you selected, Source or Destination).

Adjusting the Dark Point of a device profile overview

Editing the dark point of a device profile is often used for newspaper
proofing, since the dark colors on the newspaper print often appear
darker than on a proof, even though they have the same measured
colors. With ColorFlow, you can adjust the color look-up table (CLUT)
of the device profile source tag at one of four selectable dark points:
Solid K (input tints 0, 0, 0, 100), Solid CMY (100, 100, 100, 0), Solid
CMYK (100, 100, 100, 100), or the darkest pixel of a Preview image.
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Adjusting the dark point, allows for more accurate rendition across the
lightness scale when you are converting from one gamut to another,
where the dark points are substantially different. This occurs when you
are using a rendering intent other than perceptual, as the perceptual
rendering intent maps the dark point.

Note: One exception is if you use the Black Point compensation which also maps
the dark point from the source to the destination profile.

Editing the Dark Point values

Adjust the DarkPoint of a device profile to fine-tune a transformation.
1. In a color setup in the color setup viewer,click the Profile icon  in

the PCO.
The Device Condition Profile Adjustment window appears.

2. Select the Edit mode, either Source or Destination.
3. Select the Rendering Intent, for example Relative Colorimetric.
4. Select the Dark Point adjustment mode:
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5. From the Select Dark Point list, choose one of the following:

Option Description

Solid K (0,0,0, 100)

Solid CMY (100, 100, 100, 0)

Solid CMYK (100, 100, 100, 100)

From Preview Image Select from an image that contains
specific content suitable for the
darkest value for the reproductive
colors for the majority of your
work.

6. Adjust the dark point as required, by either entering a L*a*b* value
or use the Adjustment or Cast slider.

7. To see the effect of your adjustments on an image, click Preview.

8. When you are satisfied with your changes, click Apply.

9. When you are finished, click OK.

Adjusting the Gray Balance overview

Adjusting the Gray Balance lets you adjust the source (A2Bx) tags at a
selected point on one of two selectable gray ramps: K only and CMY
only.

When you select Gray Select and Range, you can choose the point on
the gray axis that is being edited, and the range of the source tag inputs
over which the adjustment is applied.

You can also control how far away the Chroma Limit is from the
selected gray ramp adjustment that is applied.

One example of adjusting the Gray Balance is when you want to make
a localized correction to an inaccurate color on the neutral axis of a
device profile.
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Adjusting the Gray Balance

You can adjust the Gray Balance of a device profile to fine-tune a
transformation.

1. In a color setup in the color setup viewer, click the Profile icon  in
the PCO.
The Device Condition Profile Adjustment window appears.

2. Select the Edit mode, either Source or Destination.

3. Select the Rendering Intent, for example Relative Colorimetric.

4. Select the Gray Balance adjustment mode.

5. Select the Gray Ramp, for example, K only.

6. To see the effect of your adjustments on an image, click Preview,
and then select an image that you want to adjust.
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7. In the Image Preview window, add colorimeter points to the areas
that require the adjustments.

Note: It is recommended that you keep the History window open so you can
later view the adjustments applied.

8. Using the adjustment tools, adjust the Gray Balance as required.
Check the image preview to review the changes and the
colorimeter points that there are no drastic changes. In the History
window, you can see the adjustments that you made.

Note: If you've made changes to the K only ramp, you can then go back and
adjust the CMY ramp and adjust the neutral grays. You can use this to correct
any unwanted casts. Keep the image open when adjusting CMY ramp, so that
you can preview your changes.

9. When you are done, click Apply to apply the changes.
In the History window, you can now see the adjustments you made
to both the K only and CMY Ramp.

10. When you are finished, click OK.

Adjusting a Selected Color overview

You can adjust a selected color from an image in the Image Preview
window and use the Cast and Lightness adjustment tools to apply the
changes to the source side of the ICC profile.

You can fine-tune and adjust the selected color by restricting the
ranges of Lightness, Chroma, and Hue with the Adjustment Range
sliders.

A scenario where you would use this would be when certain input color
builds have a degree of lightness or color inaccuracy that requires
adjustments to another CIELAB value. For example, a brand color that
is not mapped corrected and has little impact on the surrounding
colors.

Adjusting a Selected Color overview 145



Adjusting a Selected Color of a device profile

You can adjust a Selected Color of a device profile to fine-tune a
transformation.

1. In a color setup in the color setup viewer, click the Profile icon  in
the PCO.
The Device Condition Profile Adjustment window appears.

2. Select the Edit mode, either Source or Destination.

3. Select the Rendering Intent that is suitable for this profile, for
example Relative Colorimetric.

4. Select Selected Color adjustment mode.
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5. Click Preview and select an image where you want to apply the
adjustments. When prompted select the destination profile.

6. In the Image Preview window, add a colorimeter and position it on
the on the point in the image that you want the profile adjustments
to be applied.

7. In the Conversion Adjustments window, click Select Color.

Note: It is recommended that you leave the default ranges for Lightness,
Chroma and Hue. This displays the range the will be affected by the
adjustment.

8. Adjust the color using either the cast adjustments tool or enter the
specific values in the Device Profile In / Out fields.

9. Click Apply. In the Image Preview window, slide the divider to see
the adjustments before and after.

Note: Open the History window to view the adjustments applied.

10. When you are finished, click OK.
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15 Image preview

About previewing images
As you adjust color control elements in ColorFlow, you can use the
Image Preview window to see the real-time effect of your adjustments
on an image file in a split-screen view.

In any of the adjustment dialog boxes in ColorFlow, you can click
Preview to browse to an image and see the effect of your adjustments
on the image that you select.

You can preview only images that are 8-bit TIFF or JPEG images that in
the CMYK color space. You can open both CMYK and RGB image files
when you are adjusting device destination profiles.

You can use the Image Preview window to preview images when:

● Adjusting simulation and conversion curves and DeviceLinks

● Converting a color input for a DeviceLink

● Adjusting ICC device profiles

● Adjusting and editing device curves

● Adjusting the PCO profile

Note: The Image Preview window options vary depending on the circumstance that
you are previewing.



1. navigation pane

2. image preview pane

3. colorimeter pane

4. Divider

5. Colorimeter

6. Colorimeter (magnified)

A movable divider in the image preview pane of the Image Preview
window allows you to divide the image into two sections. One section
shows the image as it would have appeared prior to your adjustments,
and one section shows the image as it would appear after your
adjustments. You can move the divider along any edge of the image
preview pane and around any corners. When you move the divider to
the lower edge of the image preview pane, the two sections of the
image switch positions.
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Note: The image in the navigation pane shows the regions of the image that are
affected by the selected adjustment modes and ranges for all curve and profile
adjustment settings.

See also:
Colorimeter tool on page 154

Kodak Matchprint Virtual technology
If you have a Matchprint Virtual qualified monitor, you can make curve
and profile edits with accurate display color.

Matchprint Virtual Software must be installed on the qualified
Macintosh workstation where the ColorFlow client is installed.
(Matchprint Virtual preview is only supported in the Macintosh
ColorFlow client.) You can open the Matchprint Virtual software in the
ColorFlow Preview window.

The status of the calibration of the monitor is indicated by the color in
the lower right-hand corner of the window.

● red — the monitor has never been calibrated

● yellow — the monitor was previously calibrated, but requires
recalibration (Matchprint Virtual requires the monitor to be
recalibrated every 24 hours)

● green — the monitor is calibrated

When a qualified monitor for color is used, the RGB display device
profile selection is not available in the ColorFlow client preferences.
Matchprint Virtual licensing is controlled from the Kodak InSite
Prepress Portal, InSite Creative Workflow, or Kodak PressProof
Software. The MatchPrint Virtual license needs to be renewed every
60 days. To renew the Matchprint Virtual Monitor license, launch
Smart Review or the PressProof client. Opening the preview image in
ColorFlow will not renew the license.
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1 Calibrate button

2 Matchprint Virtual status

Previewing the effect of your adjustments
You can open the preview window to see the effect of your
adjustments on an image file that you specify.

The Preview option is available in any of the adjustment dialog boxes in
ColorFlow.

1. In the adjustment dialog box, click Preview.

2. Browse to an image file, and click Open.
Make sure that your image file is in the correct format. You are
prompted with an error message if the file is in the wrong color
space or format.

3. In the Image Preview window, use the input-output divider to see
the effect of your adjustments before and after they are applied.
You can drag the divider along any edge of the image preview
pane.
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Next: You can open additional preview windows as needed, and you
can use colorimeters to view the tint values of specific points in the
image.

See also:
Colorimeter tool on page 154

Zoom and pan in the Image Preview window
You can zoom and pan a previewed image in several ways.

Zoom

The current magnification of the image is shown in the text box below
the navigation pane. A magnification of 100% indicates that the image
is displayed using one screen pixel for each pixel in the image file.
Similarly, 500% indicates that ten screen pixels are used for each pixel
in the image file.

You can zoom the image in any of the following ways:

● Use the slider below the navigation pane:

○ Drag the slider right or left to zoom in or zoom out.

○ Select the slider and use the left and right arrow keys on the
keyboard to nudge it.

● Use the text box below the navigation pane:

○ Type a zoom percentage value in the text box.

○ Select a zoom percentage value in the list.

● Use your mouse:

○ In the navigation pane, drag a rectangle around a portion of the
image that you want to fill the viewing area.

○ For Windows, click the image and Ctrl+drag a rectangle around a
portion of the image that you want to fill the viewing area.

○ For Mac OS X, click the image and Command+drag a rectangle
around a portion of the image that you want to fill the viewing
area.

○ Click the image and roll your mouse wheel away from the
monitor to zoom in and towards the monitor to zoom out.
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Pan

You can pan the viewed area by dragging the image. You can also click
a point in either the image or the navigation pane to select a new
center‑point.

Colorimeter tool
You can use a colorimeter to display the tint values of colors at
selected points in the preview image.

When you add a colorimeter in the Image Preview window and drag it
over the point you want to examine, tint information about the selected
point is displayed below the image and in the colorimeter pane.

Note: You can add and remove a colorimeter as required.

The Input column displays the tint values of inks in the input file at the
colorimeter location. Values in the Input column do not change with
your adjustments.

The Output column displays the tint values of inks in the output file at
the colorimeter location. Values in the Output column change as you
adjust a color control element. The Output column consists of two
sides which correspond to the two sections of the preview image.
Depending on the type of color control element that you are adjusting,
values on the left or right side of the Output column will change.

● When you adjust a simulation or conversion curve or DeviceLink,
the tint values of inks in the output, prior to your adjustments, are
shown on the left side of the column, and remain constant. Tint
values of inks in the output, after your adjustments, are shown on
the right side of the column, and change with your adjustment.

● When you adjust a device curve, the current tint values of inks in
the output are shown on the left side, and change with your device
curve adjustment. Your desired tint values of inks in the output are
shown on the right side of the column, and remain constant as a
reference to the expected output tint after you correct a color shift.

You can place a colorimeter in either section of the image preview—
this does not affect the values that are displayed in the colorimeter
pane. For example, if you drag the image preview divider to the left side
of a colorimeter, the same values are displayed in the colorimeter pane
as when you drag the divider to the right side of the colorimeter.

See also:
Correcting a color shift on a curve-controlled device on page 86
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Working with colorimeters
You can use colorimeters in the Image Preview window to display the
tint values of colors at selected points in the image.

1. To add a floating colorimeter, click the add button under the image.
You can add as many colorimeters as you need, although only one
colorimeter can be selected at a time.

2. Drag a colorimeter to any point in the image.
The Input and Output columns below the image display the tint
value for each ink and the total tint value for all inks.

3. To select a colorimeter, roll your mouse over the colorimeter or
click the colorimeter.
A white box appears around the colorimeter number.

4. To magnify a colorimeter, perform one of the following actions:

○ For Windows, select the colorimeter and press the Ctrl key.

○ For Mac, select the colorimeter and press the Command key.

Magnifying a colorimeter allows you to see detail without having to
magnify the entire image.

5. To maintain the magnification on a colorimeter, perform one of the
following actions:

○ For Windows, hold down Ctrl while you move your mouse away
from the colorimeter.

○ For Mac, hold down Command while you move your mouse
away from the colorimeter.

The colorimeter remains magnified until you select it again and
press Ctrl or Command.

6. To temporarily hide all colorimeters from the image, select the Hide
Colorimeters check box.
Colorimeter information is still displayed in the navigation pane
and the colorimeter pane.

7. To delete a colorimeter, select the colorimeter and click the delete
button under the image.
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16 Plate setups

About plate setups
ColorFlow can use plate setups to isolate the effect of the plating line so
that different platesetting devices can be substituted in a color setup
without recalculation of color control elements.

A Plate Setup is an optional device condition property that is available
for offset press and flexographic press device types. You can use plate
setups to create plate setup curves that linearize the plates for your
offset or flexographic press device.

Each plate setup describes a particular combination of device type,
plate type, and screening, and contains one or more ColorFlow plate
lines. A plate setup is uniquely identified by its properties. You do not
need to assign a name to a plate setup. When you select a plate setup
as a device condition property for an offset device, the screening
information in the plate setup is used for the device condition. Any
screening options that you may have previously specified in the
Screening list are ignored.

Each plate setup can contain multiple ColorFlow plate lines. ColorFlow
calculates a plate setup curve for each plate line to linearize that plating
process. When you create a job in Prinergy, you can select the plate line
that the job should use.

Plate setups curves are independent of calibration curves and any other
types of curves in ColorFlow.

You cannot import an existing plate curve into ColorFlow from any
other software.

Plate lines
A ColorFlow plate line represents a physical platesetter and plate
processing system.

Each combination of a particular plating line in your shop, plate type,
and screening, has a measurable response. To determine the behavior
of a particular plating line, plate type, and screening combination you
must image a plate control strip (such as the Kodak Image Control Strip
test image) on a plate, manually measure the resulting dot area values
on the plate, and type your required values in the Plate Setups dialog
box in ColorFlow.



A single ColorFlow plate line is associated with only one plate setup. In
your shop, you may use one physical platesetter and processing
chemistry to process several different screenings. To model this in
ColorFlow, you can create similar plate lines in different plate setups
and name the plate lines to match the physical equipment in your
plant.

You can create several different plate lines to reflect changing
chemistry. For example, if you routinely change solutions on Mondays,
you may want to create different ColorFlow plate lines for Monday,
Wednesday, and Friday—for example, LotemFibrehead-
Monday_Chemistry-ProcessorA-Prebake, LotemFibrehead-
Wednesday_Chemistry-ProcessorA-Prebake, and
LotemFibrehead-Friday_Chemistry-ProcessorA-Prebake.

Creating a plate setup
You can create a plate setup that you can use in a device condition.

Requirements: You must have imaged a plate control strip using this
particular combination of press type, plate type, screening, and plating
line.

You cannot create a new plate setup that has the same screening and
plate type as an existing plate setup.

1. In the Device Condition Properties dialog box for an offset press,
select Plate Setup and click the edit button .

2. In the Plate Setups dialog box, below the Plate Setups list, click the
add button .

3. In the New Plate Setup dialog box, select the appropriate options.

a. In the Device type list, select the offset device type for which
you are creating this plate setup.

b. In the Plate Type list, select the plate type for which you are
creating this plate setup.
If you need to add a plate type to the list, click the edit button

 and add the new plate type. A plate type can be used in
many plate setups for the same device type.

c. In the Screening list, select the screening for which you are
creating this plate setup. Use the edit button if you need to add
screening values to the list.
If you need to add a screening value to the list, click the edit
button  and add the new screening value. A screening value
can be used in many plate setups.

Screening values added here will be available everywhere the
screening property for this device type appears.

158 Chapter 16—Plate setups



4. Click OK to create the plate setup.
The new plate setup appears in the Plate Setups list, named by its
properties.

5. Add a plate line to the plate setup.

a. In the Plate Lines area, click the add button .

b. In the Name column, double-click the default name of the plate
line that you just added and type a name that describes your
platesetter and chemistry.
For example, if you routinely change solutions on Mondays, type
a name like LotemFibrehead-Monday_Chemistry-
ProcessorA-Prebake.

c. Use your plate reader to measure the patches on the plate
control strip.
Measure the lower half of the tone scale, which is made with
reference screening, independent of job settings. Ensure that the
correct Plate Control Strip was used for this particular resolution
and screening.

d. In the Tint Values area for this plate line, in the Measured Tint
(Uncalibrated) column, click a desired row and type the
measured tint value as a number between 0.0 and 100.0
percent for the input tint value.
You do not have to type a measured value for every input tint
value.

6. Click Close.

A plate setup has been created for the given device type. You can
select it in the Plate Setup list in the Device Condition Properties dialog
box.

Assigning a plate setup to a device condition
You can use a plate setup in a device condition to make linear plates
for an offset press.

Requirements: If the plate setup that you want to use does not exist,
you must create it.
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1. In a color setup in the color setup viewer, click the Properties icon
 in the device condition of an offset press.

2. In the Device Condition Properties dialog box, select Plate setup.

3. In the Plate Setup list, select the plate setup that you want to use
for this device condition.
The screening information in the plate setup is used for this press,
and any screening option that you previously selected for the press
in the Device Condition Properties dialog box is ignored.

See also:
ColorFlow device conditions on page 45

Adding a plating line to a plate setup
You can configure another platesetter and its processing line as an
alternative plate line in an existing plate setup.

Requirements: You must have imaged a plate control strip using this
particular combination of press type, plate type, screening, and plating
line.

1. Select View > Plate Setups.

2. In the Plate Setups dialog box, in the Device Types list, select the
offset device type for which this plate setup was defined.

3. In the Plate Setups list, select the plate setup to which you want to
add the plate line.

4. In the Plate Lines area, click the add button .

5. In the Name column, double-click the default name of the plate line
that you just added and type a name that describes your platesetter
and chemistry.
For example, if you routinely change solutions on Mondays, type a
name like LotemFibrehead-Monday_Chemistry-ProcessorA-
Prebake.

6. Use your plate reader to measure the patches on the plate control
strip.
Measure the lower half of the tone scale, which is made with
reference screening, independent of job settings. Ensure that the
correct Plate Control Strip was used for this particular resolution
and screening.

7. In the Tint Values area for this plate line, in the Measured Tint
(Uncalibrated) column, click a desired row and type the measured
tint value as a number between 0.0 and 100.0 percent for the input
tint value.
You do not have to type a measured value for every input tint value.

8. Click Close.

160 Chapter 16—Plate setups



An additional plate line is now available in the plate setup.

Exporting plate setup curves
You can export plate setup curves from ColorFlow to use the curves in
a non-integrated workflow or in external software.

In the Workflow and Pro Workflow editions of ColorFlow software, you
do not need to export any color control elements in order to use them
in your Prinergy Connect or Prinergy Evo workflow.

1. Select View > Plate Setups.

2. In the Plate Setups dialog box, in the Device Types list, select the
offset device type for which this plate setup was defined.

3. In the Plate Setups list, select the plate setup that you want to
export.

4. Click Export.

5. Browse to the location where you want to export the plate setup,
and click Save.

ColorFlow exports a single-curve Harmony .hmy file containing a plate
curve for each plate line in the plate setup.

Remeasuring tints in a plate line
You can adjust the measured tint densities on plate after some change
has occurred to a plate line in an existing plate setup.

Requirements: You must have imaged a plate control strip using this
particular combination of press type, plate type, screening, and plating
line.

1. Select View > Plate Setups.

2. In the Plate Setups dialog box, in the Device Types list, select the
offset device type for which this plate setup was defined.

3. In the Plate Setups list, select the plate setup in which you want to
remeasure the plate line.

4. In the Plate Lines list, select the plate line that you want to
remeasure.

5. Use your plate reader to measure the patches on the plate control
strip.
Measure the lower half of the tone scale, which is made with
reference screening, independent of job settings. Ensure that the
correct Plate Control Strip was used for this particular resolution
and screening.
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6. In the Tint Values area for this plate line, in the Measured Tint
(Uncalibrated) column, click a desired row and type the measured
tint value as a number between 0.0 and 100.0 percent for the input
tint value.
You do not have to type a measured value for every input tint value.

7. Click Close.

The plate setup curve for this combination of plate setup and plate line
is changed.
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17 Flexographic printing
setup

Flexographic printing has some unique properties and requirements for
setting up curves and profiles. ColorFlow software has a variety of
capabilities for setting up flexographic devices and device conditions,
and for accurately simulating their color response on proofing devices.
This chapter provides a summary of flexographic printing, and how
ColorFlow software supports its setup.

Overview
Flexographic printing technology uses a flexible relief plate that
transfers ink from a roller, called the anilox roller, to the substrate with a
rubber-stamp mechanism. Ink-carrying surfaces protrude above the
recessed base. Total plate thicknesses range from about 0.05 to 0.25
in. or 1.2 to 6.4 mm, with the base comprising about two-thirds of the
thickness.

Like offset printing, flexographic printing (or flexography) uses halftone
screens to render tints, but the protrusion of flexographic halftone dots
above the base of the plate produces some physical effects that
uniquely affect the color response of this technology. Two primary
effects must be considered in controlling and proofing flexography:
highlight gain and minimum printable dot.

Highlight gain—Small halftone dots form rubber pillars on the
flexographic plate. Under compression, these pillars expand in
diameter, transferring more ink to the substrate than expected from the
intended halftone dot area. This results in large physical dot gain in the
highlight region. Accurate color control and proofing require special
treatment of this large highlight gain.

Minimum printable dot—Some flexographic plate technologies cannot
reliably image and print a halftone dot smaller than about 5%. For
lighter tints, halftone dot pillars may form on the plate, but they
collapse under compression. This collapse causes excessive physical
gain, smearing, and color instability—an effect called scum dots.

The smallest tint value that can be reliably imaged and printed is called
the minimum printable dot. This dot varies according to screen ruling,
plate thickness, web width, and other physical factors. To avoid scum
dots, it is essential that dots smaller than the minimum printable dot
are never imaged on the plate. This is accomplished by using the special
curves described below.



Bump and cutoff curves
Two approaches to curve shape are used to ensure that dots smaller
than the minimum printable dot are not imaged on a flexographic plate:
bump and cutoff curves.

Bump curves—Bump curves map a low input tint value, typically
between 0.3% and 1.0%, to the minimum printable dot. Lower input
tint values are mapped to zero output, ensuring that no dots smaller
than the minimum printable dot appear on the plate. The curve has a
discontinuity, where the selected input tint value is “bumped” to the
minimum printable dot. Above this discontinuity, the curve increases
smoothly to 100%. The curve typically becomes linear (output = input)
at some intermediate point.

It is common practice to select 0.39% as the input tint value that is
bumped up to the minimum printable dot. This value represents the
first tint level above zero in 8-bit image files. This ensures, for example,
that a gradient that extends down to 0% produces non-zero output on
the plate over the maximum possible extent of the gradient. However,
the bump causes the gradient to be darker than expected in the
highlight region.

Cutoff curves— Cutoff curves are typically linear from 100% down to
the curve point where input and output equal the minimum printable
dot. Below this point, input tint values are mapped to zero output,
ensuring that no dots smaller than the minimum printable dot appear
on the plate. Cutoff curves, like bump curves, are discontinuous. They
differ only in the input tint value that is chosen to reproduce the
minimum printable dot on the plate.

Reproducing a gradient with a cutoff curve ensures that the gradient
has the correct tonality down to the minimum-printable-dot cutoff
point. The disadvantage is that a substantial portion of the gradient will
be reproduced with zero output. For example, if a cutoff curve is used
with a 10% minimum printable dot, then one-tenth the length of a
gradient from 0% to 100% will have zero output.

The capabilities of ColorFlow software support the generation of bump
and cutoff curves, with a variety of options.

Color response
With the exception of flexography, most printing technologies can print
sufficiently light tints that the device response is considered to
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progress smoothly and continuously from the substrate color through
highlights and across the tonal scale.

Some measurements from the device condition for a typical sheetfed
offset press provide an example of this continuous response:

● The color change from the substrate to a 1% magenta dot is 0.7
DeltaE—a marginally noticeable color change. The 1% tint has a
tonal response, or Effective Dot Area (EDA), of 1.4%.

● The color change from the substrate to a 2% magenta dot is 1.4
DeltaE—twice that produced by the 1% dot, yielding an EDA of
2.8%.

In contrast to other printing technologies, flexographic printing
typically exhibits a discontinuous response due to the effects of
highlight gain and minimum printable dot. That is, there is a large step
in the color response between the substrate color and the color
produced by the smallest printable dot of ink. This step is called a flexo
discontinuity. It affects all process and spot inks to varying degrees,
and is evident in the colorimetric (CIELAB) and tonal (EDA) responses
of flexographic printing conditions.

The term discontinuity also refers to the step function in bump and
cutoff curves, as well as profiles and other curves generated by
ColorFlow software, when setting up flexographic printing.

The technology effects of Flexographic plates
The extent of the flexo discontinuity depends primarily on the
technology of the flexographic plate. Two plate types are commonly
used: Kodak Flexcel NX plates and Laser Ablative Mask System
(LAMS) plates. The properties of these plates that affect color
response and the behavior of ColorFlow software are described below.
For more information about these plates, see the technical reference
material provided by their manufacturers.

Kodak Flexcel NX plates
Highlight gain is the dominant effect with Flexcel NX plates. Halftone
dots as small as one or two pixels at 2400 dpi (0.4 or 0.8 percent at
150 lpi) can be imaged and printed reliably, but these small halftone
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dots are subject to compression dot gain, causing a small flexo
discontinuity.

A typical flexographic press device condition using Flexcel NX plates at
175 lpi has the following behavior, demonstrating the effect and
magnitude of the discontinuity:

● The color change from the substrate to a 1% magenta dot is 3.7
DeltaE—an easily noticeable difference. The 1% tint has a tonal
response or EDA of 9%.

● The color change from the substrate to a 2% magenta dot is 4.5
DeltaE—less than twice that exhibited by the 1% dot—and the 2%
tint has an EDA of 10%.

The color change from substrate to 1% is much larger than that from
1% to 2%. Compare this color response to the typical offset color
response (described earlier), in which there are similar color changes
from 0% to 1%, and 1% to 2%.

Laser Ablative Mask System (LAMS) plates
LAMS plates have a minimum printable dot ranging from about 4% to
10%, depending on screen ruling and physical configuration.

A typical flexographic press device condition using LAMS plates at 133
lpi has a minimum printable dot of 7%. Applying a bump curve that
maps 1% to 7% produces the following behavior:

● The color change from the substrate to a 1% magenta dot is 6.1
DeltaE—a very noticeable difference. The 1% tint has a tonal
response or EDA of 15%.

● The color change from the substrate to a 2% magenta dot is 8.2
DeltaE—less than twice that exhibited by the 1% dot; the 2% tint
has an EDA of 17%.

The color change from substrate to 1% is much larger than that from
1% to 2% The response is similar to that of the Flexcel NX plates, but
the flexo discontinuity is larger with LAMS plates (that is, the color
change from substrate to 1% tint).

The flexo discontinuity is not caused entirely by the inherent response
of flexographic printing. In the case of LAMS plates in particular,
halftone dots smaller than the minimum printable dot are capable of
forming on the plate and transferring ink to the substrate; but their
formation and behavior is unreliable and unstable, so they are
eliminated by using bump or cutoff curves. It is the combination of this
bump or cutoff curve, and the inherent device response, that
determines the input tint value at which the discontinuity occurs, and
the magnitude of its color change.

While the magnitude of the flexo discontinuity varies according to
plate type and other factors, a common set of capabilities in ColorFlow
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software manages the discontinuity for all flexographic press device
conditions.

Screening effects
Halftone screen ruling affects the nature of the flexo discontinuity.
Generally speaking, increasing the ruling increases the highlight gain
for all plate technologies, which increases the magnitude of the flexo
discontinuity. A screen ruling increase also increases the minimum
printable dot for LAMS plates, and as a result, increases the magnitude
of the flexo discontinuity.

The factors that cause flexo discontinuity can be mitigated by using
hybrid screening technologies, such as Kodak Maxtone Screening.
Hybrid screening systems use conventional (AM) halftone dots
through most of the tonal range, but change to stochastic (FM)
screening in the highlight region. Use of FM screening in the highlights
produces a continuous color transition from an input tint gradient that
extends down to 0%, at the expense of increased grain and an
apparent visual transition from FM to AM screening.

Flexographic press device type
ColorFlow software includes a device type for defining flexographic
presses in the Devices palette. A flexographic press is a curve-
controlled device type.

When you define a device condition for a Flexographic Press, specific
features for setting up and proofing flexographic presses are enabled in
the device condition and in color setups that use the device as the PCO
or SCO. These features are described below.

Note: A flexographic press device condition cannot function as a color input for a
color setup.

See also:
Devices on page 41

Flexographic plate setups and curves
Flexographic press device conditions in ColorFlow software have the
same plate setup and plate curve capabilities as offset press device
conditions. A flexographic plate setup is identified by a combination of
Screening and Plate Type attributes, has one or more plate lines, and
may be associated with one or more flexographic press device
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conditions. For output to a specific plate type, the same plate curve
applies to all separations for process and spot inks.

The response of a flexographic plate is typically measured by a system
that captures a camera image of a tint patch on the plate, and then
performs an image analysis to estimate the relative area of the
protruding, ink-carrying surfaces. You can enter these dot area
estimates into the plate setup in ColorFlow software.

The response of a flexographic plate is considered to be continuous,
and so is the plate curve that ColorFlow software calculates to linearize
the response. The flexo discontinuity is managed by special device
curves.

See also:
Plate setups on page 157

Flexographic press device curves
Device curves define bump or cutoff curves for each device in a
flexographic press device condition. The point at which the
discontinuous curve steps from zero to the minimum printable dot is
called the Mindot of the curve. The Mindot has a Tint In value that
specifies the input tint value where you want the discontinuity to occur,
and a Minimum Tint Out value that you set to the minimum printable
dot.

It is common to print spot inks with operating conditions that are
different from those used for process inks. For example, different
screening systems (AM versus hybrid) or anilox roller conditions can
be applied. This may result in different minimum printable dot values
for spot inks versus process inks. To accommodate these differences,
ColorFlow software provides two separate Mindot definitions: one for
process inks and another for spot inks. This capability lets you use
bump curves for process inks and cutoff curves for spot inks.

You define device curve Mindot settings in the Default Device Curves
Definition for a flexographic press device condition.
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Each device that you add to the device condition will inherit the default
device curves, and their Mindot settings for its device curves.

The Mindot Tint In and Minimum Tint Out values only define the
discontinuity of flexo bump or cutoff curves. Above the Mindot, the
shape of the curve is defined by preset or imported curves, using the
same controls as for other curved device types.

You can view the device curve Mindot settings for any device in the
Device Curves Definition dialog.

See also:
Pooled devices in a device condition on page 61
Adding a curve-controlled device to an existing device condition
on page 62

Preset device curves for Flexcel NX plates
The preset device curves in ColorFlow software include 13
 recommended curve shapes for setting up printing with Flexcel NX
plates. These curves are only available for flexographic press device
conditions.

Highlight Contrast control
When you define bump or cutoff curves, it is likely that the Mindot
definition you provide will not coincide with the preset or imported
curves that you choose. For example, you may want to use Linear
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curves with a Mindot that bumps 0.39% to 7.0% for LAMS plates. The
Mindot lies above the linear curve.

The Highlight Contrast control determines how the curve tapers from
the Mindot point to the preset or imported curve. With a low Highlight
Contrast value, the curve converges quickly to the selected curve. This
flattens the curve in the highlight region, and sacrifices highlight
contrast. Increasing the Highlight Contrast value improves contrast in
this tonal region, but extends the darkening effect of the Mindot bump
further up on the tonal range.

Allow Tint Out increase to improve color match control
The Allow Tint Out increase to improve color match option controls
whether ColorFlow software increases the Mindot Tint Out value of a
device curve when it calculates device curves for non-promoted
devices. It also has a similar effect on simulation and conversion curve
calculation.

With some flexographic press device conditions, the minimum
printable dot is small enough that it is not necessary to use a bump or
cutoff curve. Nevertheless, this type of device condition may have a
large enough highlight gain that its color response is discontinuous. In
this situation, you would use the default Mindot settings to ensure that
ColorFlow software accurately models the discontinuous color
response.

If the discontinuity of the color response is negligible for process and/
or spot inks, set the corresponding Mindot Tint In values to zero. This
eliminates the Mindot and indicates to ColorFlow software that the
device condition color response is continuous, giving it the same
capabilities as other types of curve-controlled device conditions.

See also:
Device curves on page 54
Pooled devices in a device condition on page 61
Device curves generated with ColorFlow software on page 172
DeviceLink restrictions for discontinuous color responses on page 179

Flexographic press device curve adjustment
You can adjust bump and cutoff device curves using the same tools
that you use for other device curves. You can also adjust the Mindot of
discontinuous process or spot ink device curves.

Mindot adjustment lets you increase the Mindot Tint Out value for any
process or spot ink device curve, to make a tonal correction or to
accommodate an increase in the minimum printable dot. You can also
adjust the cast of the CMY Mindot point.
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The Mindot adjustment does not let the Mindot Tint Out value be less
that the Minimum Tint Out setting in the Default Device Curves. This
ensures that the curves cannot generate output less than the minimum
printable dot.

You cannot adjust the Mindot Tint In value of any process or spot ink
device curve. The Tint In value is an important attribute of the device
color response. If you need to change a Mindot Tint In value, you must
redefine the device condition default device curves, and the device
curves of the affected device. This requires you to re-characterize the
device response.

Discontinuous color response
When ColorFlow software models the color response of flexographic
printing with flexo discontinuity, the resulting color response is called a
discontinuous color response. ColorFlow software accurately represents
the flexo discontinuity in both types of a color response: tonal response
and colorimetric response.

The input tint value at which the discontinuity occurs, and the
corresponding color response of a spot or process ink channel, is called
the Mindot of the discontinuous color response.

If a discontinuous color response has tonal and colorimetric
components, they have the same Mindot Tint In value.

See also:
About color response on page 81

Discontinuous tonal response
Tonal response comprises the EDA of each ink channel whose
response is measured. If a process or spot ink has a flexo discontinuity,
its tonal response has a step change, at the Mindot Tint In value, from
zero to the EDA value printed by the Mindot.

As with continuous tonal color responses, the tonal response
component of a discontinuous color response is used for tonal match
curve generation, and is reflected in tonal response graphs of devices,
device conditions, PCOs, and SCOs.

Discontinuous colorimetric response
Colorimetric response comprises the CIELAB color response of process
ink ramps and overprinted combinations. It also includes the CIELAB
color response of spot ink ramps. If a process or spot ink has a flexo
discontinuity, its colorimetric response has a step change at the
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Mindot Tint In value, from the substrate color to the color printed by
the Mindot.

As with continuous tonal color responses, the colorimetric response
component of a discontinuous color response is used for gray balance
curve, device profile, and DeviceLink generation.

Discontinuous device response
If the device curves Mindot Tint In value of a flexo device is non-zero,
ColorFlow software models the device response with a discontinuous
color response. The Mindot response of a given process or spot ink is
equal to the color printed by the Mindot Tint Out value of the device
curve in effect when the device is characterized.

ColorFlow software uses the discontinuous response of a non-
promoted device to generate its device curves, as described below. The
discontinuity is also reflected in the Device Tonality graph.

See also:
Uncalibrated Device Tonality dialog box on page 235

Device curves generated with ColorFlow software
When you characterize the response of a non-promoted device in a
flexographic press device condition, ColorFlow software calculates
device curves to align the device response to the promoted device
response—just as it does for other curved device types. When
performing this calculation for a flexo device with bump or cutoff
curves, ColorFlow software uses the device curve Mindot settings to
ensure that scum dots are not generated.

For example, consider a non-promoted device that has a darker
response in the highlight region than the promoted device. ColorFlow
software will not reduce the Mindot Tint Out value of the curves in an
attempt to match the lighter promoted device response. Instead, the
response of the non-promoted device will remain darker in the
highlight region.

Further up the tonal scale, the calculated device curves align the non-
promoted device response to the promoted device response. The
Highlight Contrast control determines how the curves taper from their
Mindot points to the curves that provide exact alignment.

See also:
Device curves on page 54
Highlight Contrast control on page 169
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Aligning highlight response
If the non-promoted device has a lighter response in the highlight
region than the promoted device, ColorFlow software can increase the
Mindot Tint Out value of the calculated curves to match the darker
promoted device across the entire tonal range. Alternatively, it can
leave the Mindot Tint Out value unchanged, leaving the non-promoted
device response lighter in the highlight region.

In this situation the Allow Tint Out increase to improve color match
control determines the behavior of ColorFlow software. If you select
the Allow Tint Out increase to improve color match check box,
ColorFlow software increases the Mindot Tint Out value of each curve
to match the promoted device response across the entire tonal range.
If you clear the Allow Tint Out increase to improve color match check
box, ColorFlow software does not change the Mindot Tint Out values
of the curves. It tapers the curves from their Mindot to the shapes
required for exact alignment, according to the Highlight Contrast
control.

See also:
Highlight Contrast control on page 169
Allow Tint Out increase to improve color match control on page 170

CMY highlight cast alignment
For all curved device types, ColorFlow software calculates non-
promoted device process ink curves using the Gray Balance method,
provided both devices have colorimetric response information. When
performing this operation for bump or cutoff device curves, ColorFlow
software can calculate CMY curves that correct the cast of the non-
promoted device highlight response to match the gray balance of the
promoted device. The correction includes the Mindot response.

The Allow Tint Out increase to improve color match control
determines if this cast correction is performed. If you clear the control,
Mindot Tint Out values are unaffected and the highlight cast is not
corrected.

If you select Allow Tint Out increase to improve color match,
ColorFlow software performs this cast correction if the non-promoted
device response is darker or lighter than the promoted device response
in the highlight region. If the non-promoted response is lighter,
ColorFlow software increases the Mindot Tint Out value of cyan,
magenta, and yellow curves to exactly align the cast and lightness of
the non-promoted device to the promoted response. If the non-
promoted response is darker, ColorFlow software increases the Mindot
Tint Out value of one or two of the cyan, magenta, and yellow curves
to exactly align only the cast of the non-promoted device to the
promoted response. The non-promoted response will remain darker in
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the highlight region. The Highlight Contrast control determines the tint
values at which the lightness of the non-promoted response also
matches that of the promoted response.

Discontinuous device condition
If the promoted device of a flexographic press device condition has a
discontinuous color response, the device condition has a discontinuous
color response and is called a discontinuous device condition. ColorFlow
software uses the discontinuous color response to generate and adjust
the device condition profile, and the simulation and conversion curves
of PCOs and SCOs that use the device condition. The resulting profile
and curves are discontinuous.

If you characterize a flexographic device condition by importing a
discontinuous device profile for the device condition profile, the device
condition becomes a discontinuous device condition, independent of
the color response of its devices.

Discontinuous device condition profile
When ColorFlow software generates a device condition profile for a
discontinuous device condition, the source tags (A2B tags) of the
profile reflect the discontinuous color response of the device condition.
The resulting ICC device profile is called a discontinuous device profile.

The destination tags (B2A tags) of the device condition profile are
continuous, despite the discontinuous device condition color response.
ColorFlow software generates B2A tags that provide optimal color
separations when the discontinuous profile is used as a destination
profile in a profile pair workflow for RGB image separation.

Discontinuous device profile input curves
The input curves of each source tag (A2B tag) provide accurate
simulation of the flexo discontinuity. They have a Mindot whose Tint In
value equals that of the discontinuous color response from which they
are generated.

Note: Other than this Tint In value, the source tag input curve Mindots do not
reflect the color response of the device condition, nor any curves associated with
it. For ColorFlow software-generated CMYK device profiles, the Mindot Tint Out
values are equal to 6.25%. This is a reflection of the internal profile structure.
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Discontinuous PCO
If the PCO in a color setup uses a discontinuous device condition, the
PCO has a discontinuous color response and is called a discontinuous
PCO. If the simulation target is continuous, or set to None, then the
PCO Mindot Tint In value equals the device condition Mindot Tint In
value.

If the simulation target is a discontinuous device condition, the PCO is
discontinuous.The PCO Mindot Tint In value equals that of the
simulation target.

ColorFlow software uses the discontinuous color response of the PCO
to generate and adjust the PCO profile and SCO conversion curves or
DeviceLinks. The resulting profile, curves, and DeviceLink are
discontinuous, and have Mindot Tint In values equal to that of the PCO
response.

See also:
DeviceLink restrictions for discontinuous color responses on page 179

PCO Simulation Curve Generation
If the simulation target is discontinuous and the PCO uses a
continuous, curve-controlled device condition, ColorFlow software
calculates Gray Balance or Tonal Match simulation curves to exactly
align the PCO color response to the target response across the entire
tonal scale.

Aligning highlight response
When ColorFlow software calculates Tonal Match or Gray Balance
simulation curves for a discontinuous device condition, it is likely that
the device condition's color response in the highlight region is darker
than the target response, unless the target is also discontinuous. The
device condition response cannot be aligned to the target response in
this region, because the device condition cannot print lighter than its
Mindot response. In this case, simulation curves have no effect at the
Mindot; Tint Out equals Tint In.

Further up the tonal scale, the calculated simulation curves align the
PCO device condition response to the target response. The Highlight
Contrast control of the PCO device condition determines how the
curves taper from their Mindot points to the curves that provide exact
alignment.

If the PCO target and device condition are discontinuous, the
possibility of alignment in the highlight region is determined by the
relative darkness of the target and device condition Mindot responses.
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If the target Mindot response is darker than that of the device
condition, ColorFlow software can generate simulation curves that
increase the Mindot Tint Out for the device condition, providing exact
alignment across the entire tonal range. Alternatively, it can generate
simulation curves that have no effect at the Mindot, leaving the PCO
response lighter that the target in the highlight region.

The Allow Tint Out increase to improve color match control of the
PCO device condition determines the behavior of ColorFlow software
in this situation. If you select the Allow Tint Out increase to improve
color match check box, ColorFlow software increases the Mindot Tint
Out value of each simulation curve to match the target response
across the entire tonal range. If you clear the Allow Tint Out increase
to improve color match check box, ColorFlow software will not affect
the Mindot of the curves. It tapers the curves from the Mindot to the
shapes required for exact alignment, according to the Highlight
Contrast control of the PCO device condition.

See also:
Highlight Contrast control on page 169
Allow Tint Out increase to improve color match control on page 170

CMY highlight cast alignment
When ColorFlow software generates Gray Balance simulation curves
for a discontinous PCO device condition, it can calculate CMY curves
that correct the cast of the device condition highlight response to
match the gray balance of the target. The correction includes the
Mindot response.

The Allow Tint Out increase to improve color match control of the
PCO device condition determines whether or not this cast correction is
performed. If you clear the control, calculated simulation curves have
no effect at the Mindot, and the highlight cast is not corrected.

If you select Allow Tint Out increase to improve color match,
ColorFlow software performs this cast correction when the PCO device
condition response is darker or lighter than the target response in the
highlight region. If the device condition response is lighter, ColorFlow
software increases the Mindot Tint Out value of cyan, magenta and
yellow simulation curves to exactly align the cast and lightness of the
PCO to the target. If the device condition response is darker, ColorFlow
software increases the Mindot Tint Out value of one or two of the
cyan, magenta and yellow simulation curves to exactly align the cast
only of the PCO to the target. The PCO response will remain darker in
the highlight region. The Highlight Contrast control of the PCO device
condition determines the tint values at which the lightness of the PCO
also matches that of the target.
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PCO Simulation DeviceLink generation
If the simulation target is discontinuous and you select a ColorFlow
software-generated simulation DeviceLink method, ColorFlow
software calculates a DeviceLink that accurately simulates the
discontinuous target color response on any PCO device condition. The
resulting DeviceLink is called a discontinuous DeviceLink.

See also:
Discontinuous DeviceLink input curves on page 178

SCO Conversion Curve generation
If the PCO is discontinuous and the SCO uses a continuous, curve-
controlled device condition, ColorFlow software calculates Gray
Balance or Tonal Match conversion curves to exactly align the SCO
color response to the PCO response across the entire tonal scale.

When ColorFlow software calculates Tonal Match or Gray Balance
conversion curves for a discontinuous SCO device condition, it is likely
that the color response of the device condition in the highlight region is
darker than the PCO response, unless the PCO is also discontinuous.
Alternatives exist for controlling curve calculation in the Mindot and
highlight region that depend on the PCO and SCO device condition
color responses.

In these situations, the calculation of the SCO conversion curve is
similar to PCO simulation curve calculations (described above), with
the simulation target response for PCO simulation curve calculations
replaced by the PCO response for SCO conversion curve calculations.

The Allow Tint Out increase to improve color match and Highlight
Contrast controls of the SCO device condition determine conversion
curve calculation in these cases.

See also:
Highlight Contrast control on page 169
Allow Tint Out increase to improve color match control on page 170
Aligning highlight response on page 175
CMY highlight cast alignment on page 176

SCO Conversion DeviceLink generation
If the PCO is discontinuous and you select a ColorFlow software-
generated conversion DeviceLink method for an SCO, ColorFlow
software calculates a DeviceLink that accurately reproduces the
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discontinuous PCO color response on the SCO device condition. The
resulting DeviceLink is called a discontinuous DeviceLink.

Discontinuous DeviceLink input curves
The input curves of a discontinuous DeviceLink provide accurate
simulation of the flexo discontinuity. They have a Mindot whose Tint In
value equals that of discontinuous color response of the DeviceLink
source; that is, the PCO response for SCO conversion DeviceLinks.

Note: Other than this Tint In value, the input curve Mindots do not reflect the
color response of the DeviceLink source, nor any curves associated with it. For
ColorFlow software-generated CMYK-input DeviceLinks, the input curve Mindot
Tint Out values are equal to 6.25%. This is a reflection of the internal profile
structure.

Discontinuous PCO profile
When ColorFlow software generates the PCO profile of a
discontinuous PCO, the source tags (A2B tags) of the profile reflect the
discontinuous color response of the PCO. The resulting ICC device
profile is called a discontinuous device profile. Each process ink channel
of the source tags has a Mindot whose Tint In value equals the color
response Mindot Tint In value.

The destination tags (B2A tags) of the PCO profile are continuous,
despite the discontinuous PCO color response. ColorFlow software
generates B2A tags that provide optimal color separations when the
discontinuous profile is used as a destination profile in a profile pair
workflow for RGB image separation.

See also:
Discontinuous device profile input curves on page 174

Separating and editing images with the PCO profile
You can use the PCO profile to separate RGB image and graphic
content, or to reseparate CMYK content. If you use the Prinergy Refine
process to separate or reseparate content, ColorFlow software delivers
the PCO profile to Prinergy for use as a destination profile.

You can also export the PCO profile to use in other applications that
perform image separation, such as Adobe Photoshop.

When images are printed with flexography, the discontinuous color
response may produce undesirable artifacts. For example, any
separation with highlight tints that vary down to 0 percent will produce
shade stepping equal to the magnitude of the Mindot color. The larger
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the flexo discontinuity, the more severe the artifacts generated by
shade stepping.

It is common to use Adobe Photoshop (or another application that
performs image editing) to edit images to avoid these problems. You
can use the PCO profile in these applications to provide an accurate
preview of how the image will appear when printed with flexographic
printing.

See also:
Prinergy workflows on page 181

Previewing images with the PCO profile in Adobe Photoshop
You can use the PCO profile from ColorFlow software to preview
images in preparation for flexographic printing.

1. Export the PCO profile from ColorFlow software.

2. In Adobe Photoshop:

a. Select Edit > Color Settings.

b. Select Working Spaces - CMYK: Load CMYK.

c. Browse to the exported PCO profile, and select it.

See also:
Exporting a device profile on page 125

DeviceLink restrictions for discontinuous color
responses

ColorFlow software cannot generate or adjust a DeviceLink if the
destination color response is discontinuous. It applies these
restrictions to flexographic printing setup:

● You cannot use the Ink Optimizing Input in a color setup whose
PCO is discontinuous.

● You cannot select the ColorFlow software-generated Conversion
DeviceLink method for CMYK color inputs. You can import a
DeviceLink, but you cannot adjust it.

● You cannot define a simulation DeviceLink for a PCO that uses a
discontinuous device condition.

● If you define a PCO with a continuous, curve-controlled device
condition, a discontinuous target, and any simulation DeviceLink,
ColorFlow software will use Curves Method: Manual Adjustments
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Only. The simulation curves are linear, and the simulation
DeviceLink performs the target simulation.

● If the PCO is discontinuous and you define an SCO with a
continuous, curve-controlled device condition and any conversion
DeviceLink, ColorFlow software will use Curves Method: Manual
Adjustments Only. The conversion curves are linear, and the
conversion DeviceLink performs the conversion from the PCO color
response to the SCO device condition.

If the flexographic device condition uses a hybrid screening system
that delivers a smooth, continuous color response from the substrate
color through the highlights of all inks, then the flexo discontinuity is
eliminated. In this situation, set the Mindot Tint In value to zero. The
flexo device condition behavior in ColorFlow software will be similar to
that of other device types, and the discontinuity-related restrictions
will be eliminated.
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18 Prinergy workflows

How a Prinergy job uses color setups
A color setup name and snapshot number is embedded at a page (1-up)
level during the refine process of a Prinergy job.

After pages for a job have been refined, if you want to change the color
setup or a color control element that the job uses, you must refine the
job's input files again so that the new color setup and/or snapshot
number is embedded its pages.

It is best practice not to modify a color setup to adjust the color of a
single job. If, for example, you need to adjust the simulation method for
a single job, you can duplicate the color setup, make your simulation
adjustment in the second color setup, and use the second color setup
for the Prinergy job.

Prinergy and snapshots
Prinergy can only access ColorFlow color control elements that have
been captured in a snapshot.

About snapshots
A ColorFlow snapshot captures the state of the entire colorstore,
making its elements available to the Prinergy workflow.

The snapshots feature makes it unnecessary for you to manually save
and name multiple versions of individual color control elements after
creating and adjusting them. When you capture a snapshot, the current
state of all color control elements in all color setups are captured and
made available in Prinergy. At any time, you can roll back (revert) to the
state of a previous snapshot. When you revert to a previous snapshot,
all color setups are restored to their state at the time the previous
snapshot was captured. Any color control elements and color setups
that you created after the snapshot that you revert to are deleted.

Important: Since snapshots capture the entire colorstore instead of individual color
setups, when you approve or revert a snapshot, multiple color setups may be
affected.

You specify a snapshot number in the refine process template or the
output process template in Prinergy. By default, the Approved snapshot



is used for all Prinergy jobs. If you are creating a Prinergy job for testing
or for setting up the color on a device for the first time, you may want
to select a snapshot that you captured after the Approved snapshot in
order to test the output. During testing, it is best practice to capture a
snapshot after each change you make in order to easily identify the
result of your changes.

When you are satisfied with the color control elements in all color
setups, you can capture a snapshot and approve it. Only one snapshot
can be in the Approved state at any time. When you approve a
snapshot, any snapshots taken before the snapshot that you approve
are deleted.

Taking a snapshot
You can capture a snapshot of all color control elements in all color
setups at this moment.

Requirements: You must apply all the adjustments that you want to
include in a snapshot before you can take the snapshot. You cannot
take a snapshot when calculations are pending or in progress.

1. Select View > Snapshots.

2. Click Capture.
The snapshot appears in a new row in the table. The table lists a
sequential ID and the date and time when the snapshot was
captured.

3. To add a note about a snapshot, double-click in the Notes column
of the snapshot.

The ColorFlow elements that you captured in the snapshot are now
available to the Prinergy workflow.

Next: To set the elements in this snapshot to be the default elements in
the Prinergy workflow, you must approve it.

See also:
Approving a snapshot on page 183

Reverting to an earlier snapshot
You can restore all color setups to their conditions as they were at the
time of a previous snapshot.

Important: When you revert to a previous snapshot, any color control elements
and color setups that you created since the previous snapshot are permanently
deleted.
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1. Select View > Snapshots.

2. In the table, select the snapshot to which you want to revert.

3. Click Revert.

All ColorFlow elements are restored to their state when this snapshot
was taken. Snapshots that were taken after this snapshot are deleted.

Approving a snapshot
You can set elements in a particular snapshot to be the default set of
elements that are used in the Prinergy workflow.

1. Select View > Snapshots.

2. In the table, select the snapshot that you want to approve.

3. Click Approve.
This snapshot becomes the approved snapshot, and any snapshots
taken before this snapshot are deleted.

How Prinergy uses ColorFlow elements
A color setup must be defined in the job attributes of a Prinergy job in
order for ColorFlow-generated elements to be applied correctly in job
processing.

In Prinergy Connect and Prinergy Powerpack, you can set job attributes
when you create a job, or afterwards, from the Edit menu of Prinergy
Job Manager. After you assign a color setup to a Prinergy job, the
ColorFlow server provides all of the necessary color control elements
for the job. If you need to change the color setup of a job from the color
setup that is assigned in the job attributes during the refine stage, you
can select a new color setup in the refine process template.

In Prinergy Evo, you associate color setup information with process
templates based on your output intent.

The following table lists elements and settings that ColorFlow can
provide to Prinergy.

Element Where defined in
ColorFlow

Where used in Prinergy Without ColorFlow,
Prinergy would define
the item in

Color Input (CI) to
primary color output
(PCO) DeviceLink

Conversion link between
the device condition of
the CI and the PCO 

Refine to PCO color space
(Images and Graphics) of
CMYK defined objects*

the refine process
template, in the CMYK
Images and CMYK
Graphics fields
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Element Where defined in
ColorFlow

Where used in Prinergy Without ColorFlow,
Prinergy would define
the item in

CI ICC device profiles
(source profiles)

Device condition of the CI Refine to PCO color space
(Images and Graphics) of
CIELAB objects

the refine process
template, in the CMYK
Images and CMYK
Graphics fields

PCO simulation
DeviceLink

Simulation Definition
dialog box 

During output to the PCO
device condition—links
the color response of the
PCO device to the color
response of the
simulation target

PCO ICC device profile Simulation of the PCO During output to the PCO
device condition—
converts CIELAB content
to CMYK

an output process
template, as either a
source profile or a
destination profile

PCO to SCO DeviceLink Conversion link between
the PCO and the device
condition of the SCO 

During output to an SCO
device condition

SCO ICC device profiles Device condition of the
SCO 

During output to an SCO
device condition—
converts CIELAB content
to CMYK

an output process
template, as either a
source profile or a
destination profile

Calibration curves Generated within a PCO
(Simulation Definition
dialog box) or from PCO
to SCO (Conversion -
Definition dialog box)

Dynamically served on
output based on the
device condition selected
in the output process
template

an output process
template, in the Print
Curve (Calibration) list in
the Calibration &
Screening section. The
curve would have been
generated in Harmony or
another curve generation
program.

Plate curves Plate Setups dialog box In the ColorFlow section
of the output process
template, you can select a
plate line from the plate
setup that is used for the
device condition.

*ColorFlow software 1.0 cannot generate elements to handle RGB
input. At this time, if you want to convert RGB content, you must do so
in a non-ColorFlow-enabled refine process template.
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ColorFlow variable marks in Prinergy
The following ColorFlow-related variable marks are available in
Prinergy.

Information Variable mark

Color setup name $[ColorSetupName]

Snapshot number $[SnapshotNumber]

Device condition name $[DeviceConditionName]

Plate line name $[PlateLineName]

Device name $[DeviceName]

For more information about variable marks, see the Prinergy Workshop
User Guide.

Using ColorFlow software
ColorFlow software is integrated with Prinergy Evo.

ColorFlow software delivers color relationship management that
unifies color control elements—such as ICC profiles, DeviceLink
profiles, and calibration curves—and manages the relationships
between color control elements and device print conditions.
Specifically, ColorFlow simplifies the process of setting up color and
ensuring that Prinergy work is processed using the correct color
settings. Specifically, ColorFlow simplifies the process of setting up
color and ensuring that Prinergy jobs are processed using the correct
color settings.

Getting started with ColorFlow

Complete these steps, in this
order

Notes

Install ColorFlow software on client
computers.

Prinergy Evo uses a client-server system, meaning that there can be many
client computers connected to and running from one server.

As part of Prinergy, ColorFlow Workflow Edition software and colorstore
database are automatically installed on the PrinergyPrinergy Evo server.
The ColorFlow server runs as a process on the Prinergy primary server.

You must install the ColorFlow software on one or more client computers
that connect to a Prinergy server.

Note: Only one user can modify the colorstore database at one time.
Therefore, only one ColorFlow client computer can be running at a time.

For instructions on installing the ColorFlow software on client computers,
see the ColorFlow User Guide.
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Complete these steps, in this
order

Notes

Consider if you will import
Harmony tonal calibration curves.

Decide whether you'll use the ColorFlow software to create and manage
color control elements, or import existing Harmony tonal calibration
software curves. If you use Harmony, you can delay using some
capabilities of ColorFlow until you have time to print and measure charts
with your device conditions.

Note: When using ColorFlow with Prinergy, we recommend building new
curves rather than importing existing Harmony tonal calibration curves.

For more information about importing Harmony curves, see chapter 11 of
the ColorFlow User Guide.

Configure ColorFlow. a. Create a color setup. A color setup is the virtual structure that you
build to define the color relationships among the devices in your
printing task. It includes devices, device conditions, a simulation
target, and color control elements, such as DeviceLink profiles and
curves.
A color setup manages how its device conditions simulate the primary
color output (PCO). If you edit the color response of a device
condition, ColorFlow ensures that related color control elements in the
color setup are updated to reflect the edit.

b. Add device conditions. A device condition is the combination of a
device and the operating conditions in which the device captures or
produces an image. It has a measurable color response.
A device condition can include more than one device. If it does, all
devices must have the same device type and must use the same
consumables and operational settings. The devices must be able to be
calibrated to yield a similar color response. Note that this applies to
curve-controlled devices only.

For more information about configuring ColorFlow, see chapters 3, 4, and
5 of the ColorFlow User Guide.

Measure or import the color
response of your device.

Perform either of the following actions:

● Create and measure a ColorFlow characterization chart.

● Import an existing measurement set.

The attributes of the chart must be suited to the inks you are using on the
output device, your measuring device, and the size of your press.

For more information about measuring color response, see chapter 6 of
the ColorFlow User Guide.
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Complete these steps, in this
order

Notes

Define simulation and conversion
settings.

Use the Simulation Definition dialog box in ColorFlow to control how a
primary color output (PCO) simulates the color target. ColorFlow can
perform the simulation using tonal curves or DeviceLinks or a
combination.

a. In the Target list, select the color response whose colors the PCO will
attempt to simulate. Often this will be an industry reference.

b. Using the Curves slider (for offset presses and halftone proofers only),
select how you want to use tonal curves. For an explanation of each
option, see chapter 11 of the ColorFlow User Guide.

c. Using the DeviceLink Method selector, select how you want to use
DeviceLinks. For some types of devices, not all values are available.
Because the DeviceLink is used in the context of a simulation, the
DeviceLink source is the color space selected in the Target list; the
destination is the device condition inside the PCO. For an explanation
of each option, see chapter 13 of the ColorFlow User Guide.

For more information about simulation and conversion, and the options in
the Simulation Definition dialog box, see the ColorFlow User Guide.

Using ColorFlow in Prinergy

After you configure the ColorFlow software, you must select the
Enable ColorFlow check box in the Match Colors section of the refine
to PDF and output process templates.

After you have configured the ColorFlow software, you can use the
ColorFlow settings in the refine, loose 1-up artwork output, layout
output, and final output process templates to apply color control
elements during processing.

In the refine process template, you select a color setup. The available
color setups are in the ColorFlow colorstore database on the primary
server. When a page or artwork file is refined using the refine process
template, the color setup specified in the process template is assigned
to the page or file.

In each output process template, you select the Color Setup, Device,
Device Condition, Plate Setup, and Plate Line color control elements.
During output processing, the color setup assigned to each page or
artwork file (during refining) defines the specific color control elements
that are applied on output, unless you choose to override the color
setup tagged to the file during refining.

In addition, when you create a new job, you must enable ColorFlow in
the job and select a default color setup for the job. You do this in the
job's attributes. To successfully process job files with ColorFlow
enabled, you must configure the process templates to use ColorFlow
and enable ColorFlow in the job.
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When a job's pages or artwork are refined using a refine process
template in which you have enabled ColorFlow, the color setup that is
assigned depends on the ColorFlow settings in the refine process
template:

● If the refine process template indicates to use the default color
setup selected for the job, the job's color setup is assigned during
refining.

● If a color setup is specified in the refine process template, the
settings in the template override the default color setup selected for
the job, and the color setup specified in the refine process template
is assigned.

● If a color setup is specified in the refine process template but
ColorFlow is not enabled for the job, refining will fail. For a job to be
processed using ColorFlow, the job must be ColorFlow-enabled and
a default color setup must be selected for the job, even if the default
color setup is not assigned during refining.

In Job Manager, the Color Setup column in the Pages and 1-Up
Artwork pane indicate the color setup assigned to each page.

Note: If the refine process template is not ColorFlow-enabled, but the job has a
default color setup selected, what happens during refining depends on whether
the Match Colors option is selected in the process template. If Match Colors is not
selected, the job's default color setup is registered with the refined files, but no
color conversion is applied. If Match Colors is selected, refining will fail.

It is also possible to change a refine process template's ColorFlow
settings when you refine specific pages, to change the selected color
setup. It is also possible to change a refine process template's
ColorFlow settings when you refine specific artwork files, to change the
selected color setup. This is useful when you plan to print parts of a job
differently, such as on different presses or with different ink sets. For
example, for a book that consists of a cover and body pages, you might
want to print the cover CMYK but print the body pages in black only.

Note: After you run a job with ColorFlow enabled, you cannot rerun the job
without ColorFlow enabled, unless you re-create the job.

Setting the halftone output modes

You can select one of four modes for output to halftone devices or files,
in the output process template. These modes control the curves that
are applied upon output, corresponding to your output goals.

Print Production

Reflects the standard operation of Prinergy and ColorFlow for
production. When this option is selected, a print calibration curve
and a plate calibration curve are applied to each output
separation.
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Print Characterization

Is used to print and measure the response of a print device.
When this option is selected, a device curve and plate calibration
curve are applied to each output separation.

Plate Verification

Is used to verify the linear response of plates produced by a
particular plate line (consisting of the computer-to-plate device,
plate processor setup, and chemistry), with a selected
screening system. When this option is selected, only the plate
calibration curve is applied to input tints of all separations.

Plate Characterization

Supports imaging and measuring the uncalibrated (or intrinsic)
response of a plating line, such that a plate linearization curve
can be computed. When this option is selected, no calibration
curves are applied to input tints of any separations.

Applying ColorFlow curves and making curve adjustments

If a printing plate has imaged and run on press, but the press is not
printing with the desired response, you may need to recreate the plate
using a different ColorFlow curve channel for one or more separations.
You can also make curve adjustments to the assigned ColorFlow curve
channel. These adjustments, made on-the-fly from the Start Process
dialog box, are appended to the ColorFlow calibration curves and have
no effect on ColorFlow colorstores. This feature is only available in
Prinergy Connect.

ColorFlow and archiving

If you retrieve an archived job for which ColorFlow is enabled, the
ColorFlow server will request the name of the color setup and the
number of the Snapshot that was used to initially process files within
that job. If you have modified any of the elements within the color
setup from the initial time of output, these modified elements will be
used to output the archived job.

In addition, if the initial color setup was deleted or renamed, the job will
fail processing. If you want to change a color setup, duplicate the
original one and make changes to the duplicated and newly named
color setup. You can use the Allow undefined color setup or color
setup mismatch check box to output the archived job when the
selected color setup differs from the color setup assigned by the refine
process.

ColorStore database and backups

If you are running the Windows 2003 Server operating system on your
Prinergy primary server, the Microsoft Windows NT Backup utility
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automatically backs up your colorstore database. If you are running the
Windows 2008 Server operating system on your Prinergy primary
server, the System Configuration Backup Utility performs the backup
process of the colorstore database. If you are using Prinergy with Hot
Standby (Hot Standby combines the basic functionality of failover,
allowing a Prinergy secondary server or render station to take over
primary server functions if the primary server fails), the colorstore
database is also automatically backed up.

Issues to consider when using ColorFlow

● Sharing ColorFlow-enabled work between plants or servers is not
possible unless you change the Prinergy Job Color Setup defaults to
an available color setup, and you select the Allow color setup
mismatch check box in the output process template. Note that your
output could be significantly different.

● If you refine a file with ColorFlow selected, ensure that you select
Match Colors and Enable ColorFlow if you refine the file again. If
you refine a file with ColorFlow selected, ensure that you select
ColorConvert and Enable ColorFlow if you refine the file again.
Otherwise, an error message appears.

● If you want to change the tagged color setup of a PDF file that has
been refined, you must refine the PDF file again with a new color
setup specified in the process template.

● You may encounter a situation in which you have two objects with
the same CMYK input in a single PDF file. One object is tagged with
an ICC-based CMYK profile; the other object is untagged using
Device CMYK. Conversion of the ICC-based CMYK content will
happen via embedded profiles for one object. In contrast, the
untagged content will be converted via a DeviceLink from
ColorFlow, if a DeviceLink is present in the selected color setup. To
avoid complication, override the embedded profile in the refine to
PDF process template, which will ensure that all content is managed
via DeviceLink. To avoid complication, override the embedded
profile in the refine process template, which will ensure that all
content is managed via DeviceLink.

● If you refine a file with the Prinergy Bypass Refine feature, ensure
you refine the file again to tag a color setup in the PDF file.

● When using ColorFlow, you can assign one color setup per page in
the refine to PDF process template. When using the output from the
imposition process template with ColorFlow, you can output an
imposition file that has different color setups for each page. When
using ColorFlow, you can assign one color setup per page in the
refine process template. When using the imposition output process
template with ColorFlow, you can output an imposition file that has
different color setups for each page. When outputting in this
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situation, ensure that you select a device condition that is contained
in all of the color setups assigned to all pages.

More information about ColorFlow and Prinergy
integration

ColorFlow software, version 2.0 , is integrated with Prinergy Evo 6.0.
ColorFlow software, version 2.0 , supports RGB devices and RGB color
inputs, as well as CMYK devices and CMYK color inputs. You can
select default CMYK or RGB source color spaces, and ColorFlow can
provide CMYK and RGB device profiles in the Process Template Editor.

Background

● An ICC profile is a color space description that acts as a standard
for accurate reproduction of colors across different platforms,
devices, and applications, according to the standards of the
International Color Consortium (ICC). For example—an ICC profile
that describes a specific RGB device, such as a Kodak EasyShare
camera, provides a mapping of the camera's red, green, and blue
color space to device-independent L*a*b* coordinates (or CIE
L*a*b* color space).

● A PDF file is composed of many objects, and each object may have
come from a different source—for example, an RGB image captured
from a digital scanner or digital camera, CMYK graphics from 
Adobe Illustrator, and so on. Each of these objects may be tagged
with an ICC profile.

Prinergy refine process template setup

You can set up color conversion with or without ColorFlow.

● When you are setting up a refine process template without
ColorFlow, the ColorConvert section allows you to select ICC
profiles for color converting RGB and CMYK images and graphics.
When you are setting up a refine to PDF process template without
ColorFlow, the Match Colors section allows you to select ICC
profiles for color converting RGB and CMYK images and graphics.
These ICC profiles are only used by the Color Matcher JTP when an
object in the PDF file is not tagged with an ICC profile. In the case of
tagged PDF content, the ICC profile settings in the process template
are ignored by the Color Matcher JTP, and the tagged profile is
used.
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Note: You can also use a DeviceLink profile that includes both the source and
the destination ICC profiles. Note also that the tagged profile can be ignored if
Strip Embededded Profile is enabled.

● In a ColorFlow-integrated environment, the color conversion that
takes place is to the primary color output (PCO) profile. In Prinergy,
a ColorFlow device condition is a named instance of a CMYK device
color response with an ICC device profile. For example, FOGRA 39
is a built-in device condition for which ColorFlow can provide a
CMYK device profile to Prinergy.

The following table summarizes how to configure the two options:

For this option Do this

To use ColorFlow device conditions
for color conversion

a. In the ColorConvert Match Colors section of the refine to PDF process
template, in the Match Colors section, select the Enable ColorFlow
check box.

b. From the Snapshot list, select the desired snapshot from ColorFlow.

c. From the Color Setup list, select the ColorFlow color setup from those
available in the selected snapshot.

d. Select each image type for which you want to enable ColorFlow color
conversion, by selecting the relevant check boxes—CMYK Images,
CMYK Graphics, RGB Images and RGB Graphics.

e. From the lists next to the image type check boxes, select a ColorFlow
device condition.

The device conditions are the conditions that have been configured in
ColorFlow, which then supplies the DeviceLinks or profiles for the
CMYK‑to‑CMYK or RGB‑to‑CMYK conversion.

To use ICC profiles or DeviceLink
profiles for color conversion

a. In the ColorConvert Match Colors section of the refine to PDF process
template, clear the Enable ColorFlow check box.

b. Select each image type for which you want to enable color conversion,
by selecting the relevant check boxes—CMYK Images, CMYK
Graphics, RGB Images and RGB Graphics.

c. From the lists next to the image type check boxes, select the relevant
ICC profile or DeviceLink profile.

If an object in the input file does not have an embedded profile, the ICC
profile selected for that object type is applied.
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19 Reporting

ColorFlow reports
You can use ColorFlow reports to analyze a device in a device condition,
compare a device to a target, or provide information for troubleshooting
potential problems.

ColorFlow produces two types of reports:

● Print Characterization reports present information about a device
that is based on measurement data.

● Print Comparison reports illustrate the differences between a device
and a selected target.

Reports are generated from the Measurements tab of the
Measurements dialog box by choosing the relevant measurement files
for the selected device.

About Print Characterization reports

Print Characterization reports provide information about a device in a
device condition, in its uncalibrated state. Print Characterization reports
contain information on the key metrics of a print condition when no
calibration is applied, even if a calibration curve was used to output
measurement data. Print Characterization reports also show the effect
of a calibration curve on curve-controlled devices.

Print Characterization reports are useful for documenting the state of a
device in a device condition for future reference or for determining if a
device is in an optimum state.

About Comparison reports

Comparison reports document the results of a calibration versus a
target measurement data set or an ISO TVI curve. You can also use a
Comparison report to compare a device to an existing device condition,
or to another device. ColorFlow provides reference data sets from
industry specifications including FOGRA, GRACoL, SWOP, IFRA, and
PSR Gravure. ColorFlow also provides the data for the eight ISO
12647-2 Curves for TVI comparisons.

When comparing a calibration to an ISO TVI curve, you can use a single
ISO TVI curve for CMYK, or use one ISO TVI curve for CMY and the
next, higher ISO TVI curve for black (K). For example, in the Compare
to list, if you select ISO TVI Curve A, ISO TVI Curve A is used for CMY



and K. If you select ISO TVI Curve A and B, ISO TVI Curve A is used for
CMY and ISO TVI Curve B is used for K.

Comparison reports are useful for identifying problem color builds, or
for determining the accuracy of a color reproduction. You can also use
Comparison reports to analyze new stocks, inks or other variables.

Generating a Print Characterization report
You can create a Print Characterization report to see detailed
information about the state of a device in a device condition.

1. In a device condition in the color setup viewer, next to the device
name, click the Measurements icon .

2. In the Measurements dialog box, click the Measurements tab.

3. In the Active Measurement area, select a measurement set or an
individual sheet.
To select multiple sheets, use Ctrl+click.

4. Click Report.

5. In the Print Report dialog box, clear the Compare to check box.

6. Specify the following information:

Customer Name

Appears on the cover of the report

Workflow and Version

Appears on the configuration page of the report

Inks

Appears on the configuration page of the report

Process Ink Sequence

Select the correct ink sequence. This is significant for
measuring trap on overprint and appears on the
configuration page of the report.

Ink Color Target

Appears on the configuration page of the report

User Comments

Appears on the front cover and the footer of every page.
Although the entire text appears on the configuration page,
only a line appears in the footer.

Notes

Appears on the configuration page of the report
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7. Click Save, and browse to the location where you want to save the
report file.
The report is generated as a PDF file.

Generating a Print Comparison report
You can create a Print Comparison report to see the difference
between a device and a target.

1. In a device condition in the color setup viewer, next to the device
name, click the Measurements icon .

2. In the Measurements dialog box, click the Measurements tab.

3. In the Active Measurement area, select a measurement set or an
individual sheet.
To select multiple sheets, use Ctrl+click.

4. Click Report.

5. In the Print Report dialog box, select the Compare to check box.

6. Perform one of the following actions:

○ To compare to another device, select Other Device, and select
the device in the list.

○ To compare to a device condition or an industry specification,
select Device Condition, and select the device condition or
industry specification in the list.

7. Specify the following information:

Customer Name

Appears on the cover of the report

Workflow and Version

Appears on the configuration page of the report

Inks

Appears on the configuration page of the report

Process Ink Sequence

Select the correct ink sequence. This is significant for
measuring trap on overprint and appears on the
configuration page of the report.

Ink Color Target

Appears on the configuration page of the report
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User Comments

Appears on the front cover and the footer of every page.
Although the entire text appears on the configuration page,
only a line appears in the footer.

Notes

Appears on the configuration page of the report

8. Click Save, and browse to the location where you want to save the
report file.
The report is generated as a PDF file.

Elements of a report
A report generated by ColorFlow contains several sections:

● Configuration

● Density of solid inks

● Tonality

● Color

● Measured values

Configuration

General

Measurement File

ColorFlow activated

ColorFlow software version

ColorFlow activated

Workflow and Version

User defined

Device Condition

ColorFlow activated

Target Device Condition

ColorFlow activated. Only applicable for the comparison
reports.
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Device Condition

Process Ink Sequence

User defined. The correct Process Ink Sequence must
be selected to calculate the Apparent Trap values in
Section 2.

Ink Color Target

User defined

Inks

User defined

Target Device

Identifies another device used for comparison. Only
applicable for the Comparison reports.

Print Device

ColorFlow activated, identifies the device

Substrate

ColorFlow activated, identifies the device condition

Screening

ColorFlow activated, identifies the device condition

Notes

Notes

User defined. Notes can be used to record special
variables.

Density of solid inks

Average Density

ColorFlow reports the minimum, maximum, and average
density of a colorant to validate the print output.

Apparent Traps

Calculates the ability of a colorant to overprint on top of
another colorant.

Density Across the Form

Charts solid density across the form.
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Tonality

Tonal Value Increase

Charts the TVI or dot gain response of a device, in Print
Characterization Reports, the TVI graphs are also displayed to
show the natural response of the device without any curve
applied. Comparison Reports graph the TVI in relation to the
TVI response of the target data set, if the data set contains
spectral or density data.

Tonal Value Increase, 40% and 50% tints

Displays the TVI of the 40% and 50% tints.

Print Contrast

75% tint compared to the solid patch for the measured data
and with the curve removed (if applicable).

Color

Spider Plot of Primary and Overprint Ramps

a*b* values plotted for primaries and secondaries to represent
the hue and saturation levels of the process colors and 2 color
overprints.

Measured Solid and Overprint Colors

Shows the CIELAB values of primaries and selected color builds.

Color Difference Distribution and Cumulative Frequency

Contains the dE distribution of a standard color characterization
chart and the cumulative frequency of ΔE values.

Grays

Plot of the a* and b* values of the calculated gray balance.

Gray Balance, Complete tonal range

Gray balance L*, a*, and b*, plotted across the entire tonal
range.

Gamut

Color gamut boundaries plotted for a*, b*.

Measured Values

Effective Dot Area

Effective Dot Area (EDA) values in 5% increments.
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Density of Black and Gray Balance

Density chart for black and 3 color gray balance across the tonal
range.
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20History and undo

About history
ColorFlow maintains a history of the profile adjustments that you have
applied, and the adjustments that you have made but not yet applied.

In the History window, you can view a list of all the adjustments that
were made to a particular color control element. This list is useful when
you are undoing actions for the color control element.

The History window shows the entire history of profiles, including
definition, regeneration, and adjustment events. A separate history list
is kept for each adjustable element in each color setup and device
condition.

For device profile editing, individual adjustment histories are
maintained for each adjustable tag.

For curve-controlled device conditions, individual histories are
maintained for each spot ink curve. This applies to the device curve and
simulation/conversion curves in each color setup that uses the device
condition for a color output.

For the PCO of a color setup, the entire history of the simulation is
recorded in a single list that includes the simulation definition, curves
adjustments, DeviceLink adjustments, and regeneration of the
simulation.

Similarly, the entire history of each SCO conversion is recorded in a
single list that includes definition, conversion curves, DeviceLink
adjustments, and regeneration.

When you make an adjustment to a color control element, each
adjustment detail appears in the Unapplied section in the History
window. These details include edit point selection, range selection,
color changes, tint changes, and other settings, depending on the color
control element and adjustment mode. When you click Apply in the
adjustment dialog box, the unapplied adjustment details are combined
into a single adjustment event, and are listed in the <element type>
Adjustment on <date and time> section of history.

If you close the adjustment dialog box before you apply your
adjustments, the adjustments are discarded, and disappear from the
history list. Any adjustments that you have applied remain in the history
list even after you restart ColorFlow.



You can use the Undo and Redo menu item on the Edit menu to undo
or redo any adjustments that are displayed in the history list.

With unapplied adjustments, you can undo or redo each individual
adjustment details. With applied adjustments, you can undo or redo
each adjustment event recorded in the history.

You can use Undo and Redo when the History window is open or
closed.

Undo can be performed for all adjustments to a color control element,
back to the latest definition of regeneration of the object. The only
exception is when Commit All Adjustments has been executed.

Execution of Commit All Adjustments is recorded in the history of all
color control elements as Commit Adjustments on <date>. Undo
cannot be performed for any adjustment events prior to this record.

Commit All Adjustments can be executed only after a snapshot
capture. If you revert to the snapshot prior to Commit Adjustments in
History, Commit Adjustments is removed, and Undo operations can be
performed.

You can open the History window from the View menu. To display the
history list of a particular color control element, the adjustment dialog
box for the color control element must be open and the element must
be selected. You can only display the History window for one color
control element at a time. The color control element that is currently
selected in the color setup viewer is the element whose adjustment
history is displayed in the History window.

See also:
About snapshots on page 181
Committing all adjustments on page 202

Committing all adjustments
You can commit all color adjustments after capturing a snapshot.

When you select this option, you are unable to undo adjustments. The
advantage of committing all the adjustments is that all the adjustment
controls are reset to show no adjustments, and the before and after
patches are now the same.

Note: This option is enabled only after you capture a snapshot.

1. From the Edit menu, select Commit All Adjustments.
The following message appears:
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This will disable Undo of all previous adjustments.
Continue?

2. Click Yes, to commit to the adjustments.

Viewing the history of a color control element
You can view a list of adjustments that have been made to a particular
color control element.

1. Open the Adjustment dialog box for a simulation, conversion,
device profile, or device curves.

2. Open the History dialog box.
Select View > History.

3. Expand the History section.

4. Perform one of the following actions:

○ To view adjustments that were made at one time, expand the
appropriate Adjustments to <element type> on <date> section.

○ To view recent adjustments that have not yet been committed,
expand the Uncommitted section.

A list of adjustments appears under the expanded section.

Undoing previous adjustments
You can undo any adjustments that you previously made to a curve or
a DeviceLink.

When you make an adjustment to a simulation, a conversion, or a
curve, you can undo individual changes until you click Apply. After you
click Apply, you can only undo a group of adjustments. You can use the
History dialog box to view details on a list of the previous adjustments.

1. Open the Adjustment dialog box for a simulation, conversion, or a
curve.

2. (Optional) Click View > History to open the History dialog box and
view details about previous adjustments.

3. Click the Edit menu, note the adjustment that appears next to the
Undo menu item.
This is the adjustment that will be undone.

4. Click Undo to undo the adjustment.
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21 Optimizing ink usage

About the Ink Optimizing Solution
The Ink Optimizing Solution is a licensed feature.

If your license includes the Ink Optimizing Solution, in the Licensing
dialog box, in the Features list, Ink Optimizing Solution displays the
expiration date.

Using the Ink Optimizing Solution, you can generate DeviceLinks or ICC
DeviceLinks that use black strength to reseparate images and replace
chromatic colors with black while limiting total ink coverage (TIC).
Because the process of gray component replacement uses a non-
chromatic color (black) throughout the tonal range, it reduces the
amount of C, M, and Y inks used in the midtones and quartertones. This
allows for increased savings in ink consumption and for improved color
stability.

With ColorFlow, you can set the Total Ink Limit for fully constrained
DeviceLinks. If you want to create a fully constrained DeviceLink, with
TAC limiting with no optimization, you can set the Total Ink Limit for
this type of DeviceLink.

Figure 1: Ink-optimized separation

For more information about gray component replacement, see Reducing
Ink Consumption on Press: Using GCR or UCR Separations and Re-
separations for Offset Printing White Paper.



Ink Optimizing Input device
When the Ink Optimizing Solution feature is licensed, an Ink
Optimizing Input device appears in the Devices dialog box.

The Ink Optimizing Input device can only be used as a color input.
When you drag Ink Optimizing Input to the color-input position of a
color setup, it automatically becomes Ink Optimizing Device
Condition.

See also:
Ink Optimizing Device Condition on page 206

Ink Optimizing Device Condition
The Ink Optimizing Device Condition is automatically defined when
you drag the Ink Optimizing Input device to a color setup.

The color response of the Ink Optimizing Device Condition is a copy of
the primary color output (PCO) color response. By adding an Ink
Optimizing Device Condition to a color setup, you can define a device
link between the Ink Optimizing Input device and the PCO. This allows
you to optimize ink usage when you refine input files without changing
the color space of the input files.

Optimizing ink usage

Optimizing ink usage on refine
You can create a color setup to reseparate input files during the refine
process and to optimize ink usage.

1. Add a new color setup.

2. In the Devices dialog box, drag the device for which you want to
optimize ink usage to the color setup viewer as the PCO.

3. Define the PCO device condition.

4. In the Devices dialog box, drag the Ink Optimizing Input device to
the color setup viewer as the color input (CI).
The device automatically becomes a device condition called Ink
Optimizing Device Condition.

5. Define a CI to PCO ICC DeviceLink.
Perform the following actions on the Image tab and on the Graphic
tab. To use the same settings for text or linework that you use for
pictures, on the Graphic tab, select the Graphic Conversion Same
as Image Conversion check box.
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a. In the Total Ink Limit box, type a value.
A lower value results in less ink consumption.

b. In the Black Strength box, type a value.
A higher value results in additional replacement of CMY with
black—that is, more chromatic ink is replaced with black.

During the refine process in the Prinergy workflow, the Ink Optimizing
DeviceLink is applied to input files to produce ink savings but no color
space mapping occurs.

Next:

You can verify your ink savings by using the Prinergy Virtual Proofing
System (VPS).

Optimizing ink usage with color conversion on refine
You can create a color setup to reseparate input files during the refine
process to optimize ink usage and to convert files from their source
color space to the PCO color space.

Proof refined files to verify ink savings before outputting the files to
plate.
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1. Add a new color setup.

2. In the Devices dialog box, drag the device for which you want to
optimize ink usage to the color setup viewer as the PCO.

3. Define the PCO device condition.

4. In the Devices dialog box, drag the CMYK Reference device to the
color setup viewer as the CI.

5. Define the CI device condition.

6. Define a CI to PCO DeviceLink.
Perform the following actions on the Image tab and on the Graphic
tab. To use the same settings for text or linework that you use for
pictures, on the Graphic tab, select the Graphic Conversion Same
as Image Conversion check box.

a. From the DeviceLink Method drop-down list, select Ink
Optimizing Solution.
This enables you to select the maximum black strength.

b. In the Total Ink Limit box, type a value.
A lower value results in less ink consumption.

c. In the Black Strength box, type a value.
A higher value results in additional replacement of CMY with
black—that is, more chromatic ink is replaced with black.

During the refine process in the Prinergy workflow, the Ink Optimizing
DeviceLink is applied to the input files to produce ink savings, and input
files are converted to the color space of the PCO. Because color
mapping occurs in this case, some color shift may occur.
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Next:

You can verify your ink savings by using the Prinergy Virtual Proofing
System (VPS).

Optimizing ink usage on output
You can create a color setup to optimize ink usage on output.

1. Create a new color setup and define the device conditions in the
color setup.

2. Specify the required simulation and/or conversion curves.

3. To optimize ink usage when the PCO aligns with its simulation
target or when the secondary color output (SCO) aligns with the
PCO, perform the following actions when you define the simulation
or conversion device link.

a. In the DeviceLink Method drop-down list, select Ink Optimizing
Solution.
This enables you to select the maximum black strength.

b. In the Total Ink Limit box, type a value.
A lower value results in less ink consumption.

c. In the Black Strength box, type a value.
A higher value results in additional replacement of CMY with
black—that is, more chromatic ink is replaced with black.

During the output process in the Prinergy workflow, the Ink Optimizing
DeviceLink is applied to files to produce ink savings but no color
conversion occurs. The following screen capture is an example of what
appears when the PCO aligns with its simulation target.

Next:

You can verify your ink savings by using the Prinergy Virtual Proofing
System (VPS).
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Optimizing ink usage with color conversion on output
You can create a color setup to optimize ink usage on output, and to
perform color space remapping on output.

1. Create a new color setup and define the device conditions in the
color setup.

2. Specify the required simulation and/or conversion curves.

3. To optimize ink usage when the PCO aligns with its simulation
target or when SCO aligns with the PCO, perform the following
actions when you define the simulation or conversion device link.

a. From the DeviceLink Method drop-down list, select Ink
Optimizing Solution.
This enables you to select the maximum black strength.

b. For a PCO, select the Target Simulation check box to enable
color mapping on output, or for an SCO, select the Color Space
Conversion check box.

c. In the Total Ink Limit box, type a value.
A lower value results in less ink consumption.

d. In the Black Strength box, type a value.
A higher value results in additional replacement of CMY with
black—that is, more chromatic ink is replaced with black.

During the output process in the Prinergy workflow, the Ink Optimizing
DeviceLink is applied to files and color space mapping occurs.

210 Chapter 21—Optimizing ink usage



Next:

You can verify your ink savings by using the Prinergy Virtual Proofing
System (VPS).

Verifying your ink savings
After generating an ink-optimized file in Prinergy or Prinergy Evo, you
can use the Prinergy Virtual Proofing System (VPS) to determine the
amount of ink that will be required for the press sheet and to compare
the results with previous values.

1. In Prinergy Virtual Proofing System, add the VPS separations to the
Ink Coverage tool.
For more information, see the Prinergy Virtual Proofing System User
Guide.

2. To determine your ink usage savings, compare the ink coverage
value of the file with the ink coverage value of the same file before
the ink optimizing DeviceLink was applied.

Best practices for Ink Optimizing Solution

Rendering intent

Rendering intent is the mapping strategy used to convert color spaces.
In general, when creating ink-optimizing device links, when Target
Simulation or Color Space Conversion is selected, select Perceptual in
the Rendering Intent list. This is usually the best option when
converting between two gamuts of greatly differing volume—for
example, when converting from a larger gamut color input such as
“GRACoL C1 2006” to a smaller gamut CMYK Reference PCO such as
“SWOP C3."

When converting between two gamuts that are not different (such as
when the Target Simulation or Color Space Conversion check box is
cleared), when the Ink Optimizing Solution method is selected, select
Relative Colorimetric in the Rendering Intent list.

You can select from the following rendering intents:

● Perceptual

● Relative Colorimetric

● Saturation

● Absolute Colorimetric
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Total ink limit

Total ink limit (TIL) is a restriction on the maximum amount of ink
allowed at one time during four-color printing. For example, if you
allow 100% of all four inks to print at one time, it would be 400%
coverage.

The best practice is to use the default TIL values that are
recommended by the ColorFlow software, because these values are
aligned with what the device is capable of for a given print condition.
Test results show that if you decrease the TIL to values below normal
operating conditions, increased ink savings do not occur.

For this device condition Use this TIL range

Heated web offset press printing on
coated paper

280–300%

Newspaper web offset press printing
on uncoated paper

240%

Sheetfed offset press printing on
coated paper

320–350%

Black Start

You can set the Black Start to any value from 0 to 60 (default is set to
0). However, it is not recommended to set the Black Start value to
more than 30, preferably between 10 and 25, especially when defining
the black start point for a press.

Maximum Black

Maximum black is the highest amount of black that can be introduced
to a color build. Typical values for maximum black are between 90%
and 100%. However, because of the increased use of black in the ink-
optimized separation, you may want to set Maximum Black to 100%.

Black strength

Black strength sets the level of available black in a color build.

Lower levels of black strength retain a corresponding amount of CMY
in the color build. For an average printing condition, set the black
strength to a value between 75 and 85%. If your process is under tight
control, it is possible to use a black strength value higher than 85% and
achieve a greater ink savings.

To run high levels of black strength, black ink must be printed at the
density at which it was characterized. It is not uncommon to
characterize black at a density of 1.8 and print it at 2.0 or higher, for
work that contains images and text. With high levels of black strength,
printing a higher density than is characterized darkens images and
reduces chroma (also known as a “muddy” look). To avoid this,
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maintain process control so that the density and TVI values of the
production run match very closely with the density and TVI values of
the characterization run.

Target Simulation and Color Space Conversion check
boxes

Select these check boxes to change the output color to more closely
match the source space that is defined.

For this scenario Do this

You have defined an offset press with
printing characteristics that match the
device condition within a PCO and
have created gray-balanced curves to
simulate a target. You want to apply
ink savings to this condition on output
but not change the simulation color to
press.

Select the DeviceLink Method type as
Ink Optimizing Solution, and clear the
Target Simulation check box.

This device link does not change the
overall color and provides ink savings.

You have defined an offset press with
printing characteristics that match the
device condition within a PCO and
have created gray-balanced curves to
simulate a target. You want better
alignment to your source target—for
example, better blue sky.

Select the DeviceLink Method type as
Ink Optimizing Solution, and select
the Color Space Conversion check
box.

You have defined an offset press with
printing characteristics that match the
device condition within a PCO and
have created gray-balanced curves
and a device link. You would like to
take advantage of the Ink Optimization
feature.

Select the DeviceLink Method type as
Ink Optimizing Solution, and select
the Color Space Conversion check
box.

The same principle applies in the context of an SCO. However, with an
SCO, you are managing the conversion rather than the simulation.
Consequently, when you select the Color Space Conversion check box,
the source space is the color response of the PCO.
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Troubleshooting the Ink Optimizing Solution

Problem Solution

My presswork with Ink Optimizing
Solution doesn't look like it did before.

Perform one or more of the following
actions:

● Ensure that the current press
condition matches the initial
characterization used to create the
ink-optimizing device link. To
accomplish this in ColorFlow,
create a characterization report
and compare it to current readings
from the press run.

● Check for common press issues
(black unit issues).

● Confirm that the proofing setup
matches the press.

● Run Prinergy Virtual Proofing
System (VPS) separations as an
acceptance procedure to verify
that the ink-optimizing device link
did not change the color.

I cannot change the color on-press for
an Ink Optimizing Solution job.

Decrease the black strength, at the
expense of press stability and ink
savings.
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22 Reference

ColorFlow menus
The menu bar in the ColorFlow software includes these menus.

ColorFlow menu (Mac OS only)

About ColorFlow

Displays the ColorFlow splash screen, which has ColorFlow
software information, including the version number.

Preferences

Displays the Preferences dialog box where you can configure
your default settings of some system parameters.

Services

Standard Mac menu option unrelated to the ColorFlow software.

Hide ColorFlow

Standard Mac menu option to hide the ColorFlow software.

Hide Others

Standard Mac menu option to hide all other open software.

Show All

Standard Mac menu option to show all software.

Quit ColorFlow

Closes the ColorFlow software.

See also:
Preferences dialog box on page 260

File menu (Windows only)

Preferences

Displays the Preferences dialog box where you can configure
your default settings of some system parameters.



Exit

Closes the ColorFlow software.

See also:
Preferences dialog box on page 260

Edit menu

Undo

Applies only to device profile, DeviceLink, and curves
adjustments. All adjustments to these color control elements
are saved in history buffers, one for each object. Use the Undo
menu item to remove the effect of the last adjustment. You can
undo adjustments all the way back to the state of the element
when it was created, regenerated, or imported. Undo can be
applied either to an unapplied adjustment detail, such as a
range selection or color change, or to an applied adjustment
event. Adjustments are the only ColorFlow actions that are
saved and can be undone.

Redo

Applies only to device profile, DeviceLink, and curves
adjustments. Repeats the adjustment that was most recently
undone.

Commit All Adjustments

Updates the state of adjustments to all color control elements,
so that Color Change values are zero, Curve Change graphs are
zero, and Before, After (or Current, Corrected) patches have the
same visual color. The purpose is to facilitate visualization of
further incremental adjustments. The adjusted color control
elements are not affected.

This action can be performed only after a snapshot is captured,
and is recorded in the history of all color control elements.
Adjustments performed prior to the Commit action cannot be
undone, except by reverting the snapshot immediately prior to
the Commit action.

Duplicate Color Setup

Makes a copy of a selected color setup, and opens it in the
Color Setup Viewer. It is convenient to use this menu item to
start building a color setup that is similar to another color setup.

Cut

This standard Cut menu item does not cut ColorFlow elements.
It is useful only for text boxes in dialog boxes.
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Copy

This standard Copy menu item does not copy ColorFlow
elements. It is useful only for text boxes in dialog boxes.

Paste

This standard Paste menu item does not paste ColorFlow
elements. It is useful only for text boxes in dialog boxes.

See also:
History window on page 261

View menu

Devices

Displays the Devices dialog box, where you can create devices,
modify device names, and drag devices into a color setup.

Snapshots

Displays the Snapshots dialog box, where you can capture a
snapshot, approve a snapshot, or revert to the state of a
previous snapshot. ColorFlow keeps all the snapshots when you
Approve. You can select and delete any snapshot except the
approved snapshot.

Note: Retaining a large number of snapshots reduces performance in
ColorFlow and in Prinergy process template editor. It is a best practice to
delete old snapshots. Selecting a snapshot is the only way to delete it.

Device Conditions

Displays the Device Conditions dialog box, where you can add
or delete property values that are available for selection in a
particular property. You can also use it to delete a device
condition.

Plate Setups

Displays the Plate Setups dialog box, where you can create and
edit plate curves to make your platesetter output linear.

History

Displays the History window, where you can view a list of
DeviceLink and curves adjustments, both applied and not
applied.

Charts

Displays the Charts dialog box, where you can view the
properties of existing charts, create a new chart, or export a
chart as a PDF file. These charts are for imposition and printing
by the device on which you want to measure the color response.
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Hide/Show Sticky Notes

Hides or shows the virtual notes that can be attached to any
color setup.

Actual Size

Displays the preview image at 100% magnification.

Zoom To Fit

Fits the entire preview image in the current Image Preview
window.

Zoom In

Zooms the preview image in.

Zoom Out

Zooms the preview image out.

See also:
Devices dialog box on page 220
Device Conditions dialog box on page 224
Charts dialog box on page 229
Image Preview window on page 256
Plate Setups dialog box on page 259
History window on page 261

Export menu
The Export menu is used to export the color control elements, mainly
in a stand-alone environment.

In a Prinergy environment, the items on this menu are automatically
exported to the workflow; you do not need to select them for export
here. (Additional items, not offered here, are available for export in
their respective dialog boxes.)

The color setup that is currently displayed and the object that you
select in the Color Setup Viewer (the object turns blue) determine
which items appear on this menu. The following items can be included:

Device Curve

Available when you click a device in a device condition.

Calibration Curve

Available when you click the border of the PCO (primary color
output), or somewhere in the link to the SCO (secondary color
output).
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Measurement data

Available when you click a device in a device condition, or the
border of a device condition.

Device Profile

Available when you click the border of the PCO, or the border of
a device condition.

DeviceLink

Available when you click the border of the PCO, somewhere in
the link to the SCO, or somewhere in the link to the color input.

Window menu

Close Window

Closes the selected window.

<Names of open windows>

Click the name of any window to make it the displayed window.

Help menu (Mac OS only)

Search

Searches for topics in the ColorFlow menu bar or the Mac OS
help system.

ColorFlow Help

Displays the ColorFlow User Guide in the Eclipse help viewer.

View / Update License

Displays the Licensing dialog box so that you can view the
status of the license for your edition and options or connect to a
different Prinergy server.

See also:
Licensing dialog box on page 262

Help menu (Windows only)

ColorFlow Help

Displays the ColorFlow User Guide in the Eclipse help viewer.

About ColorFlow

Displays the ColorFlow splash screen, which has ColorFlow
software information, including the version number.
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View / Update License

Displays the Licensing dialog box so that you can view the
status of the license for your edition and options or connect to a
different Prinergy server.

See also:
Licensing dialog box on page 262

ColorFlow windows and dialog boxes
The ColorFlow software includes these windows and dialog boxes.

Devices dialog box
Use this dialog box to create a ColorFlow device to represent each
physical printing device in your plant. The dialog box is available from
View > Devices, or when you double-click the workspace surrounding
a color setup. The dialog box also appears when a new, empty color
setup opens.

Devices

(Images of physical devices and reference devices)

Each image represents a physical output device in your plant.
Drag these images into the Color Setup Viewer to create a
primary color output (PCO), a secondary color output (SCO), or
a color input (CI). In the Devices dialog box, double-click a
device to rename it.

A reference device image is available. You can use this device
to create a reference device condition.

If the Ink Optimizing Solution is licensed, the Ink Optimizing
Input device image is available. You can use this device to
create a color input that can be used to optimize ink usage.

Add Device

Device Name

Enter a name for a physical output device in your plant.

Device Type

Select the appropriate type for the device you are creating.

220 Chapter 22—Reference



Create

An image of the device with the specified name and type
appears in the Devices section. You can drag this image into a
color setup to create a device condition.

See also:
Devices on page 41

Device Condition Properties dialog box
Use this dialog box to set the properties of a device condition. To
display the dialog box, click the Properties icon  in a device condition
in the Color Setup Viewer.

Selection Properties

Type

The type of device that is the basis of this device condition. This
field is automatically populated with the type that you identified
in the device that you selected. A device condition can have
more than one device, but they must all be of the same type.

Description

This field is automatically populated from the properties that
you select in the properties section.

Inks

The number and colors of inks of the output device in this
device condition. This section is automatically populated.

Plate Setup

Enable the Plate setup check box to select a plate setup from
the list. The list is filtered to display plate setups for the chosen
device type. Click the edit icon  to display the Plate Setups
dialog box, where you can add or edit a plate setup.

Screening

Select the type of screening used in this device condition. You
can select the type of screening only if you did not select a plate
setup. If you need to add more values, click the edit button.

Resolution

Select the resolution used in this device condition (inkjet only).
If you need to add more values, click the edit button.
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Substrate

Select the type of paper or substrate used in this device
condition. The list is filtered based on the device type. If you
need to add more values, click the edit button.

Name

Select a built-in color response or type a name to distinguish
this from other device conditions that are based on the same
reference device (reference type only).

Other

Enter additional information that makes the device condition
distinct from similar device conditions. To add your own values,
click the edit button.

Other Properties

Values in this area never force the creation of a new device condition. If
a device condition matching the values in Selection Properties exists,
settings in this area will change it.

Spot inks

Enables you to designate the process ink channel from which
the workflow copies the calibration curve for each spot color.
The ink named "Default" will be used for unnamed spot inks.

Click the add button  to add any number of inks. Click under
Curve to assign one of the process channels. Click under Color
to choose a suitable color (for visual recognition only). Click
under Name to enter the name of the spot ink.

Separate Same As

For device conditions that are based on a reference device,
select a device type that has similar separation parameters.

OK

Every device condition must have a distinct combination of
values in the Selection Properties area. Depending on the
properties you select, ColorFlow either uses an existing device
condition, or creates a new one.

See also:
Device conditions on page 45

Screening Values dialog box
Use this dialog box to manage the values that can be selected in the
Screening property of a device condition. To display this dialog box,
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click the edit button  beside the Screening list in the Device
Condition Properties dialog box.

The list shows the screening types that can be selected in the
Screening property.

Use the add button  to add values to the list; use the delete button
 to remove values. You cannot remove a value that is used in an

existing device condition.

See also:
Device conditions on page 45

Substrate Values dialog box
Use this dialog box to manage the values that can be selected in the
Substrate property of a device condition. To display this dialog box,
click the edit button  beside the Substrate list in the Device
Condition Properties dialog box.

The list shows all of the paper and substrate types that can be selected
in the Substrate property of the device condition.

Use the add button  to add values to the list; use the delete button
 to remove values. You cannot remove a value that is used in an

existing device condition.

See also:
Device conditions on page 45

Resolution Values dialog box
Use this dialog box to manage the values that can be selected in the
Resolution property of an inkjet device condition. To display this dialog
box, click the edit button  beside the Resolution list in the Device
Condition Properties dialog box of an Inkjet device type.

The list shows the resolutions that can be selected in the Resolution
property of the device condition.

Use the add button  to add values to the list; use the delete button
 to remove values. You cannot remove a value that is used in an

existing device condition.

See also:
Device conditions on page 45

Other dialog box
Use this dialog box to manage the values that can be selected in the
Other property of a device condition. To display this dialog box, click
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the edit button  beside the Other list in the Device Condition
Properties dialog box.

The list shows the values that can be selected in this custom property
of a device condition.

Use the add button  to add values to the list; use the delete button
 to remove values. You cannot remove a value that is used in an

existing device condition.

See also:
Device conditions on page 45

Device Conditions dialog box
Use this dialog box to add or delete the values that are available for
selection in a particular property, or to delete a device condition. The
dialog box is available by selecting View > Device Conditions.

Device Types

Select a device type to view device conditions based on that
device type.

Device Conditions

Displays all of the device conditions that are based on the
selected device type. Select a device condition to see its
properties in the Device Condition Properties column. Position
the mouse over a device condition to see which color setups it
uses. Use the delete button  to delete the selected device
condition.

Device Condition Properties

Displays the properties of the device condition that is selected
in the Device Conditions column. Select a device condition
property to see its values in the Values column.

Values

Displays the possible values for the property that is selected in
the Device Condition Properties column. The actual value
currently assigned to that property appears in bold. (You
cannot change the assigned value from this dialog box; use the
Device Condition Properties dialog box.) Use the add button 
to add a value; use the delete button  to delete the selected
value. Changes you make to the Values list affect all device
types.

See also:
Device conditions on page 45
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Measurements dialog box: Charts tab
Use the Charts tab to select or create a form or forms that are ready
for imposition and printing by the device on which you want to
measure the color response. This dialog box is available by selecting
View > Charts, or clicking the Measurements icon  next to a device
in a device condition.

Charts

Displays a list of the existing charts for this device condition.
Select a chart to see an image of it, and details in the right
panel. Charts are named by their inkset and order of creation;
they cannot be renamed.

 (add)

Creates a new chart, using the panel on the right.

 (export)

Prompts for a location to store the chart as a PDF file that is
ready for imposition and printing.

 (delete)

Deletes the selected, previously saved chart.

(chart preview area)

Preview one of the forms that the chart includes. Each form is
numbered in the preview. To preview other forms, move your
pointer into the preview area, and click the arrows that appear.

Ink Set

Is determined by the properties of the device condition, and you
cannot change it.

Chart Type

Select one of three types of chart to create. The chart can
contain 1600 or more color patches, enough to calculate the
color response of the printing device, or it can contain only 14
tints for each of the process colors.

Color Characterization

Provides full tonal and colorimetric data.

Tonal Characterization

Provides tonal data only.
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Tint Ramp

Lets you type in the tint ramp values and create tone
value increase (TVI) curves.

Measurement Device

Select the type of spectrophotometer that you will use to
measure the chart after it is printed. Individual measurement
pages in the chart are sized and formatted for this device. Select
one of the automated devices, or select Hand held if you will
use a manual device.

Printable Area

Type the maximum Width and Height of the form or forms that
you create. This is usually the size of your press. A small
printable area may require more than one form to be created.

Form Layout

Select how you want to arrange the individual measurement
pages within the form or forms. Minimize Form Size creates a
form that contains only the minimum number of patches
needed to characterize the device. Fill Printable Area creates a
form that fills the entire printable area that you specified in the
Width and Height boxes.

Front and Back Forms

Select to create a second form or set of forms, mirror images of
the first. Printing the same color patch on both sides may be
necessary for thin substrates.

Force Page Breaks

Use this option to keep measurement pages away from areas
where folds or scuffing will occur. For example, in the usual 8-
up layout, set Across to 4 and set Down to 2.

Background Tint

Select to apply a uniform background tint in all areas outside
the measurement pages, on all ink channels. This makes ink
takeoff more uniform.

Measure

Start sheet selection (optional) and page measurement. Before
you click Measure, ensure that the selected chart matches the
chart printed on the sheets that you are about to measure.
(Typically, you would not measure a chart in the same session
as you create a chart.)

See also:
Measurement charts on page 65
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Measurements dialog box: Measurements tab
Use the Measurements tab to select the data for establishing the color
response of a device. The dialog box appears when you click the
Measurements icon  next to a device in a device condition.

Active Measurement

Lists the collection of measurement (characterization) data that
determines the color response of this device.

Origin

Indicates where the data came from.

Type

Indicates whether the type of data in the measurements is tonal
and color, tonal only, or color only.

Sheet Number

If multiple sheets were measured, you can select an individual
sheet for reporting.

Form Number

If the chart extended across multiple forms, you can select a
particular form.

Date

Indicates the date that the measurement was made.

Chart ID

If the origin is a ColorFlow chart, the Chart ID displays its name.

Curve

Contains information about the device curve that was used in
printing the chart.

Measurement Data / Harmony CMYK Current Curve

Allows you to select the type of data to import.

 (import)

Displays a file selection dialog box where you can import
measurement data for any type of device. The file may contain
tonal and/or colorimetric data. It is not necessary to associate a
chart because the file contains its own chart data. For devices
that use curves, you can alternatively import a Harmony CMYK
current curve.
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 (export)

Exports the active, selected measurement set.

Promote Device

The color response of this device (its active measurement)
becomes the color response of the entire device condition. This
has significance if there is more than one device in the device
condition.

Report

Creates a Print Characterization Report or a Comparison Report
using the active measurement set.

Inactive Measurements

Lists alternate sets of measurement data that could determine the
color response, but are not being used. Column headings are the same
as in Active Measurement.

 (delete)

Deletes the selected measurement in the inactive table.

 (export)

Exports the selected inactive measurement set.

Activate

Moves the selected measurement set in the table to the top
table to become the active characterization.

See also:
Activating a measurement set on page 78

Chart Measurement wizard
Follow the instructions on these wizard panels to select the best press
sheets for measuring the ColorFlow chart, and then measure the
complete chart on one or more sheets.

See also:
Measuring the chart on page 75
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Tint Ramp Chart Measurement dialog box
Use this dialog box to enter hand-measurement of a tint ramp chart.
The dialog box is displayed as part of the wizard that is invoked by
clicking the Measure button in the Measurements dialog box.

Tint in

Select the row that matches the tint that you are measuring.

(ink)

Type the measured EDA values in the respective ink columns.

See also:
Creating a tint ramp chart on page 72

Charts dialog box
Use this dialog box to view the properties of existing charts or to create
a new chart. These charts are for imposition and printing on the device
whose color response you want to measure. The dialog box is available
from the View menu.

The options in this dialog box are almost the same as on the Charts tab
in the Measurements dialog box. There is no Measure button in this
dialog box.

See also:
Measurement charts on page 65

Print Report dialog box
Use this dialog box to request and produce a report derived from saved
measurements taken from a sheet.

Comparison

Items in this section are used for comparison reports.

Compare to

Select to produce a comparison report; clear it to produce a
characterization report.

Other Device

Select if you want to compare with another device in the same
device condition. (Comparison reports only.)
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Device Condition

Select if you want to compare with another device condition,
and then from the list, select an industry specification, your own
reference conditions, or one of the device conditions that exist
in ColorFlow. (Comparison reports only.)

Characterization

Items in this section are used for both characterization and comparison
reports.

Device Condition

Displays the device condition in the report. It is determined by
the measurement set that you selected before requesting the
report.

Device

Is determined by the measurement set that you selected before
requesting the report.

Customer Name

Appears on the cover of the report

Workflow and Version

Appears on the configuration page of the report

Inks

Appears on the configuration page of the report

Process Ink Sequence

Select the correct ink sequence. This is significant for measuring
trap on overprint and appears on the configuration page of the
report.

Ink Color Target

Appears on the configuration page of the report

User Comments

Appears on the front cover and the footer of every page.
Although the entire text appears on the configuration page, only
a line appears in the footer.

Notes

Appears on the configuration page of the report
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Save

Generate a report as a PDF file and specify where to save it.

See also:
Reporting on page 193

Device Condition Profile dialog box

The dialog box is available by clicking the Profile  icon in a device
condition.

Prinergy workflow requires profiles for all device conditions.

Origin

Select the source of the profile—ColorFlow Generated or
Imported.

If the value of Origin is ColorFlow Generated, the dialog box
contains the following options:

Total Ink Limit

240 to 400%

Black Start

0 to 50%

Max Black

70 to 100%

Black Strength

Use the slider or the text box to select a value between
5 and 75%.

If the value of Origin is Imported, the dialog box contains the
following options:

(profile properties)

Displays a read-only list of the properties of the
imported profile (if any) for this device condition. The
list contains Profile Name, Date Created, Date
Imported, Media White Point, Color Space, PCS Color
Space, ICC Format Version, and Internal Name.

 (import)

Use Import to navigate to an ICC profile.

See also:
Color response of a device condition on page 83
Device profiles on page 121
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Primary Color Output Profile dialog box

The dialog box is available from the Profile  icon outside the device
condition in the PCO.

Origin

Select the source of the profile—ColorFlow Generated or
Imported.

If the value of Origin is ColorFlow Generated, the dialog box
contains the following options:

Total Ink Limit

240 to 400%

Black Start

0 to 50%

Max Black

70 to 100%

Black Strength

Use the slider or the text box to select a value between
5 and 75%.

If the value of Origin is Imported, the dialog box contains the
following options:

(profile properties)

Displays a read-only list of the properties of the
imported profile (if any) for this PCO. The list contains
Profile Name, Date Created, Date Imported, Media
White Point, Color Space, PCS Color Space, ICC Format
Version, and Internal Name.

 (import)

Use Import to navigate to an ICC profile.

See also:
Color response of the PCO on page 84
Device profiles on page 121

232 Chapter 22—Reference



Device Curves Definition dialog box

The dialog box is available from the Curves icon  next to a device in a
device condition.

Origin

Select the source of the initial device curve. You can later adjust
any device curve.

ColorFlow Generated

Uses curves calculated from chart measurements.

Preset Linear

Uses curves that are initially linear.

Preset Cutback

15% Cutback curve added to the preset selection list,
providing pre-compensation for high-gain print
conditions superior to 20% cutback curve.

Note: This is the recommended option to be used, especially
for Staccato screening types.

Imported

Uses the Harmony calibration curve that you import
with Import.

 (import)

If Imported is selected, use Import to display a file selection
dialog box where you can browse to a Harmony curve set (.hmy
file). Then in the Import Harmony Transfer Curve dialog box,
you can import a Harmony curve set.

See also:
Device curves on page 54

Device Curves Adjustment dialog box
Use this dialog box to make corrections in the color response of a
device condition. If a curve has been defined, the dialog box is available

from the Curves icon  next to a device in a device condition.

(title bar)

Displays the device name.

Device Curves Definition dialog box 233



(Curve Adjustments tool)

Use the graph and controls in this area to make curve
adjustments. Adjustments that you make here affect the curves
that change the color response of the device condition.

Device Tonality

Displays the Uncalibrated Device Tonality dialog box which
contains a graph of the tonal response of the device in this
device condition, excluding the effect of its device curve.

Device Curves

Displays the Device Curves dialog box where you can view and
change the curves directly.

Preview

Enables you to see the effects of the requested change before
you click Apply. You will see a before-and-after preview of all
edits. The before-and-after view can be customized to show
edits for any particular area of the image.

Redefine

Displays the Device Curves Definition dialog box where you can
obtain a new device curve.

See also:
Correcting a color shift on a curve-controlled device on page 86
Device Curves Definition dialog box on page 233
Device Curves dialog box on page 234
Uncalibrated Device Tonality dialog box on page 235
Image Preview window on page 256
Curve Adjustments tool on page 263

Device Curves dialog box
Use this dialog box to view and directly adjust device curves. This
dialog box is available from the Device Curves command in the Device
Curves Adjustment dialog box.

(title bar)

Displays the device name.

(Curve View-Edit tool)

Use the graph and controls in this area to view device curves
and directly adjust them.

Adjustments you make here change the color response of the
device condition. In general, you should not change the color
response after ColorFlow has calculated other elements based

234 Chapter 22—Reference



on that device condition. Instead, use this dialog box only to
make a needed correction to the device curves, after something
has changed the originally-measured response.

When you correct the curves in CMY mode, you will notice that
the Current patch changes. This reinforces the concept that the
device response (represented in the Corrected patch) should
be kept constant.

Preview

Enables you to see the effects of the device curve before you
click Apply. You will see a before-and-after preview of all edits.
The before-and-after view can be customized to show edits for
any particular area of the image.

See also:
Correcting a color shift on a curve-controlled device on page 86
Image Preview window on page 256
Curve View-Edit tool on page 266

Uncalibrated Device Tonality dialog box
Use this dialog box to view the tonal response of a device in a device
condition, excluding the effect of its device curves. This dialog box is
available in the Device Curves Adjustment dialog box, from the Device
Tonality command.

(title bar)

Displays the device name.

C, M, Y, K

Select the channel to view.

(Effective Dot Area View, Tone Value Increase View)

Select the type of table and graph you prefer—Effective Dot
Area view or Tone Value Increase view. The displayed tonality
is the same; only the presentation is different.

Tint in

Tint values at the device input, not including the device curve.
Type a value to see the corresponding value for that channel in
the other column.

EDA

Effective dot area as measured on a press sheet, and then
adjusted to remove the effect of the device curve. Displayed if
the Effective Dot Area View icon is selected. Type a value to
see the corresponding Tint in.
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TVI

Tone value increase as measured on a press sheet, and then
adjusted to remove the effect of the device curve. Displayed if
Tone Value Increase View icon is selected. Type a value to see
the corresponding Tint in.

(graph of response)

Click the graph of the selected channel, and then drag the point
and read in the text boxes the corresponding Tint in and vertical
axis values.

See also:
Device Curves Adjustment dialog box on page 233

Simulation Definition (PCO to target) dialog box
Use this dialog box to select a target, and control how a PCO simulates

the target. This dialog box is available from the Simulation icon  that
appears in the outside frame of the PCO. If a simulation is already
defined, in the Simulation Adjustment dialog box, click Redefine.

ColorFlow can perform the simulation using tonal curves or
DeviceLinks or a combination.

Target

Select the color response whose colors the PCO will attempt to
simulate. Often this will be an industry reference.

Curves Method

For curved devices only (i.e., offset presses, some digital
presses, and halftone proofers), select how you want to
generate and use tonal curves.

Manual Adjustments Only

Tonal curves are applied to data in the digital file.
However, these curves are linear—they have no effect—
until you make some adjustments.

Tonal Match

Tonal curves are applied to data in the digital file. The
curves are calculated so that the Tonal Value Increase
(TVI) for a particular tone and ink color on the printed
sheet (or other device output) is the same as the TVI
for the target response. Tonal match requires spectral
data from a Tonal or Color Characterization chart, or
EDA values from a Tint Ramp chart (see Charts).
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Gray Balance

Tonal curves are applied to data in the digital file. The
curves for cyan, magenta, and yellow are calculated so
that the neutral (gray) tone throughout its range of
lightness on the printed sheet is the same as the neutral
tones for the target response. The curve for black is
calculated so that the relative lightness for a particular
tone on the printed sheet (or other device output) is the
same as the relative lightness for the target response.
Perceptual mapping of neutral ramps is performed for
black and CMY curves. The gray balance method
requires spectral or CIELAB values from a color
characterization chart.

DeviceLink Method

Select how you want to generate and use DeviceLinks. For some
types of devices, not all selections are available. Because the
DeviceLink is used in the context of a simulation, the DeviceLink
source is the color space selected in Target; the destination is
the device condition inside the PCO.

Ink Optimizing Solution

This check box is available if your license includes the
Ink Optimizing Solution feature. Select the check box to
apply gray component replacement (GCR) to optimize
ink usage by replacing chromatic inks with black.

Allow Color Space Simulation or Allow Color Space
Conversion

The name of this option depends on whether you are in
the PCO or SCO. For curve-controlled devices, use this
option to achieve ink savings, and to achieve a closer
color match to your source color space. When this
option is selected, gamut mapping may occur between
two different color spaces.

Full Reseparation

Completely reseparated. Solid colors in the original file
may not remain solid. The black generation parameters
that you specify are used, which may result in using less
chromatic ink and more black ink.

CMYK Integrity

All color builds can be adjusted. The relative amount of
black vs CMY will be preserved in content processed
through the DeviceLink
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Black Purity Only

Any colors other than black channel (solid K, K-grays)
may be adjusted.

Color and Black Purity

Same as Fully Constrained but solid colors may be
reduced to a tint.

Fully Constrained

A DeviceLink is used to change data in the digital file.
However, it is constrained, so that any color made with
only one or two inks will not have other inks added.
Solid (100% tints) primaries and secondaries are not
affected and remain solid.

Imported

Import an existing DeviceLink. Click Import to browse
to a DeviceLink.

Rendering Intent

Perceptual, Relative Colometric, Saturation, or Absolute
Colometric

Total Ink Limit

200 to 400%

Black Start

0 to 60%

Max Black

70 to 100%

Black Strength

Use the slider or text box to select a value between 5 and 100%.

See also:
Simulating an industry specification on page 91
Generating a DeviceLink on page 128

Simulation Adjustment (PCO to target) dialog box: DeviceLink tab
Use the Adjust DeviceLink tab to make changes in the overall color
response of the PCO. If a simulation has been defined, this dialog box is
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available from the Simulation icon  that appears in the outside frame
of the PCO.

(adjustment mode)

There are three adjustment modes. Options in this area depend
on the adjustment mode and are described separately.

● White Point is available only if Rendering Intent is Absolute
Colorimetric.

● Input Tonality, individual channels or CMY, is available only
when editing the DeviceLink source.

● Output Tonality, individual channels or CMY, is available
only when editing the DeviceLink destination.

Preview

Enables you to see the effects of the simulation on an image
before you click Apply. You will see a before-and-after preview
of all edits. The before-and-after view can be customized to
show edits for any particular area of the image.

Redefine

Discards adjustments and defines the simulation again.

See also:
Adjusting a simulation DeviceLink on page 93
About adjusting DeviceLinks on page 133
DeviceLink White Point options on page 254
DeviceLink Input Tonality options on page 255
DeviceLink Output Tonality options on page 256

Simulation Adjustment (PCO to target) dialog box: Curves tab
Use the Curves tab to make changes in the overall color response of
the PCO. If a simulation has been defined, this dialog box is available

from the Simulation icon  that appears in the outside frame of the
PCO.

(Curves Adjustments tool)

Use the graph and controls in this area to make tonal difference
adjustments. Adjustments you make here affect the curves that
change the color response of the device condition to simulate
the selected target.
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Expected Tonality

Displays the Expected Tonality dialog box which contains a
graph of the expected overall tonal response of the primary
color output, including the effect of the simulation curves.

Calibration Curves

Displays the Calibration Curves dialog box where you can view
and change the curves directly.

Preview

Enables you to see the effects of the simulation on an image
before you click Apply. You will see a before-and-after preview
of all edits. The before-and-after view can be customized to
show edits for any particular area of the image.

Redefine

Displays the Simulation Definition dialog box where you can
change the simulation target and methods for matching it.

See also:
Adjusting simulation curves on page 93
About previewing images on page 149
Simulation Definition (PCO to target) dialog box on page 236
Calibration Curves dialog box on page 240
Expected Tonality dialog box on page 242
Curve Adjustments tool on page 263

Calibration Curves dialog box
Use this dialog box to view and directly adjust calibration curves to use
with the device in the PCO or an SCO. This dialog box is available in the
Simulation or Conversion Adjustment dialog box, from the Curves tab,
Calibration Curves command.

(title bar)

If these are calibration curves for a simulation, the title bar
displays, "Calibration Curves [<PCO device condition name>] as
[<target name>]."

If these are calibration curves for a SCO conversion, the title bar
displays, "Calibration Curves [<SCO device condition name>] as
[ [<PCO device condition name>] as [<target name>] ]."

Device

If the device condition has more than one device (pooled),
select a device here. Calibration curves include a device curve
that ColorFlow may have adjusted to make the devices match.
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(Curve View-Edit tool)

Use the graph and controls in this area to view calibration
curves and directly adjust them.

Exclude Device Curves

Do not select this option if the intent is to edit the entire
calibration curve.

Preview

Enables you to see the effects of the calibration curve on an
image before you click Apply. You will see a before-and-after
preview of all edits. The before-and-after view can be
customized to show edits for any particular area of the image.

See also:
Curves on page 107
Simulation Curves dialog box on page 241
Conversion Curves dialog box on page 247
Curve View-Edit tool on page 266

Simulation Curves dialog box
Use this dialog box to view and directly adjust simulation curves to use
with the device in the PCO. This dialog box is available from the
Calibration Curves dialog box when Exclude Device Curves is selected.

(title bar)

The title bar displays "Simulation Curves [<PCO device condition
name>] as [<target name>]"

Device

This option, to choose a device among pooled devices, has no
effect because a simulation curve is the same for either device.

Exclude Device Curves

Clear this option to view or edit the entire calibration curve. The
title bar changes accordingly.

(Curve View-Edit tool)

Use the graph and controls in this area to view simulation
curves and directly adjust them.

Preview

Enables you to see the effects of the simulation curve before
you click Apply. You will see a before-and-after preview of all
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edits. The before-and-after view can be customized to show
edits for any particular area of the image.

See also:
Curves on page 107
Calibration Curves dialog box on page 240
Curve View-Edit tool on page 266

Expected Tonality dialog box
Use this dialog box to view the predicted tonal response of the device
condition, including its simulation (or conversion) curves. This dialog
box is available in the Simulation (or Calibration) Adjustment dialog
box, on the Adjust Curves tab, from the Expected Tonality command.

(title bar)

Displays the device condition name and target.

C, M, Y, K

Select the channel to view.

(Effective Dot Area View, Tone Value Increase View)

Select the type of table and graph you prefer—Effective Dot
Area view or Tone Value Increase view. The displayed tonality
is the same; only the presentation is different.

Tint in

Tint values at the level of the PCO (or SCO) before applying
simulation (or conversion) and device curves. Type a value to
see the corresponding value for that channel in the other
column.

EDA

Effective dot area predicted to occur on a press sheet. Appears
if the Effective Dot Area View icon is selected. Type a value to
see the corresponding Tint in.

TVI

Tone Value Increase predicted to occur on a press sheet.
Appears if the Tone Value Increase View icon is selected. Type
a value to see the corresponding Tint in.
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(graph of response)

Click the graph of the selected channel, and then drag the point
and read in the text boxes the corresponding Tint in and vertical
axis values.

See also:
Simulation Adjustment (PCO to target) dialog box: Curves tab
on page 239
Conversion Adjustment (PCO to SCO) dialog box: Curves tab
on page 246

Conversion Definition (PCO to SCO) dialog box
Use this dialog box to control how a SCO emulates the PCO. This

dialog box is available from the Conversion  icon that appears in the
link connecting a SCO to the PCO. If a conversion is already defined, in
the Conversion Adjustment dialog box, click Redefine.

ColorFlow can perform the conversion using tonal curves or
DeviceLinks or a combination of each.

Curves

Select how you want to use tonal curves.

Manual Adjustments Only

Tonal curves are applied to data in the digital file.
However, these curves are linear—they have no effect—
until you make some adjustments.

 Tonal Match

Tonal curves are applied to data in the digital file. The
curves are calculated so that the Tone Value Increase
(TVI) for a particular tone and ink color on the printed
sheet (or other device output) is the same as the TVI
for the PCO device.

Gray Balance

Tonal curves are applied to data in the digital file. The
curves for cyan, magenta, and yellow are calculated so
that the neutral (gray) tone throughout its range of
lightness on the printed sheet is the same as the neutral
tones for the target response. The curves for black and
other process inks are calculated so that the TVI for a
particular tone and ink color on the printed sheet (or
other device output) is the same as the TVI for the PCO
device.
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DeviceLink

Select how you want to use DeviceLinks. For some types of
devices, not all options are available. Because the DeviceLink is
used in the context of a conversion, the DeviceLink source is the
PCO; the destination is the device condition of the SCO.

In the following descriptions, the numbers in brackets (n) are
provided to aid the descriptions.

None

A DeviceLink is not used to change data in the digital
file.

Imported

Import an existing DeviceLink. Click Import to browse
to a DeviceLink.

Fully Constrained

A DeviceLink is used to change data in the digital file.
However, it is constrained, so that any color made with
only one or two inks will not have other inks added.
Solid (100% tints) primaries and secondaries are not
affected and remain solid.

Color and Black Purity

Same as Fully Constrained but solid colors may be
reduced to a tint.

Black Purity Only

Any colors other than black channel (solid K, K-grays)
may be adjusted.

CMYK Integrity

All color builds can be adjusted. The relative amount of
black vs CMY will be preserved in content processed
through the DeviceLink.

Full Reseparation

Completely reseparated. Solid colors in the original file
may not remain solid. The black generation parameters
that you specify are used, which may result in using less
chromatic ink and more black ink.

Ink Optimizing Solution

This DeviceLink Method is available if your license
includes the Ink Optimizing Solution feature. Select Ink
Optimizing Solution to apply gray component
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replacement (GCR) to optimize ink usage by replacing
chromatic colors with black.

Target Simulation or Color Space Conversion

The name of this option depends on whether you are in the
PCO or SCO.

For curve-controlled devices, use this option to achieve ink
savings and to achieve a closer color match to your source color
space. When this option is selected, gamut mapping may occur
between two different color spaces.

Rendering Intent

Perceptual, Relative Colometric, Saturation, or Absolute
Colometric

Total Ink Limit

200 to 400%

Black Start

0 to 60%

Max Black

70 to 100%

Black Strength

Use the slider or text box to select a value between 5 and 100%.

See also:
Generating a DeviceLink on page 128

Conversion Adjustment (PCO to SCO) dialog box: DeviceLink tab
Use this dialog box to control how an SCO emulates the PCO. If a
conversion has been defined, this dialog box is available from the

Conversion  icon that appears in the link connecting a SCO to the
PCO.

(adjustment mode)

There are three adjustment modes. Options in this area depend
on the adjustment mode and are described separately.

● White Point is available only if Rendering Intent is Absolute
Colorimetric.

● Input Tonality, individual channels or CMY, is available only
when editing the DeviceLink source.
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● Output Tonality, individual channels or CMY, is available
only when editing the DeviceLink destination.

● Dark Point, Allows you to adjust the color look-up table
(CLUT) of the DeviceLink profile at one of four selectable
dark points: Solid K, Solid CMY, Solid CMYK, or the darkest
pixel of a Preview image.

● Gray Balance, Allows you to adjust the source at a selected
point on one of two selectable gray ramps: K only and CMY
only. For example of adjusting the Gray Balance is when you
want to make a localized correction to an inaccurate color on
the neutral axis of a device profile.

● Selected Color, Allows you to adjust the central color look-
up table (CLUT) of the DeviceLink profile at a selected input
tint. The profile input coordinates to be adjusted may be
entered directly, or sampled from the active colorimeter of
the Preview image. Three range sliders select the range of
influence of the adjustment.

Preview

Enables you to see the effects of the conversion before you click
Apply. You will see a before-and-after preview of all edits. The
before-and-after view can be customized to show edits for any
particular area of the image.

Redefine

Discards adjustments and defines the simulation again.

See also:
Adjusting an SCO DeviceLink on page 97
About adjusting DeviceLinks on page 133
DeviceLink White Point options on page 254
DeviceLink Input Tonality options on page 255
DeviceLink Output Tonality options on page 256

Conversion Adjustment (PCO to SCO) dialog box: Curves tab
Use the Adjust Curves tab to change the color response of the SCO. If
a conversion has been defined, this dialog box is available from the

Conversion  icon that appears in the link between an SCO and the
PCO.

(Curve Adjustments tool)

Use the graph and controls in this area to make curve
adjustments. Adjustments you make here affect the curves that
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change the color response of the device condition to simulate
the PCO.

Expected Tonality

Displays the Expected Tonality dialog box which contains a
graph of the expected tonal response of this SCO, including the
effects of the conversion curves.

Calibration Curves

Displays the Calibration Curves dialog box where you can view
and change the curves directly.

Preview

Enables you to see the effects of the conversion before you click
Apply. You will see a before-and-after preview of all edits. The
before-and-after view can be customized to show edits for any
particular area of the image.

Redefine

Displays the Conversion Definition dialog box where you can
change the methods used to match the PCO.

See also:
Adjusting SCO conversion curves on page 96
About previewing images on page 149
Calibration Curves dialog box on page 240
Expected Tonality dialog box on page 242
Conversion Definition (PCO to SCO) dialog box on page 243
Conversion Curves dialog box on page 247
Curve Adjustments tool on page 263

Conversion Curves dialog box
Use this dialog box to view and directly adjust conversion curves to use
with the device in an SCO. This dialog box is available from the
Calibration Curves dialog box, when Exclude Device Curves is
selected.

(title bar)

The title bar displays "Conversion Curves [<SCO device
condition name>] as [ [<PCO device condition name>] as [<target
name>] ]"

Device

This option, to choose a device among pooled devices, has no
effect because a conversion curve is the same for either device.
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Exclude Device Curves

Clear this option to view or edit the entire calibration curve. The
title bar changes accordingly.

(Curve View-Edit tool)

Use the graph and controls in this area to view conversion
curves and directly adjust them.

Preview

Enables you to see the effects of the conversion curve before
you click Apply. You will see a before-and-after preview of all
edits. The before-and-after view can be customized to show
edits for any particular area of the image.

See also:
Curves on page 107
Calibration Curves dialog box on page 240
Curve View-Edit tool on page 266

Input Conversion Definition (Color Input to PCO) dialog box
Use this dialog box to control how data in the color space of the color is
converted to the color space of the PCO. This dialog box is available

from the Conversion  icon that appears in the link connecting a color
input to the PCO. You can select this from either the RGB Reference or
CMYK Reference color input device.

You can select between Profile Pair or DeviceLinks for the conversion
method. There are different options available depending on the
conversion method you select.

RGB Reference

Profile Pair

Image (tab)

Workflow handles Image content (pictures or raster) differently
from graphic content (text and linework). You can make
different settings for each.

Rendering Intent

The rendering intent influences the conversion from
device independent color spaces to a target color space.
Includes the following options:

● Perceptual

● Relative Colorimetric
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Profile Pair

● Saturation

● Absolute Colorimetric

Graphic (tab)

Graphic Conversion same as Image Conversion

Select to use the same settings for graphic content as for image
content.

RGB Reference

DeviceLink

Image (tab)

Workflow handles Image content (pictures or raster) differently
from graphic content (text and linework). You can make
different settings for each.

DeviceLink Method

Select how you want to use DeviceLinks. For some
types of devices, not all options are available. Because
the DeviceLink is used in the context of a conversion,
the DeviceLink source is the color input; the destination
is the PCO.

In the following descriptions the numbers in brackets
(n) are provided to aid the descriptions.

Imported

Import an existing DeviceLInk. Use Import to
browse to a suitable DeviceLink.

ColorFlow Generated

Allows you to select a rendering intent and
adjust the black generation controls and default
values. Includes the following options:

Rendering Intent

The rendering intent influences the conversion
from device independent color spaces to a
target color space. Includes the following
options:
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DeviceLink

● Perceptual

● Relative Colorimetric

● Saturation

● Absolute Colorimetric

Total Ink Limit

200 to 400%

Black Start

0 to 60%

Max Black

70 to 100%

Black Strength

Use the slider or text box to select a value between 5 and 100%.

Black Point Compensation

Applies to Relative Colorimetric rendering intent only. Performs
Perceptual-like gamut mapping of near-neutral colors.

Graphic (tab)

Graphic Conversion same as Image Conversion

Select to use the same settings for graphic content as for image
content.

CMYK Reference

Profile Pair

Image (tab)

Workflow handles Image content (pictures or raster) differently
from graphic content (text and linework). You can make
different settings for each.

Rendering Intent

The rendering intent influences the conversion from
device independent color spaces to a target color space.
Includes the following options:

● Perceptual

● Relative Colorimetric
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Profile Pair

● Saturation

● Absolute Colorimetric

Graphic (tab)

Graphic Conversion same as Image Conversion

Select to use the same settings for graphic content as for image
content.

CMYK Reference

DeviceLink

Image (tab)

Workflow handles Image content (pictures or raster) differently
from graphic content (text and linework). You can make
different settings for each.

DeviceLink Method

Select from the following options:

● Ink Optimizing Solution: This is only available if your
license includes the Ink Optimizing Solution feature.
Select this to apply gray component replace (GCR)
to optimize ink usage by replacing chromatic colors
with black.

● Full Reseparation: Completely reseparated. Solid
colors in the original file may not remain solid. The
black generation parameters that you specify are
used, which may result in using less chromatic ink
and more black ink.

● CMYK Integrity: All color builds can be adjusted.
The relative amount of black vs CMY will be
preserved in content processed through the
DeviceLink.

● Black Purity Only: Any colors other than the black
channel (solid K, K-grays) may be adjusted.

● Color and Black Purity: A DeviceLink is used to
change the data in the digital file. However, it is
constrained, so that any color made with only one or
two inks will not have other inks added. Solid (100%
tints) primaries and secondaries may be reduced.

● Fully Constrained: A DeviceLink is used to change
the data in the digital file. However, it is constrained,
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DeviceLink

so that any color made with only one or two inks will
not have other inks added. Solid (100% tints)
primaries and secondaries are not affected, and
remain solid.

● Imported: Import an existing DeviceLink. Use Import
to browse to a DeviceLink.

Depending on your selection, you can select a rendering intent
and adjust the black generation controls and default values.
Includes the following options:

Rendering Intent

The rendering intent influences the conversion from
device independent color spaces to a target color space.
Includes the following options:

● Perceptual

● Relative Colorimetric

● Saturation

● Absolute Colorimetric

Total Ink Limit

200 to 400%

Black Start

0 to 60%

Max Black

70 to 100%

Black Strength

Use the slider or text box to select a value between 5
and 100%.

Black Point Compensation

Applies to Relative Colorimetric rendering intent only.
Performs Perceptual-like gamut mapping of near-
neutral colors.

Graphic (tab)
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Graphic Conversion same as Image Conversion

Select to use the same settings for graphic content as for image
content.

See also:
Adjusting a CI conversion on page 103

Conversion Adjustment (Color Input to PCO) dialog box
Use this dialog box to control how the color space of the color input is
converted to that of the PCO.

If a conversion has been defined, this dialog box is available from the

Conversion  icon that appears in the link connecting a color input to
the PCO.

(adjustment mode)

There are three adjustment modes. Options in this area depend
on the adjustment mode and are described separately.

● White Point is available only if Rendering Intent is Absolute
Colorimetric.

● Input Tonality, individual channels or CMY, is available only
when editing the DeviceLink source.

● Output Tonality, individual channels or CMY, is available
only when editing the DeviceLink destination.

Preview

Enables you to see the effects of the conversion before you click
Apply. You will see a before-and-after preview of all edits. The
before-and-after view can be customized to show edits for any
particular area of the image.

Redefine

Discards adjustments and defines the simulation again.

See also:
Adjusting a CI conversion on page 103
About adjusting DeviceLinks on page 133
DeviceLink White Point options on page 254
DeviceLink Input Tonality options on page 255
DeviceLink Output Tonality options on page 256
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DeviceLink White Point options
These options are available on the DeviceLink Adjust tab of the
Simulation or Conversion dialog box when the adjustment mode is
White Point.

This adjustment mode edits the central color lookup table of the
DeviceLink at the white point—input coordinates (0, 0, 0, 0).

(color adjuster)

Use the lightness (L*) slider together with the cast (a*b*)
selector to adjust the white point. Your movement in the color
selector may be constrained. When Adjust Displayed Colors is
selected, you can use these color adjuster controls to move the
displayed color patches to a new color.

Before, After

The displayed color patches demonstrate the effect of all the
adjustments specified in this dialog box. The color produced by
the curves or profile before your adjustment is shown on the left
(Before). The color produced by the curves or profile after your
adjustment is shown on the right (After). Click the patches to
display them in a larger view.

Adjust Displayed Colors

Enables you to adjust the displayed color of the Before, After or
Current, Corrected patches on your viewing monitor, if the
neutral gray that is displayed in the color patch does not
visually align with the neutral gray on your proof or press sheet.
Select the Adjust Displayed Colors check box and use the color
adjuster controls. The feature enables you to change the color
of the patches only as they are displayed onscreen; it does not
directly affect curve editing. Clear the check box after using the
feature.

Reset

Available only when Adjust Displayed Colors is selected.
Resets the displayed color.

In

Input is the file white point (0, 0, 0, 0).

Out

White point after transformation by the DeviceLink. You can
change it with the color adjuster controls, or by directly entering
C M Y K.
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Change

Displays the expected change in L*, a*, b*, C* and H* at the
white point. You can enter the desired change directly in L*, a*,
b*.

See also:
About adjusting DeviceLinks on page 133
Simulation Adjustment (PCO to target) dialog box: DeviceLink tab
on page 238
Conversion Adjustment (PCO to SCO) dialog box: DeviceLink tab
on page 245
Conversion Adjustment (Color Input to PCO) dialog box on page 253

DeviceLink Input Tonality options
These options are available on the Adjust DeviceLink tab of the
Simulation (or Conversion) Adjustment dialog box when the
adjustment mode is Input Tonality.

This adjustment mode provides adjustment of the transfer curve at the
input (source) of the DeviceLink for a single process channel, or
coordinated adjustment of CMY input curves at four fixed tonal values.
This does not adjust the curves that appear on the Adjust Curves tab
of the Simulation (or Conversion) Adjustment dialog boxes.

(Curve Adjustments tool)

Use the graph and controls in this area to make curve
adjustments.

Input Curves

Opens the Profile Input Curves window where you can adjust
the curves directly.

See also:
About adjusting DeviceLinks on page 133
Simulation Adjustment (PCO to target) dialog box: DeviceLink tab
on page 238
Conversion Adjustment (PCO to SCO) dialog box: DeviceLink tab
on page 245
Conversion Adjustment (Color Input to PCO) dialog box on page 253
Curve Adjustments tool on page 263
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DeviceLink Output Tonality options
These options are available on the Adjust DeviceLink tab of the
Simulation (or Conversion) Adjustment dialog box when the
adjustment mode is Output Tonality.

This adjustment mode provides adjustment of the transfer curve at the
output (destination) of the DeviceLink for a single process channel, or
coordinated adjustment of CMY output curves at fixed tonal values.
This does not adjust the curves that appear on the Adjust Curves tab
of the Simulation (or Conversion) Adjustment dialog boxes.

(Curve Adjustments tool)

Use the graph and controls in this area to make curve
adjustments.

Output Curves

Opens the Profile Output Curves window where you can adjust
the curves directly.

See also:
About adjusting DeviceLinks on page 133
Simulation Adjustment (PCO to target) dialog box: DeviceLink tab
on page 238
Conversion Adjustment (PCO to SCO) dialog box: DeviceLink tab
on page 245
Conversion Adjustment (Color Input to PCO) dialog box on page 253
Curve Adjustments tool on page 263

Image Preview window
Use this window to view a selected image in detail. You can see and
measure the changes caused by adjustments. This window is available
from the Preview command in all Adjustment dialog boxes.

(title bar)

Displays the device condition name and other relevant
identifiers, such as the name of the device, the name of the
simulation target, and so on), depending on the element being
adjusted.

(navigation pane)

A rectangle indicates the portion of the image that appears in
the preview pane. The rectangle is shaded to indicate the before
side (black) and the now side (white).

To zoom, drag a marquee.
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To make a point the new center of the preview pane, simply
click it.

(zoom slider)

To zoom, move the slider, or select the slider and nudge it with
the arrow keys.

(zoom % list)

To zoom, type a value or choose a value from the list. A
magnification of 100% indicates the image is displayed using
one screen pixel for each image file pixel. Similarly, 500%
indicates five screen pixels for each image pixel. The top item
on the list represents the zoom value that fits the image in the
current preview panel, the same zoom value as full-left on the
zoom slider.

(preview pane)

Use the split-screen to compare the image with all adjustments
including the most recent (the now side) and the image without
any adjustments (the before side). The image is updated to
show the effect of adjustments as you make them.

To zoom, click in the image, and then use your scroll-wheel, or
Command-drag a marquee.

To pan the viewed area, drag in the pane. Or to make a point
the new center, simply click the point, taking care not to move
the mouse as you do.

(input-output divider)

A movable divider lets you position the split at the exact point
where you wish to examine the effect of the changes. You can
drag the divider across the top of the image, and around
corners, even onto the lower edge so that before and now switch
sides.

 (add colorimeter)

Creates floating colorimeters in the preview pane. As you drag a
colorimeter to any point in the image, the numbers below the
preview pane reveal the tint change of that color, before and
after adjustments.

 (delete colorimeter)

Deletes the selected colorimeter. If colorimeters with a higher
number exist, they are renumbered.

ColorFlow windows and dialog boxes 257



Input

Tint value for each ink (and the total of inks) at the location of
the selected colorimeter before applying the transformation.

Output

Tint value for each ink (and the total of inks) at the location of
the selected colorimeter after applying the transformation, both
before and after the adjustment. The transformation revealed
here depends on where you were making adjustments when
you invoked the Image Preview window.

Hide Colorimeters

Hides all colorimeters but does not delete them. Their locations
still appear in the navigation pane.

(colorimeter pane)

Displays color data for all colorimeters.

See also:
Image preview on page 149

New Plate Setup dialog box
Use this dialog box to create a plate setup. The dialog box is available
by clicking the add button  in the Plate Setup area of the Plate
Setups dialog box.

Device type

Displays the type of offset device (sheetfed offset, coldset web
offset, or heatset web offset) for this plate setup. The plate
setup that you create can be used only with this device type. If
this dialog box was invoked from the Device Condition
Properties dialog box, this item is already known, and cannot be
changed.

Plate type

Displays the physical plate for this plate setup. A plate can
appear in many plate setups and plate lines. However, note that
when you add a plate type, it is specific to the device type that
the plate will be used with.

Screening

Displays the screening for this plate setup. The list contains the
same values as the screening property for the device type. Use
the edit button  to change the screening values in the list.
Values added here will be available everywhere that the
screening property for this device type appears.
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OK

Creates the new plate setup. Its name is formed from the
combined values of its plate type and screening.

See also:
Plate setups on page 157
Creating a plate setup on page 158

Plate Setups dialog box
Use this dialog box to create and edit plate curves. These curves can
make your platesetter output linear. The dialog box is available from
View > Plate Setups.

Device type

Select an offset device type. Only the plate setups for this
device type are displayed in Plate setups. If this dialog box was
invoked from the Device Condition Properties dialog box, this
item is already selected.

Plate setups

A list of all the plate setups that can be used with the selected
Device type. Because each plate setup must have a unique
combination of the Plate and Screening properties, its name is
simply their combined values. You cannot change the name.

 (add)

Opens the New Plate Setup dialog box where you can
create a plate setup.

 (export)

Exports the selected plate setup in Harmony format.

 (delete)

Deletes the selected plate setup.

Plate lines

A plate line refers to a particular combination of plate,
screening, platesetter, and chemistry. The plate lines displayed
are for the selected plate setup only. If you want to use the
same physical plate line with a second plate setup, you must
create another plate line in the second plate setup. Several plate
lines can use the same combination of platesetter and
chemistry.
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Name

You can assign your own plate line names.

Date modified

The date you created the plate line or modified a tint.

 (add)

Creates a new plate line for this plate setup only.

 (delete)

Deletes the selected plate line from this plate setup.

Tint values

The tint values imposed on the plate for measurement. The tint
value table is specific to the selected plate line.

Input tint

Tint values that are input to the platesetter. The values
are the same as on the Kodak plate control strip.

Measured tint (uncalibrated)

The measured densities on plate for each of the input
tints.

Close

Closes the dialog box. Additions and changes were saved as
you made them.

See also:
Plate setups on page 157

Preferences dialog box
Use this dialog box to configure your default settings in several
categories. The dialog box is available from the File menu.

User Interface tab

Language

Selects the language of the ColorFlow user interface. After the
language is changed, a restart is required.
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ICC Profiles tab

Profile Version

Selects whether generated ICC device profiles and ICC
DeviceLink profiles are version 2 or version 4 profiles. The
default is version 4. After it is changed, a restart is required.
Existing profiles are not affected.

Measurement tab

Density Standard

Enables you to select the standard that your measuring device
will use when measuring densities on a press sheet.

ISO Status T, ANSI T: Wide band color reflection
densitometer response, used mainly in the US and United
Kingdom.
ISO Status E, DIN: Wide band color reflection densitometer
response, used mainly in Europe. Yellow values tend to be
higher than Status T.
ISO Status I / SPI, DIN NB: Narrow band densitometer
responses.

See also:
Measuring the chart on page 75
About device profiles on page 121

History window
Use this window to view adjustments made and being made to the
element in the currently selected adjustment dialog box. This window
is available from the View menu. Here you can view the entire history
of curves and profiles, including definition, regeneration, adjustments,
and snapshot capture events.

A separate history log is kept for each adjustable element in each color
setup, and each device condition. Consequently, changes to a device
curve and simulation curve even in the same PCO do not appear in the
same window.

Adjustments to

Although individual adjustments are shown under this heading,
you cannot undo them individually. However, from the Edit
menu you can undo or redo the collected adjustments made in
each preceding apply.
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Uncommitted

Shows the adjustments you have made since you opened that
dialog box, or last clicked Apply. These adjustments can be
undone individually from the Edit menu.

See also:
History and undo on page 201

Licensing dialog box
Use this dialog box to obtain or view the status of the license for your
edition and options. The Standalone edition is not available in version
1.0 of the software.

Workflow Edition

When a Workflow edition first runs, it presents the ColorFlow
Licensing dialog box where you can connect to a Prinergy server.

Prinergy Primary Server

Select a server and its IP address from the list to view its
licensed ColorFlow edition and licensed options. To add more
servers that are not on the local network, use the add button 
and type the exact server name. To remove a server from the
list, use the delete button .

ColorFlow License

Licensed editions available on this server.

Optional Features

Additional features available on this server.

OK

ColorFlow connects to the selected server and the features that
are licensed by the server become available. If you used this
procedure to change an existing license, or connect to a
different server, ColorFlow exits and you must restart it.

Standalone Edition

When the Standalone edition first runs, it presents the ColorFlow
Licensing dialog box where you can connect with the Kodak licensing
server.

Your Unique Computer ID

A unique string that identifies your computer. Use it to obtain
your standalone license key.
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Get License

Opens a Web browser to contact Kodak and obtain the license
key.

License Key

Enter the license key provided.

Optional Features

Displays any optional features that are available with your
license.

OK

If you changed an existing license, ColorFlow exits and you
must restart it.

See also:
Licenses on page 20

Curve Adjustments tool
This collection of items appears in several curve-adjustment dialog
boxes: device curves, simulation/conversion curves, and device profile
and DeviceLink input/output tonality. Together the items comprise a
powerful global adjustment tool.

As you adjust the controls in this group, you are changing the
underlying curves. The height of the graph and values in text boxes
represent the exact change in the underlying curves.

(graph of tonal change)

For CMYK devices, the horizontal axis represents CMYK and
Spot (if applicable) tint values 0% (lightest) to 100% (darkest).
The vertical axis represents your requested curve change,
+20% to - 20%.

Expected Tonality (simulation/conversion curve adjustments)

Device Tonality (device curve adjustments)

View the tonal response of the PCO/SCO or device, and the
effect of your curve changes.
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Calibration Curves (simulation/conversion curve adjustments)

Device Curves (device curve adjustments)

Input Curves (device profile or DeviceLink input tonality
adjustments)

Output Curves (device profile or DeviceLink output tonality
adjustments)

Device or Calibration Curve views can be used to view and edit
the actual curves that you are adjusting with the Curve
Adjustments tool. Alternately, you can change curves in both
windows, and see the result in both.

(channels)

Select for adjustment an individual channel C, M, Y, or K,
combined channels CMY for a coordinated neutral tonal or cast
or lightness adjustment, or Spot for spot color adjustment.

Spot ink

If C, M, Y, or Spot is selected, the dialog box contains
adjustment sliders in five ranges. As you move a slider or type
in a text box, the underlying curve changes by the amount
indicated on the graph. Five sliders affect tints in the following
ranges:

● Slider at 10% (Highlight): affects 0 to 25%

● Slider at 25% (Quartertone): affects 0 to 50%

● Slider at 50% (Midtone): affects entire tonal range

● Slider at 75% (3/4-tone): affects 50 to 100%

● Slider at 90% (Shadow): affects 75 to 100%

If CMY is selected, the dialog box contains the following
options:

(range buttons)

Select the range of input tints that you want to affect:
Highlight, Quartertone, Midtone, 3/4-tone. The ranges
refer to lightness (L*), not the tint of cyan or any other
channel. For this reason, the greatest curve change
resulting from your Midtone adjustment may not occur
at 50% C, M, or Y.

(CMY Gray Adjustment controls)

Use the lightness (L*) slider together with the cast
(a*b*) selector to adjust the color in the selected range.
Your movement in the color selector may be
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constrained. When Adjust Displayed Colors is selected,
the color adjuster controls only shift the displayed color
patches for visualization of the current color change;
they do not change any curves.

Before, After (simulation/conversion curve and profile
input/output tonality adjustments)

The displayed color patches demonstrate the effect of
all the adjustments specified in this dialog box. The
color produced by the curves or profile before your
adjustment is shown on the left (Before). The color
produced by the curves or profile after your adjustment
is shown on the right (After). Click the patches to
display them in a larger view.

When Commit All Adjustments is selected in the Edit
menu, the After patch is updated to be the same as the
Before patch, even though the adjustments are retained.
This facilitates visualization of further incremental
adjustments with the Before, After patches.

Current, Corrected (device curve adjustments)

The displayed color patches demonstrate the effect of
all the adjustments specified in this dialog box. The
color that is currently being produced is shown on the
left (Current), and can be adjusted to reflect any
changes in the device color output that require
correction. The desired color output is shown on the
right (Corrected) and remains constant, as a reference
to the expected color output after correction. Click the
patches to display them in a larger view.

Adjust Displayed Colors

Enables you to adjust the displayed color of the Before,
After or Current, Corrected patches on your viewing
monitor, if the neutral gray that is displayed in the color
patch does not visually align with the neutral gray on
your proof or press sheet. Select the Adjust Displayed
Colors check box and use the color adjuster controls.
The feature enables you to change the color of the
patches only as they are displayed onscreen; it does not
directly affect curve editing. Clear the check box after
using the feature.

Reset

Available only when Adjust Displayed Colors is
selected. Resets the displayed color.
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Color Change

Displays the expected change in L*, a*, b*, C*, and H* at
a point in the range that you are working on. You can
enter the desired change at the center of the selected
range, directly in L*, a*, b*.

See also:
About adjusting curves on page 111
Curve View-Edit tool on page 266

Curve View-Edit tool
This collection of items appears in several curve-adjustment dialog
boxes, including device curves, calibration curves, and DeviceLink
input/output tonality. Together the items comprise a powerful curve
adjustment tool.

Enable Editing

Select to allow editing of the curves in this dialog box. The
descriptions of the remaining items assumes that Enable
Editing is selected. (If the check box is not selected, you can
only drag a point along the selected single curve, and read its
values in Tint In and Tint Out.) Adjustments you make, both
before and after you click Apply, can be undone from the Edit
menu.

(graph of transfer curves)

For CMYK devices, the horizontal axis represents CMYK tint-in
values 0% (lightest) to 100% (darkest). The vertical axis
represents the corresponding tint-out values.

Apply

After you make the changes you want, click Apply to save your
changes.

(channels)

Select for adjustment an individual channel C, M, Y, or K,
combined channels CMY for a coordinated neutral cast or
lightness adjustment, or Spot for spot color adjustment.

If a Spot or single channel C, M, Y, or K is selected, you can
adjust the curves as follows:

On the selected curve (channel), click to make handles. To
change the shape of the curve, drag a handle up or down. The
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handles on either side act as anchors, restricting the change to a
smaller range. Press Delete to remove the selected handle.

Tint In

The displayed value is the tint-in value of the selected
point. Enter a value and the selected point on that curve
(or if none exist, a new point) moves to that tint-in
value on the curve; the curve does not change.

Tint Out

The displayed value is the tint-out value of the selected
point. Enter a value and the curve changes so the curve
at the existing tint-in value moves to the new tint-out
value.

If CMY is selected, you cannot adjust the curves by dragging
them. Instead, the dialog box contains the following controls:

Gray Range

Select the center and range of lightness (L*) that you
want to affect. The center must be between 5 and 75.
Notice that the range sliders refer to lightness (L*), not
the tint of cyan or any other channel. For this reason,
the curve change on the Tint-in Tint-out graph will not
"line up" with the slider positions you set.

CMY Gray Adjustment

Use the lightness (L*) slider together with the cast
(a*b*) selector to adjust the color in the selected range.
Your movement in the color selector may be
constrained. When Adjust Displayed Colors is selected,
the color adjuster controls only shift the displayed color
patches to a new example color; they do not change any
curves.

Before, After (simulation/conversion curve and profile
input/output tonality adjustments)

The displayed color patches demonstrate the effect of
all the adjustments specified in this dialog box. The
color produced by the curves or profile before your
adjustment is shown on the left (Before). The color
produced by the curves or profile after your adjustment
is shown on the right (After). Click the patches to
display them in a larger view.

When Commit All Adjustments is selected in the Edit
menu, the After patch is updated to be the same as the
Before patch, even though the adjustments are retained.
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This facilitates visualization of further incremental
adjustments with the Before, After patches.

Adjust Displayed Colors

Enables you to adjust the displayed color of the Before,
After or Current, Corrected patches on your viewing
monitor, if the neutral gray that is displayed in the color
patch does not visually align with the neutral gray on
your proof or press sheet. Select the Adjust Displayed
Colors check box and use the color adjuster controls.
The feature enables you to change the color of the
patches only as they are displayed onscreen; it does not
directly affect curve editing. Clear the check box after
using the feature.

Reset

Available only when Adjust Displayed Colors is
selected. Resets the displayed color.

Color Change

Displays the expected change in L*, a*, b*, C* and H* at
the selected tint-in (center slider). You can enter values
in L*, a*, b*.

Curve Values

Displays the tint-in and tint-out values of each curve at
the L* corresponding to the center slider.

See also:
About adjusting curves on page 111
Licensing dialog box on page 262

Simulation targets and methods
A simulation target for the primary color output may contain only tonal
data, only colorimetric data, or both tonal and colorimetric data.

The availability of a particular simulation method depends on the type
of data that is included in the simulation target.

The following table lists the simulation methods that are available for
various industry specifications and ColorFlow device conditons.

Specification or Reference Curves: Tonal
Match

Curves: Gray
Balance

DeviceLink

FOGRA 28 - Web Offset PT 3 Coated × ×
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Specification or Reference Curves: Tonal
Match

Curves: Gray
Balance

DeviceLink

FOGRA 29 - Web Offset PT 4 Uncoated × ×

FOGRA 30 - Web Offset PT 5 Uncoated × ×

FOGRA 31 - Continuous Forms PT 2 Matte Coated × ×

FOGRA 32 - Continuous Forms PT 4 Uncoated × ×

FOGRA 39 - Sheetfed Offset PT 1 & 2 Coated × ×

FOGRA 40 - Web Offset Super Calandered × ×

FOGRA 41 - Web Offset MFC (machine finished
coated)

× ×

FOGRA 42 - Web Offset SNP (standard newsprint) × ×

IFRA 26 Newspaper Printing TVI 26% × ×

IFRA 30 - Newspaper Printing TVI 30% × ×

GRACoL 2006 C1 x x x

SWOP C3 and C5 x x x

FOGRA 45 - Web Lightweight Coated, Improved x x

FOGRA 46 - Web Lightweight Coated, Standard x x

FOGRA 47 - Offset PT4 Uncoated, White x x

ISO TVI Curve A ×

ISO TVI Curve A and B ×

ISO TVI Curve B ×

ISO TVI Curve B and C ×

ISO TVI Curve C ×

ISO TVI Curve C and D ×

ISO TVI Curve D ×

ISO TVI Curve D and E ×

ISO TVI Curve E ×

ISO TVI Curve E and F ×

ISO TVI Curve F ×

ISO TVI Curve F and G ×

ISO TVI Curve G ×

ISO TVI Curve G and H ×

ISO TVI Curve H ×

PSR Gravure Publication HWC (Improved LWC) × ×

PSR Gravure Publication LWC (Light Wt Coated) × ×
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Specification or Reference Curves: Tonal
Match

Curves: Gray
Balance

DeviceLink

PSR Gravure Publication MF (Machine Finished) × ×

PSR Gravure Publication SC (Super Calandered) × ×

SWOP 2006 Coated 3 x × ×

SWOP 2006 Coated 5 x × ×

ColorFlow data set, generated by measuring a Color
Characterization chart

× × ×

ColorFlow data set, generated by measuring a Tonal
Characterization chart

×

ColorFlow data set, generated by importing CIELAB
colorimetric data

× ×

ColorFlow data set, generated by importing spetral
colormetric data

x x x

× indicates that a method is available.
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23 Glossary

Glossary

black generation strategy
A method of determining how much black ink—versus a combination of
cyan, magenta, and yellow—is used to generate a particular color.

black strength
A value that specifies the black quantity in the replacement zones.

calibration
The act of setting equipment or software to produce desired results.
The purpose of color calibration is to achieve a consistent level of color
quality.

calibration curve
A curve that the workflow system applies to job image data en route to
a halftone output device. The calibration curve is created by combining
a device curve and a simulation or conversion curve.

See also:
device curve on page 274
simulation curve on page 278

characterize
To measure the color patches on a printed characterization chart with a
spectrophotometer, to determine the average color reproduction of a
device condition. Characterizing a device condition establishes a
relationship between the output colors and the input values of a digital
file.

See also:
color response on page 273

chart form
A portion of a ColorFlow-created characterization chart. It is a page in a 
Adobe PostScript file that will be printed on one surface (front or back)
of a printing device. If the printable area of the print device is too small
to contain the complete characterization chart, then the chart contains



multiple forms which must be printed in separate print runs. ColorFlow
can generate charts for measuring the response of double-sided
printing devices. In this case, front and back forms are generated, with
the color patches on back forms being the mirror image of those on the
front forms.

CMYK
A color representation scheme (or color space) in which cyan,
magenta, yellow, and black are combined to create full-color images.

color cast
The predominance of a particular color that affects the whole image in
the original, proof, or reproduction. A color cast is due to an excess of a
color pigment or light. It is most obvious in gray and near-gray areas.

color characterization chart
A file that is created by ColorFlow that contains all color patches that
are required to determine the color response of a printing device. It
includes all necessary identification and branding information. A
complete characterization chart may require more than one chart form.

See also:
characterize on page 271
chart form on page 271

color control element
A digital file that affects color reproduction in a prepress workflow
system. Color control elements include plate linearization curves and
print calibration curves, ICC device profiles, and ICC DeviceLink
profiles.

color gamut
The range of possible colors that can be represented in a given
circumstance, such as within a given color space or by a certain output
device.

color input
The device condition in the color setup that describes the color space
of the input files.

See also:
color setup on page 273
conversion method on page 273
device condition on page 274
primary color output (PCO) on page 277
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color management
A process that aims to control the representation of colors across a
variety of output devices so that the colors that are generated appear
consistent. Color management is based on the coordination of three
processes: device calibration, device characterization, and conversion
from one color space to another.

color response
The relationship between the input values of a digital file and the actual
color produced on an output device, for example, the color on a press.
It could be the observed behavior of a real output device, or part of an
industry printing specification such as GRACoL C1.

See also:
device condition on page 274

color setup
A collection of several device conditions and the color control elements
(curves, device profiles, DeviceLink profiles) that are required to align
to a common target on all the reproduction devices.

See also:
device condition on page 274
primary color output (PCO) on page 277
secondary color output (SCO) on page 278
simulation target on page 279

conversion method
The way in which input color content is converted from an input device
condition to the PCO, or output color content is converted from the
PCO to a SCO device condition. Methods include tone value increase
and gray balance curve methods (for SCOs only), and full color
management DeviceLinks.

curve
A graphical representation of a set of numbered pairs. Types of curves
include device curves, simulation curves, conversion curves, calibration
curves, and plate setup curves.

density
A measurement of the ability of light to be absorbed by an ink and
paper combination. A darker tone has a higher density than a lighter
tone.
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device
An individual occurrence of a physical device that reproduces an
image. Devices have a type and a customer-specified name. Because
the declaration of a device does not include its operating conditions—
such as ink selection, type of screening, and paper—you cannot
measure the color response of a device on its own. (In ICC
terminology, the declaration of a device does include its operating
conditions.)

See also:
device condition on page 274
device type on page 275

device condition
A combination of a device and the operating conditions in which the
device captures or produces an image. A device condition has a known
color response. Device conditions can be divided into groups such as
print conditions (press and proofer devices), capture conditions
(scanner and camera devices), and reference print conditions (industry
specifications). A device condition can include more than one device,
provided that all the devices are of the same device type, use the same
consumables and operational settings, and can be calibrated to yield
the same color response.

See also:
calibration on page 271
color response on page 273
device on page 274
print condition on page 277

device curve
A set of curves, one for each ink color, that is associated with a
particular device in a device condition. The device curve corrects either
tonal values or gray balance response differences between multiple
devices in the device condition. The method applied depends on
whether colorimetric or tonal measurement data is used, or gray
balance response differences between multiple devices in the device
condition such that each has the same apparent dot gain.

See also:
calibration curve on page 271

device-dependent color space
A color space defined by using information about the color capabilities
of a specific device.
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device-independent color space
A color space based on human perception of color, measured using a
colorimeter or spectrophotometer. The color space is independent of
the color capabilities of any specific device. An example is CIELAB. A
device-independent color space may be used as an intermediate color
space when converting from one color space to another, for example,
from CMYK to RGB.

DeviceLink profile
A type of ICC profile that represents a one-way link or connection
between devices. Its input has one channel for each colorant of the
source or simulation device; its output has one channel for each
colorant of the destination device. It does not represent any device
model and cannot be embedded into images.

device profile
A type of ICC profile that represents the relationship between colorant
tint values of a device and the resulting color. It has two sets of color
mapping tables: one set maps device colorant tint values to the profile
color space while the other set maps the profile color space to device
colorant tint values.

See also:
rendering intent on page 278

device type
A classification of a device into one of several types that implies a set
of capabilities and behavior. The list of device types is fixed.

See also:
device on page 274

dot gain
A printing effect which results in dots being printed larger than they
should be. It occurs as a result of ink spreading on the printed page,
and if not compensated for, can lead to an image appearing too dark.

effective dot area (EDA)
The area of the halftone dot as perceived by the human eye. It is
comprised of the physical dot area and the optical dot area. Effective
dot area is measured with a densitometer. Also referred to as tonal
value.
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frequency-modulated (FM) screening
A method of creating halftones where the spots are all the same size,
but the frequency or number of dots changes in a given area. There are
more dots in a dark area and fewer in a light area.

gray balance
The values for yellow, magenta, and cyan that produce a neutral gray
with no dominant hue when printed at a normal density.

highlights
The whitest portions of the original or reproduction that have no color
cast. The highlight dot is ranged in the reproduction from the smallest
printable dot to approximately 25 percent.

See also:
midtones on page 277
shadows on page 278

ICC profile
A color space description that acts as a standard for accurate
reproduction of colors across different platforms, devices, and
applications.

linearization curve
A curve that achieves a linear response on a printing plate. It adjusts
the tint values so that the measured dot area on the imaged plate is the
same as the tint specified in the input digital file. That is, a tint patch
specified as 50 percent in the digital file will measure a 50 percent dot
area on the printing plate.

measurement data set
Data collected from a measurement device that describes the color
response of a device that has known operating conditions.

measurement page
The portion of a chart form that can be measured by a measurement
device. It contains color patches and a footer. The maximum size is
limited by the intended measurement device, and by the uninterrupted
printable area on the print device.
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midtones
Tones in the range between highlights and shadows.

See also:
highlights on page 276
shadows on page 278

Preucil equation
A method of calculating wet trap. It quantifies how well a printed ink
adheres to another ink, compared to how well that ink adheres to
paper. This way of expressing apparent wet trap is defined only for the
three basic process inks (CMY). The equation is named after Frank
Preucil (1905–1996) who pioneered the use of color reflection
densitometry to control and evaluate process color printing in
lithography.

primary color output (PCO)
The device condition in the color setup that is chosen to be the main
color output. The PCO can include curves and/or a DeviceLink to be
used with the device condition to make it simulate a selected target.

See also:
color setup on page 273
device condition on page 274
secondary color output (SCO) on page 278
simulation method on page 279
simulation target on page 279

print characteristic
The graphical relationship between the tint values specified in a digital
file and the effective dot area or tonal values on a press sheet.

print condition
The operating conditions associated with printed output from a device.
For output from a printing press, these usually include (as a minimum)
printing process, substrate type, printing ink, and screening. A print
condition is one of the several types of device condition.

See also:
device condition on page 274

process colors
A set of ink colors used in overprinted combinations to print graphic
design elements. A process color set can be the common CMYK set or
an extended color set such as CMYKOG.
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profile connection space
The color space used to describe color in an ICC profile. CIELAB is
often used because it has reasonable perceptual uniformity.

reference print condition
An industry printing specification such as GRACoL C1 or FOGRA 39 for
which characterization data and printing aim points are published. A
reference print condition is one of the several types of device condition.

See also:
device condition on page 274

rendering intent
The compression method—a mathematical algorithm—used when
mapping and translating colors from one color gamut to another. It
allows for compression of out-of-gamut colors into the color capability
of the press used.

secondary color output (SCO)
The name given to all other output device conditions in the color setup
—other than the one used in the PCO. Each SCO extends its device
condition with a method by which it matches the target of the PCO.

See also:
color setup on page 273
conversion method on page 273
device condition on page 274
primary color output (PCO) on page 277

shadows
The darkest part of an image (original and reproduction). A shadow
has densities near the maximum. In a reproduction, shadows are
printed with dot areas between 80 percent and 100 percent.

sheet selection
The process of choosing the printed sheets from a print run that are
deemed to best represent the color response of a print condition.

simulation curve
A set of curves, one for each ink color, that is associated with a color
output. The simulation curve modifies the color response of the
associated device condition in accordance with the desired simulation.

See also:
calibration curve on page 271
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simulation method
The way in which the PCO extends its device condition to achieve a
target. Methods include tone value increase, color and gray balance,
and full color management DeviceLinks.

See also:
primary color output (PCO) on page 277
simulation target on page 279

simulation target
The color response that you want to achieve in the PCO.

See also:
primary color output (PCO) on page 277
reference print condition on page 278
simulation method on page 279

spot color
A special ink color, not included in the process color set, that is used to
specify the color of a graphic design element.

substrate
Any printing surface to which ink will adhere. Also referred to as stock.

three-quartertone
Tone area of an image that has density values between the midtone
and the dark point. Three-quartertone is typically printed with a dot
area near 75 percent.

TIFF
Acronym for Tagged Image File Format. TIFF is a file format used to
describe, store, and exchange bitmap images. TIFF is cross-platform,
highly flexible, and capable of saving a wide variety of image types,
including photographs and illustrations. Most page makeup and image
editing software supports TIFF.

tint
The percentage value assigned to a dot.

tone value increase
The difference between the tint specified in the digital file and the tone
values on the output. Tone value increase is the total of all increases in
tone values that can happen at various stages of the print reproduction
process.
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total ink limit
An upper limit placed on the sum, at a given point on a printed image,
of the tint values of all device colorants. Its purpose is to prevent
excessive ink buildup. Typical values range from 260 percent for
coldset web printing on newsprint, to 400 percent for ink jet printing
devices on high-quality substrates.
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Index
A

activating a Workflow edition license 21
adjustments,

undoing 203

C

calculating curves 107
calibrating a press 107
calibration curves,

applying to printing plates 107
described 107
viewing 110

changing the user interface language 21
chart,

printing from press 73
charts,

color characterization 68, 69
exporting 73
measurement 65
tint ramp 72
tonal characterization 71

CI conversion DeviceLinks,
adjusting 103

CI-to-PCO conversion,
defining a new method for 105

CIs (color inputs),
about 101
creating 102
defining conversion methods for 15
removing from color setups 104

client and server software model 18
client software,

installation 19
starting 20

color 185
color characterization charts,

creating smallest possible 69
creating to fill the form 68

color inputs
See CIs

color management 185
color response of a device,

establishing in a condition 13
color responses,

about 81
adjustment of PCO 85
of device conditions 83
of PCOs 84
of pooled device conditions 83
ways to establish for a device condition 84
ways to establish for PCOs 85

color setups,
and PCOs 89

appearance of 8
creating 10, 11, 90
deleting 90
duplicating 90
explained 6
how used in Prinergy 181
removing CIs from 104
removing SCOs from 98

color shifts,
correcting on curve-controlled devices 86

ColorFlow software 185
ColorFlow software, limitations 191
ColorFlow-Prinergy terminology 18
ColorFlow,

window components 4
database 18
elements and settings provided to Prinergy 183
introduction to the software 1
variable marks in Prinergy 185
viewing licensed options 21

colorstore,
about 18
capturing the state of 181

conversion curves,
adjusting 96, 111
described 107
viewing 110

conversion methods,
defining for SCOs and CIs 15
defining for the CI 103

conversions,
for input types 102
SCO to PCO, defining 96
undoing adjustments 203

Curve View-Edit tool,
about 116
using on individual color channels 118
using on neutral balance 119

curve-controlled devices,
adding to device conditions 62

curves,
about 107
adjusting 111
calculating 107
exporting 120
importing from Harmony 109
types of 107
undoing adjustments 203
viewing 109

curves, device-specific device curves 60
curves, reverting to default device curves 61

D
database 18
default device curves, reverting to 61



device conditions,
about 45
adding curve-controlled devices to 62
components of 46
defining 48
deleting 50
establishing new color response for 78
how created 47
pooled devices in 61
promoting pooled devices in 63
selecting properties 12
ways to establish color response for 84

device curves,
about 54
adjusting 111
described 107
importing 56
selecting 55
viewing 109
when to import 109

device curves, device-specific 60
device profiles,

about 121, 137, 138, 141
defining 15
exporting 125
importing 38, 124

device profiles,,
about 121, 137, 138, 141
Dark Point 141

DeviceLink profiles,
importing 38

DeviceLink white point,
adjusting 134

DeviceLinks,
about 127
adjusting 133
adjusting input or output tonality 135, 139, 140, 142,

144, 146
exporting 132
generating 128
importing 132
recalculating for CI-to-PCO conversion 105

devices,
about 41
adding 11
creating 42
deleting 43
establish color response in a condition 13
pooled in a device condition 61
renaming 43

E

exiting the software 24
exporting,

curves 120
device profiles 125
DeviceLinks 132
measurement data 78

F

flexographic printing 163

G

getting started with ColorFlow software 185
Gray Balance 143
gray balance,

method of calibrating a press 107

H

Harmony,
importing curves from 109
printing a similar color in ColorFlow 37

history,
viewing 203

I

icons,
color and animation explained 9
list of 9

importing,
device profiles 124
DeviceLinks 132
elements from other products 38
Harmony curves 109
measurement data 78

industry specifications,
using as reference device conditions 52

Ink Optimizing Solution 3, 205, 211, 214
licensing 205, 211, 214

Ink Optimizing Solution option
about 205, 211, 214

ink savings
verifying 211

input types,
conversions for 102

installation,
client software 19
server software 19

introduction to the ColorFlow software 1

K

Kodak Profile Wizard software,
importing profiles generated in 38

L

language of the user interface,
changing 21

license,
about 20
activating for Workflow edition 21
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licensed edition,
viewing 21

licensed options,
viewing 21

limitations with ColorFlow 191
linearizing platesetter output 36

M
Mac computer requirements 5
marks, variable 185
measurement charts

about 65
measurement data,

exporting 78
importing 78

measurement sets,
activating 78

Mindot 59
monotonic curves 107

N
neutral balance,

using Curve View-Edit tool on 119
using Tonal Adjust tool on 114

O
offset presses,

aligning to halftone proofers 32
aligning to inkjet proofers 31

output devices,
adding 11

P
PCO device,

choosing 11
PCO to SCO conversions,

recalculating 99
PCOs (primary color outputs),

and color setup 89
choosing a simulation target for 14
color responses of 84
creating 91
establishing color responses of 85

PCOs,
using device condition's color response without

simulation 92
plate lines,

about 157
linearizing platesetter outputs 36
remeasuring tints in 161

plate setup curves,
described 107
exporting 161
viewing values 111

plate setups,
about 157, 164
adding a plating line 160
assigning to a device condition 159
creating 158

platesetter output,
ensuring linearity of 36

pooled devices 28, 61, 63
pooled devices,

promoted devices 83
presses,

aligning color response of within one device
condition 28

aligning to halftone proofers 32
aligning to inkjet proofers 31
using curves to calibrate 107

primary color outputs
See PCOs

Prinergy Connect 183, 185, 191
using with ColorFlow 185
RGB limitations with ColorFlow 191

Prinergy Evo 183, 185, 191
using with ColorFlow 185
RGB limitations with ColorFlow 191

Prinergy Powerpack 183, 185, 191
RGB limitations with ColorFlow 191
using with ColorFlow 185

Prinergy primary server,
connecting to 20

Prinergy Virtual Proofing System 211
Prinergy,

ColorFlow variable marks in 185
how color setups are used in jobs 181
how ColorFlow elements are used 183
making colorstore elements available to 181

Print Characterization report,
generating 194

Print Comparison report,
generating 195

printing an exported chart 73
Profile Adjustments 143, 145
Profile Wizard,

importing profiles generated in 38
promoted devices 63, 83
proofers and presses,

aligning 29, 31, 32
proofers,

aligning to offset presses 29

Q

quitting the software 24

R

reference device conditions,
creating custom conditions 53
using industry specifications for 52

reports,
about 193
elements of 196
Print Characterization 194
Print Comparison 195

requirements, system 5
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RGB limitations with ColorFlow 191

S

sample data 13
sample sheets for measurement,

selecting 73
SCO DeviceLinks,

adjusting 97
SCOs (secondary color outputs),

about 95
adjusting conversion curves 96
creating 95
defining a new method for conversion 99
defining conversion methods for 15, 96
propagating PCO simulation adjustments to 33
removing from color setups 98

secondary color outputs
See SCOs

Selected Color 145
server software,

installation 19
sheets, sample,

selecting for measurement 73
shifts, color,

correcting on curve-controlled devices 86
simulating a target,

defining a new method for 94
simulating,

another device condition 92
color response of another press 26
industry specifications 27, 91

simulation curves,
adjusting 93, 111
described 107
viewing 110

simulation DeviceLinks,
adjusting 93

simulation targets,
choosing for the PCO 14

simulations,
undoing adjustments 203

snapshots,
about 181
approving 183
commit all adjustments 202
reverting to earlier 182
taking 182

software,
client and server 18

starting the client software 20
sticky notes,

creating 22
deleting 23
hiding 23
moving 23
resizing 23
showing 23

system requirements 5

T

target simulation,
defining a new method for 94

terminology in ColorFlow and Prinergy 18
tint ramp chart,

creating 72
Tint Values list 111
Tonal Adjust tool,

about 112
adjusting curves with 113
using on individual color channels 113
using on neutral balance 114

tonal characterization chart,
creating 71

tools,
Curve View-Edit 116
Tonal Adjust 112, 113

TVI,
method of calibrating a press 107

U

undoing adjustments 203
user interface,

changing the language of 21

V

variable marks in Prinergy 185
VPS

See Prinergy Virtual Proofing System

W

white point 103, 133, 134
Windows-based computer requirements 5
Workflow edition license,

activating 21
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